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Preface

Welcome to the Access 2003 Bible —your personal guide to a powerful, easy-
to-use database management system. This book is in its ninth revision and

has been totally re-written for Microsoft Office Access 2003 with new text, new pic-
tures, and a completely new and improved set of example files..

This book examines Access 2003 with more examples than any other Access book
ever written. We think that Microsoft Access is an excellent database manager and
the best Windows database on the market today. Our goal with this book is to share
what we know about Access and, in the process, to help make your work and your
life easier.

This book contains everything you need in order to learn Microsoft Access to a
mid-advanced level. You’'ll find that the book starts off with the basics and builds,
chapter by chapter, on topics previously covered. In places where it is essential
that you understand previously covered topics, we present the concepts again and
review how to perform specific tasks before moving on. Although each chapter is
an integral part of the book as a whole, each chapter can also stand on its own and
has its own example files. You can read the book in any order you want, skipping
from chapter to chapter and from topic to topic. (Note that this book’s index is par-
ticularly thorough; you can refer to the index to find the location of a particular
topic you're interested in.)

The examples in this book have been well thought out to simulate the types of
tables, queries, forms, and reports most people need to create when performing
common business activities. There are many notes, tips, and techniques (and even
a few secrets) to help you better understand the product.

This book can easily substitute for the manuals included with Access. In fact, many
users do not get manuals today, often relying on just the online help. This book will
guide you through each task you might want to do in Access. We even created
appendixes to be used as reference manuals for common Access specifications.
This book follows a much more structured approach than the Microsoft Access
manuals, going into more depth on almost every topic and showing many different
types of examples.
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Is This Book for You?

We wrote this book for beginning, intermediate, and even advanced users of
Microsoft Access 2003. With any product, most users start at the beginning. If, how-
ever, you've already read through the Microsoft Access manuals and worked with
the Northwinds sample files, you may want to start with the later parts of this book.
Note, however, that starting at the beginning of a book is usually a good idea so you
don’t miss out on the secrets and tips in the early chapters.

We think this book covers Microsoft Access in detail better than any other book
currently on the market. We hope you will find this book helpful while working with
Access, and that you enjoy the innovative style of a Wiley book (formerly IDG
Books, the people who make the For Dummies books).

Yes — If you have no database experience

If you're new to the world of database management, this book has everything you
need to get started with Microsoft Access. It then offers advanced topics for refer-
ence and learning.

Yes — If you've used other database managers
like dBASE or Filemaker

If you're abandoning another database (such as dBASE, Filemaker, Alpha, Paradox,
FoxPro, R:Base) or even upgrading from Access 2.0, Access 95 or 97, or even
Access 2000 or 2002 this book is for you. You’ll have a head start because you're
already familiar with database managers and how to use them. With Microsoft
Access, you will be able to do all the tasks you’ve always performed with character-
based databases — without programming or getting lost. This book will take you
through each subject step by step.

Yes — If you want to learn the basics of Visual Basic
Applications Edition (VBA) programming

VBA has replaced the Access Basic language. We know that an entire book is needed
to properly cover VBA, but we took the time to put together many chapters that
build on what you learn in the forms chapters of this book. The VBA programming
chapters use the same examples you will be familiar with by the end of the book.

Conventions Used in This Book

4+ When you are instructed to press a key combination (press and hold down
one key while pressing another key), the key combination is separated by a
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plus sign. Ctrl+Esc, for example, indicates that you must hold down the Ctrl
key and press the Esc key; then release both keys.

4 Point the mouse refers to moving the mouse so that the mouse pointer is on a
specific item. Click refers to pressing the left mouse button once and releasing
it. Double-click refers to pressing the left mouse button twice in rapid succes-
sion and then releasing it. Right-click refers to pressing the right mouse but-
ton once and releasing it. Drag refers to pressing and holding down the left
mouse button while moving the mouse.

4 When you are instructed to select a menu, you can use the keyboard or the
mouse. To use the keyboard, press and hold down the Alt key (to activate the
menu bar) and then press the underlined letter of the menu name; press Alt+E
to select the Edit menu, for example. Or you can use the mouse to click on the
word Edit on-screen. Then, from the menu that drops down, you can press the
underlined letter of the command you want (or click on the command name)
to select it.

4+ When you are instructed to select a command from a menu, you will often see
the menu and command separated by an arrow symbol. Edit_Paste, for exam-
ple, indicates that you need to select the Edit menu and then choose the Paste
command from the menu.

4 ltalic type is used for new terms and for emphasis.
4+ Bold type is used for material you need to type directly into the computer.

4+ A special typeface is used for information you see on-screen — error mes-
sages, expressions, and formulas, for example.

Icons and Alerts

You'll notice special graphic symbols, or icons, used in the margins throughout this
book. These icons are intended to alert you to points that are particularly impor-
tant or noteworthy. The following icons are used in this book:

Alote This icon highlights a special point of interest about the topic under discussion.
p
Tip This icon points to a useful hint that may save you time or trouble.
y)
Caution This icon alerts you that the operation being described can cause problems if

you're not careful.
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.@A This icon points to a more complete discussion in another chapter of the book.
eference

using the sample files included on the disk accompanying this book.

ggthe'h This icon highlights information for readers who are following the examples and

Feature

\ This icon calls attention to new features of Access 2003.

In addition to noticing the icons used throughout this book, you will also notice material
placed in gray boxes. This material offers background information, an expanded discussion,

or

a deeper insight about the topic under discussion. Some sidebars offer nuts-and-bolts

technical explanations, and others provide useful anecdotal material.

How This Book Is Organized

This book contains 39 chapters divided into four main parts and five sections. In
addition, the book contains a fifth part containing four appendixes.

The main parts of the book include:

4 Creating Desktop Applications
4 Creating Enterprise Applications
4 Creating Web Applications

4 Advanced Topics

Part I: Creating Desktop Applications

Part I consists of three sections and for most Access users is all that you will ever
need. The 26 chapters in this section (or about two-thirds of the book) cover every-
thing you will need to do for your individual or workgroup applications including
creating data tables, building forms and reports, and programming in VBA.

Working with Data Tables and Queries

The first section of the book contains seven chapters that will teach you all about
data and conceptual designs of information.
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Chapter 1 contains great conceptual material on understanding the basic elements
of data, introduces you to the buzzwords of database management, teaches you how
to plan a table and will show you the different data types. Chapter 2 teaches you
how to create a table. You learn how to properly name fields and assign data types.
You will learn how to rename fields and add fields to an already created table.
Chapter 3 covers everything you need to know about entering data into forms and
datasheets. You will learn how to add validation to fields, format fields and use vari-
ous built in tools for making data entry easier. You will learn how to search for data
and how to change and delete data values. In Chapter 4 you will learn more about
creating tables and creating primary and foreign keys and relating them and using
the Relationship builder tools in Access. In Chapter 5, you examine the concept of
queries; then you create several queries to examine how data can be filtered,
rearranged and displayed. Chapter 6 continues the query work started in the previ-
ous chapter, You will learn how to create more complex criteria to ask questions
about your data. You will learn a little about SQL and WHERE clauses and how to use
operators and expressions. Chapter 7 examines how to import, export, and attach
external files, and how to copy Access objects to other Access databases.

Building Forms and Reports

The second section of the book contains ten of the most in-depth chapters ever
written on forms and reports.

You'll begin in Chapter 8 with a visual tour of various types of forms and get a com-
plete understanding of form controls. Chapter 9 teaches the basics of creating data-
entry forms and using Wizards to simplify the creation process; using data-entry
forms is also discussed. Chapter 10 examines the concepts of bound forms to table
data sources and how to create unbound forms. Chapter 11 teaches how to add
data validation to forms to prevent errors. It also teaches the basics for combo box
controls. Chapter 12 teaches you how to professionalize the look for forms and
reports through various formatting techniques and the use of color and special
visual effects to create great-looking forms and reports that catch the eye and
increase productivity Chapter 13 covers the basics of report creation and printing
and introduces groups which allow reports to summarize data at many levels.
Chapter 14 covers embedding subforms in forms and reports and how to link a par-
ent form to a child form within a subform. Chapter 15 shows you how to create
summaries and totals in reports and how to work with various group headers and
footers. Chapter 16 discusses the various special reports types such as snaked col-
umn reports for directories, mail merge reports and labels. Chapter 17 explains the
use of pictures, graphs, sound, video, and other OLE objects.

Automating Your Applications

The third section of the book covers VBA programming and how to use Visual Basic
commands to control forms and reports and to build outstanding user interfaces.

Chapter 18 teaches the concepts of Visual Basic programming and how to edit a
Visual Basic procedure. Chapter 19 covers the concept of event-driven program-
ming and how Access uses commands to automate manual processes. Chapter 20

XV
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examines the built-in functions in Microsoft Access used for everything from
manipulating strings to formatting dates. In Chapter 21 you learn about ADO and
recordsets used to move data between forms and tables. This chapter is the most
important chapter for programmers in understanding database management,
Chapter 22 teaches you how to craft programming commands to find data. You will
learn how to automate queries and link combo box selection to display data on a
form. Chapter 23 teaches how to use subroutines to create reusable code modules
for more efficient coding. Chapter 24 teaches you how to add error routines and
proper debugging routines for programs. In Chapter 25, you learn how to create
button menus known as switchboards, as well as traditional pull-down menus, and
custom command bars used to build menus and toolbars. Chapter 26 teaches how
to create a tab control and use continuous forms to display and switch between
data views.

Part ll: Creating Enterprise Applications

This fourth section of the book teaches how to build applications an entire enter-
prise can use.

Chapter 27 teaches the process of upsizing Access tables to SQL Server. You learn
how to use the upsizing wizard and all the tasks you need to do to really make it
work. While chapter 27 teaches how to upsize your data, chapter 28 teaches how to
create an Access Data Project (ADP) to create a true client-server system. You learn
how to upsize your programs and create ADO recordsets to work against SQL
Server or the Microsoft Database Engine (MSDE). Chapter 29 delves further into the
client server world teaching how to create stored procedures, triggers and pass-
through queries to build true client server systems.

Part l1l: Creating Web Applications

The three chapters of section four cover building applications that work with data
on the internet and with intranets. Chapter 30 covers building basic Data Access
Pages (DAP) using many of the example you are already familiar with. Chapter 31
covers more advanced types of DAP’s. Chapter 32 provides an overview of XML and
schemas and also includes an overview of the new InfoPath product used to create
forms with XML data.

Part IV: Advanced Access Database Topics

This part contains six chapters that present advanced topics on each of the basic
tasks of Access. Chapter 33 examines how to exchange data with other Office prod-
ucts such as Word, Excel, Outlook and even PowerPoint. Chapter 34 covers security
and protecting a database while chapter 35 shows you how to build and run help
systems. Chapter 36 discuss advanced select query topics, including total, cross-
tabulation, top-value, and union queries. Chapter 37 covers action queries, which
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change data rather than simply displaying records. Chapter 37 is also a com-
pendium of advanced query topics that will leave you amazed at the power of
Access. Chapter 38 shows you a multitude of techniques for increasing the speed
of an application. Finally, Chapter 39 covers the new Access Developers Edition
(ADE) and runtime.

Part V: Appendixes and Reference Material

The last part contains four appendixes. Appendix A presents a series of tables list-
ing Access specifications, including maximum and minimum sizes of many of the
controls in Access. Appendix B displays a database diagram of the many database
tables used in this book so you can create your own system. Appendix C describes
the CD-ROM. Appendix D is a discussion of standard naming conventions.

Guide to the Examples

‘\lote

The examples in Access 2003 Bible are specially designed to maximize your learning
experience. Throughout this book you will see many examples of good business
table design and implementation, form and report creation, and module coding in
Visual Basic. You will see examples that use both Jet (the internal database of
Microsoft Access) as well as examples that connect to SQLServer datbases. You will
also see forms that work on the Web using Access’s own Data Access Pages.

As every developer knows, it is important to understand what you are creating and
programming from the application standpoint. This is sometimes called the business
of business, and in this book we have chosen a simple example that any business

or developer can hopefully relate to. More importantly, in this or any book you
must relate to it successfully in order to learn. When developing systems you often
find yourself analyzing applications that you don’t have a lot of experience with.
Obviously an aerospace engineer makes a better analyst when developing a system
to track airplane engines, but any good developer can develop any system as long
as they are willing to work with the business experts. In this book, the authors and
their words will serve as the business experts.

The examples in this book will use a fictitious company named Access Auto Auctions
or AA Auctions for short. AA Auctions buys and sells cars, trucks, and other vehicles.
They directly sell these vehicles and also offer them for sale through auctions both at
their equally fictitious showroom and on the Internet. The example database contains
the necessary tables, queries, forms, reports and module code to facilitate their busi-
ness needs.

Within this guide we are going to use some terms that have not been thoroughly
-~ been explained yet. Feel free to skip over them and return to this guide often as
you start new chapters that use these forms and reports.

XVii
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Using the Example Files on Your CD

On your CD is a standard Windows setup program that will install the examples onto your
hard drive. We have provided separate Microsoft Access database files for each chapter.
They are arranged into subdirectories that are placed on your hard drive when you install
the example files. The subdirectories are simply names Chapxx where xx is the chapter
number. The database files are each named Chapxxyyyyyyy.mdb where xx is the chapter
number and yyyyyyy is a description of the contents. For example, Chap07Start. ndb would
be the database file you might open at the start of Chapter 7 and Chap07End.mdb
would be how you would expect to find the database after you completed all of the exer-
cises in the chapter . Some chapters will have no files while others may have many.
Additionally, you may find other types of files with their own file extensions in each subdi-
rectory. You will be instructed how to use each file throughout each chapter of the book.

Additionally, we have provided many fully working programs, demos, and trial versions of
some of the best Microsoft Access tools for end-users and developers and provided links to
these companies’ websites so you can get the latest information from them.

In each chapter’s database file, you will only see the objects that are needed for the chap-
ter. We have also combined all the completed working forms and reports in two database
files; AccessAutoAuctions.mdb contains all of the program objects (queries, forms,
reports, and modules). The linked data file AccessAutoAuctionsData.mdb will contain
only the tables used by the application. However, in the individual chapter files, you will see
the program files (queries, forms, reports, and modules) in the same database file as the
tables.

Tip While professional developers will always split program and data objects into two
.. separate database files, it is acceptable during development to combine all of the
4 objects into one database and split them when development is complete. When
you are working in a program database and you are linked to your data file, you
must load the data database file before you can make changes to the table design.
You'll learn more about this throughout the book.

The Main Menu Switchboard

When you load the completed example file (Access Auto Auctions.mdb), you will
see the main menu (known as a switchboard) shown in Figure FM-1. This switch-
board contains buttons that display the main areas of the system.
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7 Main Swhchboard Dog

Figure FM-1: The Access Auto Auctions main switchboard
that allows the user to open various forms and reports.

These main areas include:

4+ Contacts: Buyers and Sellers of vehicles and parts that AA Auctions deal with.
Rather than traditionally separate Customer and Supplier tables, the Contacts
table provides a single access point to all people that AA Auctions needs to
contact for any reason.

4 Sales: This button displays an invoice form that lets AA Auctions enter infor-
mation about the buyer (which comes from the Contacts information). It
allows for an unlimited number of line items on the Invoice. Each item will be
selected from information stored in the Products system.

4+ Products: Lists of everything that AA Auctions sells or offers for auctions
These include vehicles, parts, and anything that needs to be tracked for sales
or inventory purposes including descriptions, costs, selling prices, and even
pictures of each vehicle or part.

4+ Reports: Any good application contains reports at many levels. This button
actually does nothing. Normally, it would be used to display a generic report
manager that displays reports while allowing specifications of the report
name and parameters which will only show data between certain dates or for
certain vehicle types. Though not specifically covered in this book, on the
example CD of third party products, there is a generic report manager named
the ez Report Manager you can use.

4 Company Setup: This displays a form that contains information used by the
entire system. This is used when you need global values such as your com-
pany name (Access Auto Auctions in this example) or other information that
can be used by the entire application.

XiX
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Understanding the Data Tables

Data is the most important part of any system and in Access (as well as every other
database management system), data is arranged into logical groupings known as
tables. Tables help define the structure of the data as well as hold the data itself.
Tables are related to each other in order to pass data back and forth and to help
assemble the chaos of data into well defined and formatted information.

The diagram in Figure FM-2 displays a representation of most of the data tables that
make up the Access Auto Auctions example. As you will learn in Part 1 of this book,
the lines, arrows, and symbols between the tables mean something important and
communicates to the developer how the data interacts. You will learn terms like
table, field, record, relationship, referential integrity, normalization, and primary
and foreign keys as you begin to understand how tables work within a database.

Figure FM-2: The Access Auto Auctions data relationship diagrams showing the
example tables and their data fields.

in Front of Table Names and

Why There Are Prefixes

You might notice that each table name is prefixed with the letters tb/. You might also notice
that each data field listed in Figure FM-2 is also prefixed with a variety of characters. These
are standard naming conventions, prefixes assigned by developers to let other developers
know the type of data these fields may contain when later used in Visual Basic programs.
The characters tbl mean the object is a table. There are other prefixes for database objects
such as qry (query), frm (form), rpt (report), and mod (module). Some of the common data
field prefixes include chr (character), int (integer), dtm (date/time), and many others. You
will see that we use standard naming conventions throughout this book.
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¢ Cross- Naming conventions are more thoroughly discussed in Appendix D.
'] Reference

In the example database are approximately 11 tables as shown in Figure FM-2 that
are used to create the Access Auto Auction applications. Many of the smaller tables
are lookup tables whose sole purpose is to provide a list of valid selections. The
larger tables hold the data used by the system itself. All of these tables include a
number of data fields that are used as the definitions of the data. The lines between
the tables show how tables how related by common data fields. If these terms are
strange to you, don’t worry. In the first few chapters, you will receive a full explana-
tion of each of them. The tables include:

4+ tblSales

The tblSales table contains fields for the main part of the sale. This
includes information that occurs once in the sale such as the Invoice
Number, dates of the sale, the Buyer ID (which links to the tblcontacts
table to retrieve information about the buyer including taxing informa-
tion), the Salesperson ID (which links to the tblSalesperson table), the
taxing location (which links to the tblTaxRates table), and various other
financial information.

4 tblSalesperson

The tblSalesPerson table contains a list of sales people that sell prod-
ucts for Access Auto Auctions along with their commission rates. It is
linked to the Sales Invoice and is used when a Salesperson is selected in
the Invoice form.

4+ tblTaxRates

The tblTaxRates table contains a list of taxing locations and tax rates
and is used by the Sales Invoice when the buyer is selected in the form.
The taxing location is retrieved from tblTaxRates and then the tax rate
used by the Invoice to calculate taxes owed.

4 tblSalesLineltems

The tblSalesLineltems table contains fields for the individual line items
that will make up the sale. The sale may contain a variety of items.
Several vehicles may be sold to a single buyer at one time. The buyer
may buy parts, accessories, or services. You will see a form created later
which allows for the data entry of an Invoice and an unlimited number of
lineitems that will be stored in this table.

The data fields in the tblSalesLineltems table include the Invoice Number
which is used to link the main Invoice table to the Invoice Lineitems
table as well as the quantity purchased. The Product ID field (which links
to the tblProducts table) is used to retrieve information about the prod-
uct including the item description, price, and taxability status. A dis-
count field allows a discount to be entered.
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e The way this table will be used will violate true relational database the-
ory. Rather than simply link from the tblSalesLineltems table to the
tbIProducts table by the common chrProductID field data values from
the tblProducts table are copied to the tblSalesLineltems. This is often
done with time-dependent data. If a customer bought a part today with a
price of $10.00 and next week the price goes up to $15.00 as stored in the
tblProducts table, it would be wrong if the Invoice then showed the price
of $15.00.

lmeSS- You learn more about relational database theory and how to build tables in
| Reference ) g0 tion | of this book.

4 tblSalesPayments

e The tblSalesPayments table contains fields for the individual payment
lines. The invoice may be paid for by a variety of methods. The customer
may make a deposit for the sale with a check, and then split the remain-
ing amount owed with a variety of credit cards. By having unlimited
payment lines in the Invoice form you can do this.

¢ The data fields in the tblSalesPayments table include the Invoice
Number which is used to link the main Invoice table. There is a field for
the payment type (which links to the tbIPaymentType table) to only
allow entry of valid payment types as well as the payment date, payment
amount, and any check or credit card number and the credit card expira-
tion date.

4 tblPaymentType

e The table tbIPaymentType is simply a lookup table with valid values for
types of payments. Only valid payment types can be chosen for a payment.

4 tblContacts

4+ The table tblContacts contains information about all the people and compa-
nies that Access Auto Auctions will have relationships with. This data
includes customers, suppliers, buyers, and sellers. Names, physical
addresses, phone and fax numbers, email addresses and Web sites and all the
financial information about the contact is stored in this table. Unlike the
tblSalesLineitems table information, this data is only linked from an Invoice
form and with the exception of some changing financial data is never copied
to any other table. This way if a customer changes their address or phone
number, any Invoice which is related to the contact data, will instantly show
the updated information.

4 tblContactLog

e The tblContactLog table contains potentially multiple entries for each
contact in the tblContacts table. This information includes the contact
date, notes or items discussed, and follow up information. The contacts
form will manage all of this information.
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4 tblCustomerTypes

e The tblCustomerTypes table simply contains a list of valid customer
types that can be selected through the Contacts form. It is important in
all applications that certain data be limited to valid values. In this exam-
ple, each valid value will trigger certain business rules. Therefore, data
entry must be limited to those values.

4 tblProducts

e The tblProducts table contains information about each item that is sold
or auctioned by Access Auto Auctions. This table contains information
that is used by the Invoices line item section. The products table could
also be used as an inventory table. However, since Access Auto Auctions
will provide a wide variety of products and services, the term Products
seemed to suit it better.

The tblProducts table includes field data types of nearly every type
available in Access. From a business viewpoint, there is a key field which
will be user defined. The table contains a field for description and sev-
eral types of costs, prices and quantity fields. There are also several
fields that determine if a value is true or false including whether or not
the item is being auctioned and whether it is taxable. A date field is used
to display the auction end date. There are also a field for long text values
(known as memo fields) for a list of features, and a field for a picture of
each vehicle.

e The tblProducts table will be one of the main tables used in this book.
The frmProducts form will be used to teach nearly all form development
lessons in the book so you should pay particular attention to it.

4 tblCategories

The tblCategories table is used to lookup a list of valid categories.

Understanding the Products Form

The frmProducts form shown in Figure FM-3 is the first form that will be used to
teach you how to properly build forms. It is also one of the forms that you will use a
lot of through the book. The Products form was developed with most of the form
control types used in Microsoft Access to handle table data types such as text, cur-
rency, date, yes/no, memo, and OLE pictures. You will also learn how to use form
control types such as labels and text boxes, command buttons, option group con-
trols, check boxes, combo boxes, and toggle buttons. You will learn how to use
lines and rectangles and all the special effects that go with them. There is also a
tabbed dialog on the form which uses a subform control as well. There is even a
popup calendar on the form. You will see several different form types and tech-
niques to enter, search, filter, retrieve, and display data. The form includes tech-
niques to hide controls, display them based on certain business rules and even
update data in other tables. This form will be used to teach you how to work with
long memo fields and pictures as well.

XXII
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It is important to have a good understanding of the use of the form as well as the
technical details of how to build it. The form will contain information about each
product and is bound (tied to) the tblProducts table. As you enter information into
the frmProducts form, it is stored in the tblProducts table. You learn more about
that in Section II.

You will learn how to resize controls, how to align and space controls. You will learn
how to copy and paste controls, secrets of moving controls as well as how to work
with color, shading, text fonts, and even special effects. The frmProducts form can
do all this and more. Later, after you master forms, you will learn how to add code
behind this form and several others to make a truly powerful application. You will
learn how to add code to the Invoice form to check to the quantity in stock before
you can sell an item and then change the quantity in stock after you have sold it.

The top of the frmProducts form contains a control that allows you to quickly find a
record. This Quick Find is programmed using VBA code behind a combo box selec-
tion. The bottom of the form contains a series of command buttons that will be
used to demonstrate how to create new records, delete existing records, and dis-
play a custom search and custom print dialog.

7 Products 51>

199,000.00 # " )
|mut TN | p——— 1

Figure FM-3: The Access Auto Auctions Products form which
allows data entry for all vehicles and parts sold or auctioned.

Understanding the Product form subform

A form normally displays one screen of data. The frmProducts form contains a tab
control. This lets you effectively use a form to display many screens of data. Each
can use a different table or a different type of form. The frmProducts form displays
a single record at a time. This is on the first tab named Product. The second tab
named Show All Products displays many records at once as shown in Figure FM-4.
This is actually a subform or a form (named fsubProductsDisplayAll) within the
frmProducts form.
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This form is another great example of how a form works. It displays many records
at once but only selected fields. Each record contains a button to switch between
the record in the second tab with the more detailed record in the first tab. There is
also a button alongside each record to delete any records that are no longer
needed. Each of the column headers are actually buttons with code behind them
that can be clicked on to sort the records displayed by the form. One click and the
data in that column is used to sort the records in ascending order. The next click
into descending order.

T2 Products B6 %)
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Figure FM-4: The Access Auto Auctions Products form’s Show All Products tab that
allows the user to display all of the products and go right to the details of any record.

Understanding the Contacts Form

The frmContacts form shown in Figure FM-5 is used to maintain information about the
various contacts that Access Auto Auctions has relationships with. This includes
the contacts name and address, whether they are a buyer, seller, or both. It includes
information if the buyer or seller is a car dealer or parts store that they regularly do
business with or someone who just once came to a auction, bid on a car, and won.

The Contact form like the Products form contains a tab control. This allows you to
show several screens within one form. The Contacts form will be used in later chap-
ters to teach how to display objects within a form based on certain conditions. It
will show how to use a calendar to store and display data as well. Using information
on the other tabs, you will also learn how to display other forms such as a Contact
Log and how to synchronize information between two forms.
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Figure FM-5: The Access Auto Auctions frmcontacts form showing
a tabbed dialog and values used with the tblContacts table.

Using the Invoice form

The frmSales form shown in Figure FM-6 is used to teach some of the more
advanced form concepts you will learn in this book. Unlike all the other forms, the
Invoice form contains two subforms each of which use a relationship known as one-
to-many. This means that there may be one or more records in each subform that
relate (use the same key) as the main form. In this example, each invoice is used to
sell one or more products to a buyer. After all the products are selected for the
invoice and a total price is calculated, you can enter one or more payments to pay
for the vehicle and any parts or accessories. The buyer may make a deposit with a
check, and then pay the remaining balance with two different credit cards.

This form will also be used to teach simple and complex calculations. The calcula-
tion of the Amount column in the invoice line items is Qty x Price x (1-Discount%)
for example. All of the amount records have to be totaled to calculate the subtotal
field. Then a tax rate has to be retrieved and calculated to get the tax amount. This
plus the other amount must be summed to get the total. All this is happening using
fields in the Invoice Line items (fsubSalesLineitems) subform.

The second subform (fsubSalesPayments) will also be used to show how to calculate
a total in one subform (the total of all payments) and then use that total with controls
in other parts of the form. This is how the Amount Due control will be calculated. It
will require data from the main form and both subforms to calculate its total.
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These calculations will first be taught using nothing but properties of the controls
themselves without any VBA code in the earlier chapters. You will learn many tech-
niques for control referencing and calculating between forms. Later in the book,
you will learn how to add more flexibility and power by using VBA code to replace

the original techniques and then learn to use subroutines to really professionalize
the application.

The Invoice form will also be used to teach several other important techniques
including displaying values in other forms as you are taught how to display a prod-
uct record by hiding a double click event in the product control of each lineitem.
Each line item and payment can also be deleted by using a button and the code will
be explained here as well. The bottom of the Invoice form will also contain buttons
to create a new record a fill in any defaults as well as to delete an unneeded invoice
and to display search and print dialogs.

T Seles 050

Invoice Irwoice Number : 4

Buyer: [lores, John =zl
Mopa At Parts
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Figure FM-6: The Access Auto Auctions Sales Invoice form used to
show multiple linked subforms and totals.

XXVII



XXVII

Access 2003 Bible

Understanding the Search Dialogs

Each of the main forms (Contacts, Products, Sales) can display a separate form
known as a dialog (a form that is displayed on top of another). This allows you to
choose from a variety of ways to search for a record. This is built using a standard
Microsoft Access form. It contains an option group to allow the user to select a
search type and then uses VBA code to assemble the desired records in a list box
as shown in Figure FM-7. Once the user selects the desired record and presses the
OK button, more VBA code is used to close the dialog box, and display the desired
record in the Invoice form. There are separate search dialog forms for each of the
major forms.

Johifon

Figure FM-7: The Access Auto Auctions search
dialog displaying a variety of searches for the
Invoice form.

Understanding the Print Dialogs

Each of the main forms also use a separate form known as a dialog (a form that is
displayed on top of another) to allow you to choose important print settings before
printing the report that has been created to go with each form. In this example, you
can see the Invoice’s print dialog (frmDialogSalesPrint) as shown in Figure FM-8.
This form allows you to print invoices for just the current Inviice record, for a
selected date range, or even all invoices for a specific buyer. You will learn how to
build this form and properly write the VBA code behind it. This form will also teach
you how to filter data for reports, and to pass parameters to the Microsoft Access
print routines. You will learn how to send preview a report to the screen or how to
print any number of copies. You will also learn how to print multiple reports at
once from this simple print dialog.

There are separate print dialogs for each of the major forms.



Figure FM-8: The Access Auto Auctions invoice
print dialog displaying a variety of reports for
the Invoice form.

As you go through each chapter, come back here to remember what you will learn
or where each form is. In each chapter’s database file, you will only see the objects
that are needed for the chapter. The main databases, AccessAutoAuctions.mdb and
its linked data file AccessAutoAuctionsData.mdb will contain the finished example.
However, in the majority of all the chapter files, you will see the program files
(queries, forms, reports, and modules) in the same database file as the tables.
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In this chapter, you learn the concepts and terminology of
databases and how to design the tables that will be used
by your forms and reports. Finally, you build the actual tables
used by the example, Access Auto Auctions, in this book.

Before you begin to use a database software package, you
must understand several basic concepts. The most important
concept is that the data is stored in a “black box” known as

a table, and that by using the tools of the database system,
you can retrieve, display, and report the data in any format
you want.

After you understand the basic concepts and terminology,

the next important lesson to learn is good database design.
Without a good design, you constantly rework your tables,
and you may not be able to extract the information you want
from your database. Throughout this book, you learn how to
use queries, forms, and reports and how to design each of
these objects before you create one. The Access Auto Auctions
case study provides invented examples, but the concepts are
not fictitious.

This chapter is not easy to understand; some of its concepts
are complex. If your goal is to get right into Access, you may
want to skip to the section on building tables in this chapter.
If you are fairly familiar with Access but new to designing and
creating tables, you may want to read this chapter before
starting to create tables.

Chapter 1 does not use the example CD. This is a chapter
for you to read, view the screenshots, and learn many con-
cepts you will use later in this book.

To jump right into using Access, skip to the section titled
“Creating Database Tables” in Chapter 2.
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The Database Terminology of Access

Before examining the actual table examples in this book, it’s a good idea to have a
firm understanding of the terminology that is used when working with databases —
especially Access databases.

What is a database?

Generally, the word database is a computer term for a collection of information
concerning a certain topic or business application. Databases help you organize
this related information in a logical fashion for easy access and retrieval.

Databases aren’t only for computers. There are also manual databases; we simply
refer to these as manual filing systems or a manual database system. These filing
systems usually consist of people, papers, folders, and filing cabinets — paper is the
key to a manual database system. In a real manual database system, you probably
have in/out baskets and some type of formal filing method. You access information
manually by opening a file cabinet, taking out a file folder, and finding the correct
piece of paper. You use paper forms for input, perhaps by using a typewriter. You
find information by sorting the papers manually or by copying desired information
from many papers to another piece of paper (or even into a computer spreadsheet).
You may use a calculator or a computer spreadsheet to analyze the data further or
to report it.

A computer database is nothing more than an automated version of the filing and
retrieval functions of a manual paper filing system. Computer databases store
information in a structured format that you define. They can store data in a variety
of forms, from simple lines of text (such as name and address) to complex data
structures that include pictures, sounds, or video images. Storing data in a precise,
known format enables a database management system (DBMS) to turn the data into
useful information through many types of output, such as queries and reports.

In an automated database management system such as Access, you use a computer
to access the information or data stored in tables — entering data in the tables
through data-entry forms and retrieving it by using a query. You can create and use
queries to obtain a specific portion of data from the tables. Then a report outputs
the data to the screen or a printer. Macros and modules allow you to automate this
process and to create new menus and dialog boxes.

A relational database management system (RDBMS), such as Access, stores data in
many related tables. Using queries, you can ask complex questions from one or
more of these related tables, with the answers returning as forms and reports.
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Using Multiple Databases

When using Access, you normally use only one database at a time. However, it can use
more than one database simultaneously. As you build the example files in this book, you
will ultimately separate the data (tables) from all the other objects (forms, reports, queries,
and on and on) by placing the data tables in their own database and accessing the data by
linking to them from another database containing all the other objects.

Databases, tables, records, fields, and values

Microsoft Access follows traditional database terminology. The terms database,
table, record, field, and value indicate a hierarchy from largest to smallest.

Databases

In Access, a database is the overall container for the data and associated objects.

It is more than the collection of tables, however —a database includes all objects.
Database objects include tables, queries, forms, reports, data access pages, macros,
and modules. In some computer software products, the database is the object that
holds the actual data; in Access, this is called a table. Other products refer to the
database as the collection of all tables related to the system.

Access can work with only one database at a time. Within a single Access database,
however, you can have hundreds of tables, forms, queries, reports, pages, macros,
and modules, all stored in a single file with the file extension .MDB (multiple
database) or .ADP if you are using SQL Server Desktop Engine.

- Cross- ADP file format is a special database format that is used by Access to act as a front
Reference )  ond to access the underlying data stored in SQL Server (in MDF format). Chapter
28 covers Access Data Projects in detail.

¢ Cross- Chapter 7 covers moving your tables to another database in detail.
Reference

|

Chapters 27 and 28 cover SQL server and Access projects in detail.

Tables

A table is just a container for raw information (called data), similar to a manila folder
in a manual system that holds reports. When you enter data in Access, a table stores
it in logical groupings of similar data (the tblProducts table, for example, contains
data about items being sold) and the table’s design organizes the information into
rows and columns.



6 Part I, Section | + Working with Data Tables and Queries

You create these tables after careful analysis of the type of information that you want
to store, as discussed in the “Designing field names, types, and sizes” section later
in this chapter. After you create a table, you can view the table in a spreadsheet-like
form, called a datasheet, comprising rows (records) and columns (fields). Figure 1-1
shows a simple datasheet of the tblContacts table.

2 hiContacts - Table e )
| ContactiD | ContactT: Fiest Name |  Last Name Company |  Address | City | Same | ZpCodia
Og | Buyw Joha Jors Nopa Asto Pan: 11253 Man Stn Sprngheld WA 01111253
- 2 Seler Hank Mlpsions Jiy Autp Salss 623 Field Road  Sprngleld MO 12345
| | 3 Both Laery Mnkder AN Stat Autos 971 E Mais St Daftrok (] 1255767
u 11 Both Joo Hamesgeman  Columbia Chevy 105 Masm Street Columbea MA 12237
- 12 Buywr Cary Jomas James Aato Pa 55 South Strest Portland CT 96480
- 13 Buywr Mhark Uno Filbon Sales An 5908 Nerth Park South Windeer CT 60T
| ] 14 Buyw Bramdon Ay T Top Chevy 1816 Emchaon [ Fawbanks WA 12333
| | 14 Both Mg el Denneg Newbury Aute 75 Mamn Steeet  Bedierd NY 10506-
| 16 Both ook Blpezan Foekaill Salpy 51 Tolland Trph Lake Peskaiol  NY 10537
| | 17 Both Kl Johngon KJ Auto Repaw 350 Broadway ¢ Rye Ny 10580
n 18 Both Wilkam Gleason R4 G Monda ir 136 Epst Street Dby cr 06218
| | 18 Bogth Al Tomaso Tiws National 45 Scheol Stres Oneco (=} 9637
n 20 Bath Kara s Hayes Auctions 58 E Center Str Grasby CcT 06035
n 21 Saller Teresa Aduny Mddiatown Auti 100 Nosthlield D Meddlstown  CT 06457,
| | 22 Bath Joha Maens Bill Thomsas Sal 986 Bucknghar Brawter N 10508
- 23 Bath Deonald Petersca Yastic Aute Pa 6 Oak Street  Yantic cT 06383
- 24 Seler Dannee Parkaon ACC Car Sales 963 New Englar Peskail Y 10566-
- 25 Buyw Ann Bend A-12utc Sales 58 South Mam | Colehoster cT 06415
| | 26 Seller Jod Caook Main Strest Usd 61 North Main £ Windsor cT 06095
- 27 Both Jefrey Lan LAN Trucking 108 Thomas Ro North Baanch WU 08376
| | 28 Buyw Matt Senth ABC Teucking 7 Depot Rd  Stratiord cT 06515
- 29 Both David Sesith Fordman Colens 123 Fadeal S Quincy Ma 1230
n 30 Both Cindy Caney Ciecle Auto Salk 123 Sosth Strec Newingtoa  NH 12301
- 3 Both Kaven Basdey Sammry Fordma 59 West Church Westbousgh ~ MA 91581
32 Both A Schandler Pme Flamg BM 2 5 Pusg Plgeny NY 12567
{1 11 Rath lshe e Plexantalle L 45 Plrssantalle Vet Recioesa WA oS =
Recoed: M| ¢ [T 1 b [M|p#|of | 1L

Figure 1-1: A table displayed in a datasheet

Records and fields

As Figure 1-1 shows, the datasheet is divided into rows (horizontally from left to
right) called records and columns called fields, with the first row (the heading on
top of each column) containing the names of the fields in the database. Each row is
a single record containing fields that are related to that record. In a manual system,
the rows are individual forms (sheets of paper), and the fields are equivalent to the
blank areas on a printed form that you fill in.

The data shown in the table has columns (vertically from top to bottom) of similar
information, such as Contact ID, Contact Type, First Name, and Last Name; these
columns of data items are fields. Each field is identified by a field name (the first
row of the datasheet) that identifies its category of information. In addition, each
field has a certain type of data (Text, Number, Date, and so on) in it and has a speci-
fied length.

The rows of data within a table are its records. Each row of information is considered
a separate entity that can be accessed or sequenced as desired, and each record is
made up of fields. Each record has all the fields (one each) of the database structure.
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For example, looking at Figure 1-1, Row 1 has a Contact ID field with the value of “1,”
a Contact Type of “Buyer,” a First Name of “John,” and the remaining fields. Row 2
has a Contact ID field with the value of “2,” a Contact Type of “Seller,” a First Name of
“Hank,” and the other fields. Each row and record has all the fields of the database
with a value in each (some of the values may be blank or empty, known as null). All
the fields of information concerning a certain contact are contained within a spe-
cific record.

Values

At the intersection of a row (record) and a column (field) is a value — the actual
data element. For example, John, the First Name in the first record, represents one
data value. You may have a couple questions, such as:

4+ How do you identify the first record?

It’s sitting in the first row of the datasheet and is the record with the buyer
John Jones.

4 But what if you have more than one John Jones in your database?

Whereas the fields of a record are known by the field name, records are usually
identified by some unique characteristic or value within one or more of the
fields of the record. This unique value makes each record different from all the
other records. In the tblContacts table, the field that makes each record unique
is the Contact ID; fields like the Contact Type, First Name, or Last Name are
not unique because you may have two people named John Jones or more than
one Buyer in the table.

Sometimes it takes more than one field to find a unique value. You can use Company
and Contact Type, but it’s possible for more than one customer to work for the same
Company and all of them may be buyers or sellers. You can use the fields Company,
Contact Type, and Last Name. Again, theoretically, you can have two different cus-
tomers come in and both say, “Hi, my name’s Jones —I work for Acme Company, and
[ am a seller.” Creating a unique identifier (such as Contact ID) helps distinguish one
record from another without having to look through all the values.

Using More Than One Table

A database, by definition, is a collection of tables. Just like a file cabinet usually
contains many manila folders, a database contains one or more tables (that is, logi-
cal groupings of similar data). Most applications that are developed in Access have
several related tables to present the information efficiently. An application that
uses multiple tables can usually manipulate data more efficiently than it can with
one large table.



8 Part I, Section | + Working with Data Tables and Queries

Tip

Working with multiple tables

Multiple tables simplify data entry and reporting by decreasing the input of redun-
dant data. By defining two tables for an application that uses customer information,
for example, you don’t need to store the customer’s name and address every time
the customer purchases an item.

After you've created the tables, they need to be related to each other. For example,
if you have a Contacts table and a Sales table, you must relate the Contacts table to
the Sales table in order to see all the sales records by the Contact. If you had only
one table, you would have to repeat the Contact name and address for each sale
record. Two tables let you look up information in the Contact table for each Sale by
using the related fields Contact ID in Contacts and Buyer ID. This way, when a cus-
tomer changes address (for example), it changes only in one record in the Contact
table; when the Sales information is onscreen, the correct contact address is always
visible.

Separating data into multiple tables within a database makes the system easier to
maintain because all records of a given type are within the same table. By taking the
time to segment data properly into multiple tables, you experience a significant
reduction in design and work time. This process is known as normalization.

It's also a good idea to create a separate database for just your tables. By separating
s your design objects (queries, forms, reports, pages, macros, and modules) and the

4 tables into two different databases, you can more easily maintain your application.

Later in this chapter, you have the opportunity to work through a case study for the
Access Auto Auctions that consist of five tables.

| Reference

|
L

fis-/x For more information about the Access Application Splitter, see Chapter 7.

Why you should create multiple tables

The prospect of creating multiple tables always scares beginning database users.
Normally, they want to create one simple table that contains information —in this
case, a Customer table with all the sales performed by the customer and all the
items sold or bought for each customer. So they create a single table containing all
the fields, including fields for the personal information for customer (contact),
Sales information (date of sale, sales person amount paid, any discount, and so on)
and the products information (the quantity sold, the product information, individ-
ual prices, and so on) for each sale. Before you know it, the table has 50 fields or
more. You add more fields as you think of more things that need to be captured.

As you can see, the table design begins to take on a life of its own. After you've
created the single table, it becomes even more difficult to maintain. You begin
to realize that you have to put in customer information for each sale a customer
makes (repeating the information over and over). The same is true for the items



Chapter 1 4+ Understanding Data 9

purchased for each sale, which is usually more than one item sold for each sale
(thus duplicating information again). This makes the system more inefficient and
prone to data-entry mistakes. The information that is actually in the table becomes
inefficiently maintained — many fields may not be appropriate for each record, and
the table ends up with a lot of empty fields.

It’s important to create tables that hold the minimum of information while still mak-
ing the system easy to use and flexible enough to grow. To accomplish this, you need
to consider making more than one table, with each table containing records with
fields that are related only to the focus of that table. Then, after you create the tables,
you can link them together by some means that will let you glean useful information
from them. Although this sounds extremely complex, the actual implementation is
relatively easy. Again, this process of creating multiple tables from a single table is
known as normalization — or normalizing your tables.

Access Database Objects and Views

If you are new to databases (or even if you're an experienced database user), you
need to understand some key Access concepts before starting to use the program.
The Access database contains seven objects, which consist of the data and tools
that you need to use Access:

4 Table. Holds the actual data (uses a datasheet to display the raw data)
4 Query. Lets you search, sort, and retrieve specific data

4 Form. Lets you enter and display data in a customized format

4+ Report. Lets you display and print formatted data, including calculations
and totals

4 Pages. Lets you publish live forms to a corporate intranet

4 Macro. Gives you easy-to-use commands to automate tasks without
programming

4 Module. Lets you create programs written in VBA (Visual Basic for
Applications)

Datasheets

Datasheets are one of the many ways by which you can view data. Although not a
database object, a datasheet displays a list of records from a table in a format com-
monly known as a browse screen or table view. A datasheet displays data as a series
of rows and columns (comparable to a spreadsheet). A datasheet simply displays
the information from a table in its raw form. This spreadsheet format is the default
mode for displaying all fields for all records.
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You can scroll through the datasheet using the directional keys on your keyboard. You
can also display related records in other tables while in a datasheet. In addition,
you can make changes to the displayed data.

Caution Use caution when making any changes or allowing a user to make any modifica-

tions in this format. When a datasheet record is changed, the data in the underly-
ing table is the data actually being changed.

Queries and dynasets

You use a query to extract information from a database. A query can select and
define a group of records that fulfill a certain condition. You can use queries before
printing a report so that only the desired data is printed. You can also use a query
with forms so that only certain records that meet the desired criteria appear
onscreen. You can also use queries within procedures to change, add, or delete
database records.

An example of a query is when a person at the Auto Sales office says, “Show me all
customers, in alphabetical order by name, who live in Massachusetts and bought
something over the past six months, and show them to me sorted by Customer
name” or “Show me all customers who bought cars for a value of $35,000 or more
for the past six months and show them to me sorted by customer name and then
by value of the car.” Instead of asking the question in actual English, the person
uses a method known as QBE, which stands for Query by Example. When you enter
instructions into the QBE Design window, the query translates the instructions into
SQL (Structured Query Language) and retrieves the desired data. In the first exam-
ple, the query first combines data from both the Sales and Contact tables, using the
related field Contact ID (the common link between the tables). Then it retrieves the
fields First Name, Last Name, and any others you want to see. Access then filters
the records, selecting only those in which the value of Sales Date is equal to or less
than six months from the current date. It then sorts the resulting records first by
contact’s Last and First names. Finally, the records appear onscreen in a datasheet.
A similar action takes place for the second example — using Sales, Contacts, Invoice
Items, and Products and the criteria being looked for is where the Description field
has a car bought whose value in Price is greater than or equal to $35,000.

These selected records are known as a dynaset— a dynamic set of data that can
change according to the raw data in the original tables.

After you run a query, the resulting dynaset can be used in a form that can be dis-
played onscreen in a specified format or printed on a report. In this way, user access
can be limited to the data that meets the criteria in the dynaset.

Data-entry and display forms

Data-entry forms help users get information into a database table quickly, easily,
and accurately. Data-entry and display forms provide a more structured view of the
data than what a datasheet provides. From this structured view, database records
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can be viewed, added, changed, or deleted. Entering data through the data-entry
forms is the most common way to get the data into the database table.

You can use data-entry forms to restrict access to certain fields within the table. You
can also use these forms to check the validity of your data before you accept it into
the database table.

Most users prefer to enter information into data-entry forms rather than datasheet
tables; data-entry forms can be made to resemble familiar paper documents. Forms
make data entry self-explanatory by guiding the user through the fields of the table
being updated.

Display-only screens and forms are solely for inquiry purposes. These forms allow
for the selective display of certain fields within a given table. Displaying some fields
and not others means that you can limit a user’s access to sensitive data while
allowing inquiry into other fields.

Reports

Reports present your data in printed format. You can create several different types
of reports within a database management system. For example, your report can list
all records in a given table, such as a customer table. You can also create a report
that lists only the customers who meet a given criterion, such as all those who live
in the state of Washington. You do this by incorporating a query into your report
design. The query creates a dynaset consisting of the records that contain the state
code WA.

Your reports can combine multiple tables to present complex relationships among
different sets of data. An example of this is printing an invoice. You access the cus-
tomer table to obtain the customer’s name and address (and other pertinent data)
and the sales table to print the individual line-item information for the products
ordered. You can then have Access calculate the totals and print them in a specific
format on the form. Additionally, you can have Access output records into an invoice
report, a table that summarizes the invoice.

. When you design your database tables, keep in mind all the types of information
Tip that you want to print. Doing so ensures that the information you require in your
% various reports is available from within your database tables.
/

| Reference’) oo the appropriate chapters.

ﬁj For descriptions of the remaining database objects (pages, macros, and modules),

Designing the system’s objects

To create database objects, such as tables, forms, and reports, you first complete a
series of tasks known as design. The better your design is, the better your application
will be. The more you think through your design, the faster you can complete any
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system. Design is not some necessary evil, nor is its intent to produce voluminous
amounts of documentation. The sole intent of design is to produce a clear-cut path
to follow as you implement it.

The Seven-Step Design Method

Figure 1-2 is a version of the design method that is modified especially for use with
Access. This is a top-down approach, starting with the Overall System Design and
ending with the Menu Design, and consists of seven steps.

0 IS Desi Figure 1-2: The seven-step design flowchart.
verall System Uesign This design methodology is one that has been
[ modified specifically for use with Access

Report Design (Output) databases.
Data Desilgn (Fields)
Table Design |(Relationships)
Field Desigrl (Validation)
Form Desilgn(lnput)

|
Menu Design (Automation)

These seven design steps, along with the database system illustrated by the exam-
ples in this book, teach a great deal about Access and provide a great foundation for
creating database applications —including databases, tables, queries, forms, data
pages, reports, macros, and simple VBA (Visual Basic for Applications) modules.

As you read through each step of the design process, always look at the design in
terms of outputs and inputs. Although you see actual components of the system
(customers, pets, visits, and visit details), remember that the focus of this chapter
is how to design each step. As you watch the Access Auto Auctions system being
designed, pay attention to the design process, not the actual system.

This process of looking at output/input is often referred to as performing a needs
analysis.
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Step 1: The overall design — From concept to reality

All software developers and end users face similar problems, the first of which is
determining what will meet the needs of the end user (typically your client, your
coworker, or yourself). It’s important to understand the overall needs that the
system must meet before you begin to zero in on the details.

The seven-step design method shown in Figure 1-2 helps you to create the system
that you need, at a price (measured in time or dollars) that you can afford. The
Access Auto Auctions database, for example, is a database system that allows the
client to sell items (vehicles and parts) to customers. It can be ran individually or
on the Internet, and needs to automate the following nine tasks:

4+ Entering and maintaining contact information (customers, sellers) —name,
address, and financial history

4 Entering and maintaining sales information — sales date, payment method,
total amount (including tax), buyer ID, and other fields

4+ Entering and maintaining sales line items information — details of items actu-
ally purchased

4 Viewing information from all the tables — Sales, Contacts, Sales Line Items
purchased, and Payment Information

4 Asking all types of questions about the information in the database
4 Producing a current Contacts directory

4 Producing a monthly invoice report

4 Producing a Customer Sales History

4 Producing mailing labels and mail-merge reports

Conceptual design

These nine tasks that the Access Auto Auctions needs to automate are conceptual
at this point; they are the ones that you have been told about by the client. You may
need to consider other tasks as you start the design process.

The design process is a repetitious procedure; as you finish each step, you need to
look at all the previous steps again to make sure that nothing in the basic design
has changed. For example, if you are creating a data-entry rule and decide that you
need another field (that’s not already in the table) to validate a field you've already
defined, you have to go back and follow each previous step needed to add the field.
You have to be sure to add the new field to each report in which you want to see it.
You also have to make sure that the new field is on an input form that uses the table
the field is in. Only then can you use this new field in your system.

13
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Interviewing the user

Most of the information that is necessary to build the system comes from the people
whom you are building the system for. This means that you need to sit down with
them and learn about how the existing manual process works. To accomplish this
you need to do a thorough needs analysis of the user or client’s current system and
how you anticipate automating it.

One way to accomplish this is to sit down and prepare a series of questions that can
give you insight to how the client currently performs their business. For example,
when considering automating an auto action system, you may consider asking these
questions:

4 What reports and forms are currently used?
4 How are records currently kept on the sales?

4 How are the manual records/charts filed of the contacts, their sales, or
products they offer?

4+ What happens when a customer doesn’t come back for a year or more?
4 What do they do with the records after a year? Five years?

4 How are billings processed?

As you ask these questions and others, the client will probably remember other
things about their business that you should know.

A walk-through of the manual process is also necessary to get a “feel” for the busi-
ness. You will probably have to go back several times to watch the manual process
and how the employees work.

When you prepare to follow the remaining steps, keep the client involved —let them
know what you are doing and ask for their input as to what you want to accomplish,
making sure it is within the scope of their needs.

The process of prototyping

You may want to create a prototype system for the client to look at and play with to
give you further input about what needs to be added to make the system functional
for them.

In its simplest terms, a prototype is a working sample system. It comprises one
or more tables that are used to demonstrate the forms and reports of the system.
A prototype is made up of the visual parts of the system as opposed to the logical
underlying structure of the system.

A prototype is only the visual representation of how the system will look and function
after it’s complete. Often you can build a prototype in a few days and give it to the
client for their comments. This allows the user to see a working prototype demon-
strating the data display and data access techniques through forms and reports.
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Prototypes can be very stress-inducing. Essentially, they are an attempt to visualize
the future and plan for change and are often undertaken without a clear vision of
what the end result will be. Remember that a prototype is a working sample of the
final system — it will need to be changed.

So why build one? Prototypes can help you visualize a strategy or direction,
describe functionality or form, and demonstrate a proof of concept. You can use
them to gauge customer reaction, explore system functionality, and test the system’s
concepts and directions.

Because of these reasons, prototyping offers a highly valuable tool in the overall
building of your database system.

To build a prototype of the overall system, you have to quickly define the major
components of your database from your specifications that you gathered during
the initial meetings with the client. A prototype shouldn’t become the final working
system —it is only a sample system. Keeping this in mind, you shouldn’t spend
weeks and months on building one. Here’s a good analogy to keep in mind: Think of
a prototype system as the house fronts that are built for a street scene in a movie.
They look great, but the moment you open the front door to the building, you find
yourself in a vacant lot —it’s all make-believe!

Basically, a good prototype saves time and significantly reduces the cost of the
overall project.

Step 2: Report design — Placing your fields

After you've defined the Access Auto Auctions’ overall systems in terms of what
must be accomplished, you can begin report design.

Design work should be broken into the smallest level of detail, based on your
knowledge of the current system. Start each new step by reviewing the overall
design objectives. In the case of Access Auto Auctions, your objectives are to
track customers (buyers and sellers), track sales, keep a record of all sales and
items purchased, produce invoices, create a directory of contacts, and produce
mailing labels. Figures 1-3 and 1-4 show two possible reports that the system
may use.

Laying out fields in the report

When you see the reports that you will create in this section, you may wonder,
“Which comes first—the chicken or the egg?” Does the report layout come first,

or do you first determine the data items and text that make up the report? Actually,
these items are conceived together.

It isn’t important how you lay out the fields in this conception of a report. The
more time you take now, however, the easier it will be when you actually create the
report. Some people go so far as to place gridlines on the report so that they will

15
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know the exact location they want each field to occupy. In this example, you can
just do it visually.

The reports in Figures 1-3 and 1-4 were created with two different purposes. The
report in Figure 1-3 is used to display information about an individual contact
(Buyer, Seller, or Both). In contrast, the report in Figure 1-4 is a typical invoice with
billing and customer information. Both of these reports, although different purposes,
were created based on the type of information that they will use. The actual layout
was conceived simultaneous with determining what they need to have in them.
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Figure 1-3: A contact information report

Tip This process of creating any new reports should be done with pen and paper first.

s, After you have reviewed any existing reports and the new ones you have created,
' you are ready to figure out what type of information you will need to put into your
automated system.

- Cross- If you want to learn more about the reports for the Access Auto Auctions system
| Reference ) o Chapters 12 and 13.
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Figure 1-4: A sales invoice report sales information

Step 3: Data design —What fields do you have?

After you've decided what you want for output, it’s time to think about how to orga-
nize your data into a system to make it available for the reports that you've already
defined (as well as for any ad hoc queries). The next step in the design phase is to
take an inventory of all the information or data fields that you need to create the
desired output (reports and forms). One of the best methods is to list the data items
in each report. As you do so, take careful note of items that are in more than one
report. Make sure that you keep the same name for a data item that is in more than
one report because the data item is really the same item.

Another method is to see whether you can separate the data items into some logi-
cal arrangement. Later, these data items are grouped into logical table structures
and then mapped on data-entry screens (forms) that make sense. You should enter
customer data (buyers and sellers), for example, as part of a contact table process,
not as part of a visit entry.

This process of grouping common information is known as one of the steps in the
s, process of normalizing your database. As you conceptually work with the data items

4 (orfields) you should group them together into logical groups (the customer-related

fields, the sales-related fields, and on and on).
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Determining contact information

First, look at each report you have reviewed or attempted to make for the Access
Auto Auctions system. For this system, start with the customer data and list the
data items, as shown in Table 1-1.

Table 1-1
Customer-Related Data Items Found in the Reports
Contacts Report Invoice Report
Customer Name Customer Name
Street Street
City City
State State
ZIP Code ZIP Code
Phone Numbers Phone Number

Type of Customer

E-Mail Address

Web Site Information

Contact Log Information (4 fields)
Discount Rate

Customer Since

Last Sales Date

Sales Tax Rate

Credit Information (4 fields)

As you can see by comparing the type of contact (customer) information needed for
each report, there are many common fields. Most of the data fields pertaining to the
customer are found in both reports. Table 1-1 shows only some of the fields that are
used in each report —those related to customer information. Fields appearing on
both reports appear on the same lines in the table, which allows you to see more
easily which items are in which reports. You can look across a row instead of looking
for the same names in both reports. Because the related row and the field names are
the same, it’s easy to make sure that you have all the data items. Although locating
items easily is not critical for this small database, it becomes very important when
you have to deal with large tables.
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Determining sales information

After extracting the customer data, you can move on to the sales data. In this case,
you need to analyze only the Invoice report for data items that are specific to the
Sales. Table 1-2 lists the fields in the report that contain information about the Sales.

Table 1-2
Sales Data Items Found in the Reports

Individual Invoice Report

Invoice Number

Sales Date

Invoice Date

Payment Method

Payment Salesperson

Discount (overall for sale)

Tax Location

Tax Rate

Product purchased (multiple lines)
Quantity purchased (multiple lines)
Description of Item purchased (multiple lines)
Price of Item (multiple lines)

Discount for each item (multiple lines)
Taxable? (multiple lines)

Payment Type (multiple lines)
Payment Date (multiple lines)
Payment Amount (multiple lines)
Credit card Number (multiple lines)

Expiration Date (multiple lines)

As you can see when you examine the type of sales information needed for the
report, a couple of items (fields) are repeating; for example, the Product purchased,
Number of items purchased, and Price of each item. Each invoice can have multiple
items, and each of these items needs the same type of information — number
ordered and price per item. Each Sales Invoice will probably have more than one
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item that is sold and being invoiced. Also, each invoice can have partial payments
showing on it, and it is possible that this payment information will have multiple
lines of payment information, so these repeating items can be put into their own
grouping.

Determining line item information

You can take all the individual items that you found in the Sales information group
above and extract them to their own group for the Invoice Report. Table 1-3 shows
the information related to each line item.

Table 1-3
Extracting Line Item Information

Line Item Data Items

Product purchased

Quantity purchased
Description of item purchased
Price of item

Discount for each item

Taxable?

Looking back at the report in Figure 1-4, you can see that the above table doesn’t
list the calculated field amount, but you can recreate it easily in the report.

Unless a numeric field needs to be specifically stored in a table, simply recalculate
» it when you run the report (or form). You should avoid creating fields in your
4 tables that can be created based on other fields —these calculation fields can be
easily created and displayed in a form or report. Don't waste the storage space or
your valuable time!
Combining the data

Now for the difficult part: You must determine what fields you need to create for
the tables that make up the reports. When you examine the multitude of fields and
calculations that make up the many documents you have, you begin to see which
fields actually belong to the different tables. (You already did some preliminary
work by arranging the fields into logical groups.) For now, include every field you
extracted. You will need to add others later (for various reasons), although certain
fields won’t appear in any table.
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After you have used each report to display all the data, it’s time to consolidate the
data by function (for example, grouped into logical groups) and then compare the
data across those functions. To do this step, first you look at the contact information
and combine all of its different fields to create one set of data items. Then you do the
same thing for the Sales information and the Line Item information. Table 1-4 com-
pares data items from these three groups of information.

Table 1-4
Comparing the Data Items from the Three Groups
Contacts Data Invoice Data Line Items Data Items
Customer Name Invoice Number Product purchased
Street Sales Date Quantity purchased
City Invoice Date Description of item
purchased
State Payment Method Price of item
ZIP Code Payment Salesperson Discount for each item
Phone Numbers Discount (over all for this sale) Taxable?
(2 fields)
Type of Customer Tax Location
E-Mail Address Tax Rate
Web Site Information Payment Type (multiple lines)
Contact Log Information Payment Date (multiple lines)
(4 fields)
Discount Rate Payment Amount (multiple lines)
Customer Since Credit card Number (multiple lines)
Last Sales Date Expiration Date (multiple lines)

Sales Tax Rate

Credit Information
(containing 4 fields)

Consolidating and comparing data is a good way to start creating the individual
table definitions for Access Auto Auctions, but you have much more to do.

As you learn more about how to perform a data design, you also learn that the
information in the Contacts column must be split into two columns. Some of these
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items are used only once for the contact; other items can have multiple entries; for
example, the Contact Log information. This is also true for the Sales column —the
payment information can have multiple lines of information.

It is necessary to further break these types of information into their own columns,
thus separating all related types of items into their own columns — an example of
the normalization part of the design process. For example, one customer can have
multiple contacts with the company. One customer can also have a sale in which he
pays several payments to pay that sale off. Of course, we have already broken the
data into three columns above: contacts, invoice of sales, and sales line items.

Keep in mind that one customer can have multiple invoices, and each invoice can
have multiple line items on it. The contact (customer) group represents customer
(buyer or seller) information, the invoice group contains information about individ-
ual sales, and the line items group contains information about each invoice. Notice
that these three columns are all related; for example, one customer can have multi-
ple invoices and each invoice may require multiple detail lines (line items). These
relationships between tables can be different. For example, each Sales Invoice can
only have one customer (thus a one-to-one relationship). In contrast, one customer
can have multiple sales, forming a one-to-many relationship. A one-to-many relation-
ship also exists between the sales invoice and the line items of the invoice.

r Cross- Creating and understanding relationships is covered in Chapter 2.
'] Reference

At this point, you could continue to make additional columns for the things that
have the potential of multiple lines, meaning contact log information and payment
information. However, these three columns are the main groups of information (the
three main tables) that will be needed for the Access Auto Auctions database. Other
tables will be needed for the system and each of these groups, if made into a table,
will require additional fields. But the fields in each column of Table 1-4 are many of
the fields needed for each table used in the Access Auto Auctions database. You will
make many more changes as the design is examined and enhanced.

Linking the groups/tables

Assuming that the three groupings represent the main three tables of your system,
less additional fields, you will need to have some type of way to link these tables
together. This means that you have to add one more identification number to each
group. None of these groups/tables has a unique identifier (a way to make each
record in the group unique and easy to find), which means that you will need to add
at least one field to each group that can be used to link a specific record, or group
of records, in one table to a specific record in another table. For example, you could
create a contact ID number and put it in the Contacts table. Then add this same
number into the Invoice table so that the Invoice table can look up that Contacts

ID number in the Contacts table to get the information it needs about the customer.
The same could be done for linking the Invoice and the Line Items table — create an
invoice number that would be used in both of these tables. The linking of one group
of data to another is done through special fields, known as key fields.
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With an understanding of the need for linking one group to another, you can add
some fields to each group. Table 1-5 shows two new groups and link fields created
for each group/table. These link fields, known as primary or foreign keys, can be
used to link these tables together.

Table 1-5
System Tables with Keys

Sales
Payment

Contacts Data Invoice Data Line Items Data Data

Contact ID Invoice ID Invoice ID Invoice ID

Customer Name Contact ID Line number Contact Date Payment
Type

Street Invoice Number  Product purchased  Contact Notes Payment
Date

City Sales Date Quantity purchased Payment
Amount

State Invoice Date Description of Follow up date Credit card

item purchased Number

ZIP Code Payment Method Price of item Expiration
Date

Phone Numbers Payment Discount for

(2 fields)

Type of Customer

E-Mail Address

Web Site
Information

Discount Rate
Customer Since
Last Sales Date

Sales Tax Rate

Salesperson

Discount (over
all for this sale)

Tax Location

Tax Rate

each item

Taxable?

With the link fields added to each table, you can now find a field in one table that
can be used to link it to any table that needs to be related. For example, Table 1-5
shows a Contact ID field in both the Contacts table and the Invoice (Sales) table.

23
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g Cross- Creating specific types of links and understanding their importance is covered in
| Reference’) 1\ 5re detail in Chapter 2 when discussing relationships. See Chapter 2 for a com-
!

Alote

plete discussion of keys and relationships.

Step 4: Table design and relationships

You have identified the core of the three primary tables for your system, as reflected
by the first three columns in Table 1-5. This is the general, or first, cut toward the
final table designs. You have also created two additional tables (columns) from fields
shown in Table 1-4.

Taking time to properly design your database and the tables contained within it is
arguably the most important step in developing a database-oriented application. By
designing your database efficiently, you maintain control of the data — eliminating
costly data-entry mistakes and limiting your data entry to essential fields.

Although this book is not geared toward teaching database theory and all of its
nuances, this is a good point to briefly describe the art of database normalization.

Database normalization

Database normalization can essentially be defined as the process of optimizing how
you store and use the information in your tables. E. F. Codd, an employee of IBM,
first proposed the normalization process back in 1972 (Normalized Data Structure:

A Brief Tutorial, 1971, and Relational Completeness of Data Base Sublanguages, 1972).
Codd proposed that a person should take each table and put it through a series of
tests to “certify” whether or not it belonged to a certain normal form. He initially
proposed three normal forms, which he named first, second, and 3rd normal form.

Simply put, these “normal forms” are based on the functional dependencies of the
fields within a table and how they interrelate with the other tables of the database
system. Using normalization, you can ensure that the information in your tables is
being utilized and stored efficiently.

Normalizing to 3rd Normal form

When possible, you should take your tables and try to normalize them to 3rd normal
form. This simply means that you should separate your tables into the focused
groups (the columns in Tables 1-4 and 1-5) that you've already started. After you
separate the tables, you are ready to look at each table separately and determine if
you can optimize them better. This is accomplished via a process known as normal-
izing to Third Normal Form (3NF). Third Normal Form requires three steps, as out-
lined in the following sections.

Often you perform these steps after you create all the fields that you need in your
-~ tables. You may want to jump back to this section after creating the actual tables
for your Access Auto Auctions system.
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The reasons you want to consider making your tables conform to 3NF is two-fold:

4 Eliminating Data Redundancy. When typing data into tables, you may
encounter two problems: First, typing the same data over and over consumes
more space and resources than necessary. Second, entry of repetitive informa-
tion is prone to typographical errors.

4+ Unforeseen Scalability Issues. The database tends to continue growing and

takes on a life of its own after creation. If you fail to normalize your tables, you
run the risk of “hard coding” in fields that later need to be expanded. For exam-
ple, you may have two telephone fields in your system (one for home, one for
business). Later, you may realize that you need to also capture cellular phone
numbers and perhaps beeper numbers. Going back and changing the structure
to accommodate this new information is problematic. You would need to move
the telephone numbers to their own table and then have to change many forms
and reports that refer to these fields in the new table. The system needs to be
able to quickly adapt to these growth issues.

You can eliminate these types of problems by building your tables following the
three basic steps of normalizing to Third Normal Form.

First normal form (1NF)

Converting a table to the first normal form is relatively simple. The first rule calls
for the elimination of any repeating groups of data— moving repeating data into
their own tables.

3rd Normal Form and the Access Auto Auctions

The tables used in the Example database, Access Auto Auctions, does not conform to 3rd
Normal form. In many real business applications, you must sometimes sacrifice blind fol-
lowing of a rule for simple reality. For example, 1st normal form says that you will never
have the same data in more than one place. The tbIProducts table contains values for an
item’s Price. An invoice line item stored in the tblSalesLineltems table also contains a field
for an item’s Price. However, prices change. When you add an item to a sales invoice, you
copy the current value of price. If you stored only the product’s tem Number and looked up
the price when printing the invoice at a point in time and the price has changed in the
tbIProducts table since the moment of purchase, you wouldn't agree to it (unless it went
down). This is known as time-dependent data and is a reason to not technically follow 1st
normal form at a database level. In fact, technically because one table records the price as
it changes for an item and one records the price at a moment in time, they are different.
Keep this in mind when reading this section. For clarity the two fields could be named dif-
ferently for the distinction. To stick with 3rd normalized form you could create another link-
ing table that contains the price of the item at time of sale and link this to the Line Items
database — complicating the example in this book. For simplicity the book simply puts the
field in both tables.
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For example, looking at the Contacts table in Table 1-4, you see that you have a
repeating group in the table of contact information fields. These contact related
fields can be moved to their own table and then you can link the two tables by
using a common field between them. Table 1-5 shows the fields moved into their
own table and then linking the two tables together though the common field
Contact ID.

There are also the City and State name fields in the contacts table. In reality, you
should move these fields to another table and link it back to the Contacts table via
the ZIP code (only if, in America, you use the nine-digit ZIP code instead of the tra-
ditional five-digit one). For this exercise, we acknowledge that it should be done.
For simplicity, however, we will leave it in the database, allowing people to enter
the five-digit code or other country codes.

Second normal form (2NF)

Converting a table to second normal form takes a bit more thought. It relies on each
table having a defined primary key:.

Simply explained, a primary key is a field or combination of fields in a table that
makes each record in the table unique. Using this uniqueness, you can quickly find
any record by searching for the unique (primary) key.

¢ Cross- For more information on primary keys, see Chapter 2.
'] Reference

For example, in Table 1-5 you have both an Invoice ID field and a Line Number field
in the Line Items Data table. If you combine these two fields together, they make a
unique primary key. (Because each Invoice can contain more than one Line Item
record, you need to link the Invoice table to the Line Item Table through the Invoice
ID field; however, to make each record unique in the Line Items data table, you need
to have another field that has a value for each line item number for each invoice —
thus the Line Number field).

Looking at the Line Items Data table, you can see that there are two fields — Product
Purchased and Description of Item Purchased. Because these data elements (fields)
will probably be repeated over and over from one record to another, they should be
moved to their own tables. Many customers may buy the same Product, with the
same product on many different invoices. You should move these fields to another
table by adding a Product ID code field in the Line Iltems Data table and creating a
new Products table with the same field name (Product ID) to link the Product
names and descriptions in the new Products table to the Line Iltems Data table.

Third Normal Form (3NF)

The final step in the 3NF model is a bit more difficult. It relies on each table having
all the fields in the table directly related to the primary key field.
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For example, using Table 1-5 as a guide, you see that the Invoice table has several
fields unrelated to the Invoice table directly —Discount, Tax Rate, Payment Method,
and Tax Location. These fields should also be moved to a more appropriate table or
to their own tables and linked back to the Invoice table.

- Cross- For the purposes of this book, several of the fields in the final example will remain
| Reference’) i this table and the other tables, not normalizing the actual system, even to 2NF.

L

In summary, when creating your tables, you should consider building them to 3NF.
This greatly enhances both the accuracy and performance of your system.

Step 5: Field design data-entry rules and validation

The next step is to actually create your tables and define your fields for those
tables. You also need to determine data-validation rules for each field and to define
some new tables to help with data validation.

Designing field names, types, and sizes

First, you must name each field. The name should be easy to remember, as well as
descriptive, so that you recognize the function of the field by its name. It should
be just long enough to describe the field but not so short that it becomes cryptic.
Access allows up to 64 characters (including spaces) for a field name.

You must also decide what type of data each of your fields will hold. In Access, you
can choose any of several data types:

4+ Text. Alphanumeric characters; up to 255 characters

4 Memo. Alphanumeric characters; long strings up to 65,538 (64K) characters

4 Number. Numeric values of many types and formats

4 Date/Time. Date and time data

4 Currency. Monetary data

4 AutoNumber. Automatically incremented numeric counter

4+ Yes/No. Logical values, Yes/No, True/False

4 OLE object. Pictures, graphs, sound, video, word processing, and
spreadsheet files

4 Hyperlink. A field that links to a picture, graph, sound, video, word
processing and spreadsheet files

One of these data types must be assigned to each of your fields. You must also
specify the length of the text fields.



28 Part

'] Reference

I, Section | + Working with Data Tables and Queries

detail.

jﬁ) The section on “Creating the tblContacts table” in Chapter 2 covers this in more

Tip

e

Designing data-entry rules

The last major design decision concerns data validation, which becomes important
when you enter data. You want to make sure that only good data (data that passes
certain defined tests) gets into your system. You have to deal with several types of
data validation. You can test for known individual items, stipulating that the Gender
field can accept only the values Male, Female, or Unknown, for example. Or you can
test for ranges, specifying that the value of Weight must be between 0 and 1,500
pounds. Finally, you can test for compound conditions, such as whether the Type
of Customer field indicates a seller, buyer, or both.

Designing lookup tables

Sometimes you need to design entire tables to perform data validation or just to
make it easier to create your system; these are called lookup tables. For example,
because Access Auto Auctions needs a field to determine the customer’s tax rate,
you decide to use a lookup table that contains the Tax location, and tax rate. Another
example is when a customer pays an invoice using some specific method — cash,
credit card, money order, and on and on. Because the tax rate can change, Access
looks up the current tax rate whenever an invoice is created. The tax-rate value is
stored in the Invoice/Sales table to capture the tax rate for each invoice because it
is time-dependent data. Another purpose of a lookup table is to limit data entry in
a field to a specific value. For example, you can use a table that contains Payment
Methods. This payment methods table can be used as a lookup table to make sure
only those methods in the table can be entered in the invoice table.

When you create a field in a table, you can use the data type “Lookup Wizard" It is
% not an actual data type, but is instead a way of storing a field one way and dis-
4 playing it another way.

Although you can create a field on a data-entry form that limits the entry of valid
Customer Types to seller, buyer, or both, you create a table with only one field —
Type of Customer — and use the Type of Customer field in the Contacts table to link
to this field in the Type of Customer lookup table.

You create a lookup table in exactly the same way as you create any other table,
=~ and it behaves in the same way. The only difference is in the way you use the table.
In Figure 1-5, the actual tables for the Access Auto Auctions, several lookup tables
have been added to the design.



Chapter 1 4+ Understanding Data

et

Figure 1-5: The tables of the Access Auto Auctions with several lookup tables

As Figure 1-5 shows, tblCustomerTypes, tbIPaymentType, tblTaxRates, and
tblCategories are all look up tables in the system.

Creating test data

After you define your data-entry rules and how the database should look, it’s time
to create test data. You should prepare this data scientifically (in order to test many
possible conditions), and it should serve various purposes. For example, it should
let you test the process of data entry: Do all the conditions that you created gener-
ate the proper acceptance or error messages? In addition, it may lead you to some
conditions that you should test for that you hadn’t considered. What happens, for
example, when someone enters a blank into a field? How about numbers in a charac-
ter field? Access automatically traps items such as bad dates or characters in Date
and Numeric fields, but you must take care of the rest yourself.

The first type of test data you want to create is simply data that allows you to popu-
late, or fill, the databases with meaningful data. This is the initial good data that
should end up in the database and then be used to test output. Output consists
mainly of your reports. The second type of test data you want to create is for test-
ing data entry. This includes designing data with errors that display every one of
your error conditions, along with good data that can test some of your acceptable
conditions.

29



30 Part |, Section | 4 Working with Data Tables and Queries

Test data should let you test routine items of the type you normally find in your
data. You should also test for limits. Enter data that is only one character long for
some fields, and use every field. Create several records that use every position in
the database (and thereby every position in the data-entry screen and in the
reports).

Create some “bad” test data. Enter data that tests every condition. Try to enter a
customer number that already exists. Try to change a customer number that’s not
in the file. These are a few examples of what to consider when testing your system.
Testing your system begins, of course, with the test data.

Step 6: Form design — Input

After you've created the data and established table relationships, it’s time to design
your forms. Forms are made up of the fields that can be entered or viewed in edit
mode. If at all possible, your screens should look much like the forms that you use
in a manual system. This setup makes for the user-friendliest system.

Designing data-entry screens
When you’re designing forms, you need to place three types of objects onscreen:

4+ Labels and text box data-entry fields

4 Special controls (multiple-line text boxes, option buttons, list boxes, check
boxes, business graphs, and pictures)

4 Graphical objects to visually enhance them (color, lines, rectangles, and three-
dimensional effects)

When designing a form, place your fields (text boxes, check boxes, list boxes, and
radio buttons) just where you want them on the form. Ideally, if the form is being
developed from an existing printed form, the Access data entry form should resem-
ble the printed form. The fields should be in the same relative place on the screen
as they are in the printed counterpart.

After you have placed your fields on the form, you can check the order of the fields.
In other words, when you fill in a field and tab to the next field, which field does the
cursor move to next? The tab order for data entry normally moves from top to bot-
tom and from left to right when you fill in the fields (text boxes and special controls).
However, you can tell Access to use a different order for moving from one field to
another. When placing the fields, be sure to leave as much space around them as is
needed. A calculated field, such as a total that is used only for data display, can also
be part of a data-entry form.



l1 Reference

Chapter 1 4 Understanding Data 31

You can use labels to display messages, titles, or captions. Text boxes provide an
area where you can type or display text or numbers that are contained in your
database. Check boxes indicate a condition and are either unchecked or checked
(selected). Other types of controls available with Access include list boxes, combo
boxes, option buttons, toggle buttons, and option groups.

Access also provides a tool called Microsoft Graph that can be used to create a

;Cm;X Chapters 8 through 10 cover the various types of controls available in Access.

wide variety of graphs. Pictures can also be displayed using an OLE (Object Linking
and Embedding) object stored in a database table, as you learn in Chapter 14.

In this book, you create several basic data-entry forms:

4+ Contact Log
4+ Contacts

4 Sales

4 Products

The Contact Log form

The Contact Log data-entry form shown in Figure 1-6 is the simplest of the data-
entry forms that you create in this book. It is straightforward, simply listing the
field descriptions on the left and the fields themselves on the right. The unique key
field (primary key) is Entry ID. At the top of the form is the main header, a title that
identifies this data-entry form by type: Contact Log.

| Reference

|

I(INJ;X You can create this simple form by using a Form Wizard. See Chapter 8 for details.

(P2 Contact Log 220)

EneryID: 2

CONtact Nime: _ v
Comaet Inde: Nioa Ate Parsy

11253 Main Streat

Soringfald, MA 01111-1283
(413) 555-3216

Date Contacted: |

l*' WI
Failen o Date

Record: 1| < J[T 5 b |Mpe]ef 2
Figure 1-6: The Contact Log data-entry form.
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The Contacts form

The Contacts data-entry form is a little more complex. It contains several types of
controls, including a tab control, command buttons, and a check box. Figure 1-7
shows the Contacts form.

= Contacts e 5

Contit Infarmaton | Commurncaton | Contomar Infirmation |

Contact ID I Contact Tyoe: Jluve »| Cumtemer TyoR Ii=.-.!~.‘.'.:rr -[ acmve: ¥

P [lore Penes Nt
Pt !

Compinrty ".g.-. ey

Addrem: [ 1250 M Sreet

Gty: forrsieis swte: [ra ZpCode: Prini e

| geete | g | g |
Becord: M|« |[ P LN 0

Figure 1-7: The Contacts data-entry form.

The Sales form

The next data-entry form combines data from several tables to provide general
information about sales. This form contains information about customers, the sale,
line items sold, any payments made on this sale; its primary purpose is to allow a
user to enter this type of information into the database.

The Products form
The final form in this book is for adding the products that are sold in the system.

Step 7: Automation design — Menus

After you've created your data, designed your reports, and created your forms, it’s
time to tie them all together using switchboards and menus. Figure 1-8 is a switch-
board form that also contains a custom menu bar. Switchboards are graphical menus,
which are usually built with command buttons with text or pictures on them. Menus
refer to the lists of commands at the top of a window.

Menus are the key to a good system. A user must be able to follow the system to
understand how to move from place to place. Usually each form or report is also a
choice on a menu, which means that your design must include decisions on how to
group the commands. When you examine the overall design and look at all of your
systems, you begin to see a distinct set of combinations.
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Figure 1-8: A switchboard and menu for Access Auto Auctions.

You can use Access macros to create a menu on the top menu bar of the switch-
board. This menu gives the user the choice of using pull-down menus or switch-
board buttons.

- Cross- You create this switchboard, along with the menus and a complicated dialog box,
Reference’\ i, Chapter 24.
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Creating and
Building Tables

In this chapter, you learn how to start the process of creat-
ing a database and its tables. You will create the database
container to hold your tables, forms, queries, reports, and
code that you create as you learn Access. Finally, you will
build the actual tables used by the example, Access Auto
Auctions, in this book.

Before you begin to create the tables, you must create a con-
tainer to store them in.

Chapter 2 does not use the example CD. In this chapter,

CD®VI you will create a blank database and begin to create your

first tables.

Creating Database Tables

You create a database container to hold the tables, queries,

forms, reports, and macros that you create as you learn Access.

You also create the Sales and Contacts database tables, which
stores data about the sales and customers of the Access Auto
Auctions.

Before you can create the tables of the Access Auto Auctions,
you must first create the actual database container to hold
the tables.

Creating a Database

The Database window displays all the various object files
from your database that you may create while using Access.
Actually, a database is a single file. As you create new object
files, they are stored within the database file. They are not
separate files in themselves; rather, they are stored objects.

CHAPTER

0+ o+
In This Chapter
Creating a database
Creating a table

Navigating in the
Table window

Entering field names
and descriptions

Selecting a field
data type

Entering field
properties

Changing a
table design

Creating a
primary key

Saving and printing
your table design

Renaming, copying,
and deleting tables

¢+ 4+ 0+
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The database file starts at about 94,000 bytes (92K) and grows as you create new
objects —tables, queries, forms, reports, macros, and modules. Adding data to an
Access database also increases the size of the file.

There are many ways to create a new database file. When you start Microsoft Access,
you see the Getting Started dialog box open in the Database window, as shown in
Figure 2-1. You can also display this dialog box by selecting File => New from the main
Access menu—this opens the New File dialog box— and then clicking the Home
icon at the top of the New File dialog box. (It looks like a sheet of paper with the
right-top corner bent down.) Finally, you can click the New button (the first button
in the toolbar) and select the Home icon.

Started + »| Figure 2-1: The Getting Started dialog box opens along
the right-hand side of the Access window, showing three
general categories for creating a new database.

) Create armw fie

The Getting Started dialog box shows several groupings:

4 Open. This lets you open an existing database file. The last four databases
opened are displayed. Clicking the More choice opens the Open dialog box,
which enables you to browse through your hard drive for the existing
database you want to open.

4 Create a new file. Clicking on this choice opens the New dialog box, which
has two sections — New and Templates. The New section enables you to open
a Blank Database, a Blank Data Access Page, a Project Using Existing Data, a
Project Using New Data, or From Existing File. The Template section lets you
search for new templates on Microsoft.com, go to the Templates Home page,
and look for templates On My Computer.
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Templates Section

In addition to using the New section to create a blank database, you can select the
second section in the New File dialog box— Templates. This section has three
choices: Search Office Online:, Templates Home page, and On My Computer.

Templates Home page

This choice activates your dialer program if you are not currently connected to the

Internet. When connected to the Internet, your browser will be activated and display
the Templates Home page of Microsoft Office Online. Here you can see a list of tem-

plates. The top figure in Figure 2-2 shows the Templates Home page after connecting
to Microsoft.com.

The Templates home page displays many templates for all the Microsoft Office
products. If you type Access in the search box located at the top-left corner and
click on the right arrow button or press Enter, the Web site will display a series of
online templates that can be used in Access.

Search Office Online:

Using the Search Office Online: choice of the Templates section, you can type a
search criteria for a specific template. For instance, typing in the keyword “inven-
tory,” Access will go out to the Template section of the Web site and search for any
templates for “inventory.” In this case it reports the “Inventory Management
Database” was found on the Microsoft.com site.

On My Computer

Clicking on this choice activates the Templates dialog box. When you open the
Templates dialog box for the first time, it may look different than the one in Figure 2-2.
Notice that the Templates dialog box has two tabs across the top —the General tab
and Database tab. The first time you open this dialog box, the General tab may be
active — clicking on the Database tab should show entries similar to Figure 2-2.

Notice that there are several database templates available in this window. Selecting
one of them will create a new database with objects that can be used for that specific
purpose. You can use any of these templates to build a specific database system.
Once built you can modify any of the objects created for your particular need.

When you select a particular template, Access will activate the Database Wizard and
ask you a series of questions about the fields to use for each table of the system and
the look of your forms and reports. Finally it will ask you for the name of the system
you are building and create the database and all its objects automatically.

37
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If you have the Templates dialog box open, close it at this time to continue with

creating a new database.
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Figure 2-2: The Templates Home page is activated by selecting
Templates home page (top figure). The Templates dialog box with
the Database tab active. This dialog box is activated by selecting the

On My Computer choice in the Templates section of the New
File menu (bottom figure).
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Blank database

Creating a database is a very simple matter. Just follow the steps below:

1. Click Blank Database under the New category of the New File menu. If you are

on the Getting Started menu, select Create a New File to go to the New File menu.

2. The File New Database dialog box opens. You can see any existing .MDB files

in the file list part of the window. The New File Database dialog box may ini-
tially open to the My Documents folder. Navigate to the folder you want to
place your new database file in—in the case of the author, it is a folder named
“Access db Files.”

3. A default name of dbl.mdb will appear in the File Name text box at the bottom

of the window. Simply type over this default name with the name My Access
Auto Auctions or any other name you want to give the database. (Typing the
extension .mdb is optional because Access automatically supplies it if you
do not.)

4. Click the Create button.

When the new database is created, Access automatically opens it for you.

_Alote

—

As the database in Figure 2-3 shows, Access automatically creates the database
file (container) using the Access 2000 format. This is for backward compatibility.
If you want to use the newer format—Access 2002 —you will need to convert
the database after it is created by selecting Tools=> Database Utilities => Convert
Database > To Access 2003.

=
]

a
%
a
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(5 My Access Auto Auctions - Database (Access 2000 file format) 1= 3 0
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Figure 2-3: The new database “My Access Auto
Auctions” is created.
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Tip You can specify that Access 2003 uses the default database format of Access 2002

s instead of version 2000. To change which format of the database Access uses
' when creating a new database, select Format=>Options->Advanced Tabr>Default
File Format pull-down menu and choose Access 2002 format.

- Cross- You learn more about file attaching in Chapter 7.
|1 Reference

Caution An Access 2002 database cannot be used by versions of Access from 2000 and
earlier. However, Access can use previous formats of Access databases—2.0, 95,
97, and 2000. Because the default version is 2000, you can use these files with
Access 2000, Access 2002, or the current version. Of course you can change the
default version to Access 2002 instead of 2000 (see tip above).

Understanding How Access Works with Data

There are many ways that Microsoft Access works with data. For simplicity, you will see the
data stored in local tables in the examples of this book. A local table is a table stored within
the Access .MDB file This is how you have seen examples so far.

[N

In many professionally developed Microsoft Access applications, the actual tables are in
their own database while the other interface objects (forms, reports, queries, pages,
macros, and modules) are stored in another database. The reason for this is usually main-
tainability. By separating the data and their tables into another database you can easily do
maintenance work on them (building new indexes, repairing the tables, and so on) without
affecting the remainder of the system. In contrast, you may be working with a multi-user
system and find a problem with a form or report object in the system. If you have all the
data and interface objects in the same database, you would have to shut down the system
while repairing the broken form or report — others could not be using the system while you
repair one object. Instead, by separating the data from the other objects, you can fix the
erring object while others are still working with the data. After you've fixed the problem,
you can deliver the new changes to the others, and they can import it into their local
database system. In addition, there is a more critical reason to separate your data from the
interface objects —security. By maintaining the data separately in its own database, either
locally or in a remote location, as in a multi-user environment, you can maintain better con-
trol over the information. Thus, the solution is to consider separating your tables, and their
stored data, from the rest of the application.

While you may want to first develop your application with the tables within the .MDB
database, later you can use the Database Splitter wizard to automatically move the tables in
your .MDB file to a separate Access .MDB file and then attach the tables. You can also attach
your tables to the Microsoft Database Engine or the larger SQL Server database. You can
also attach to non-Microsoft servers such as Oracle, Informix, or Sybase.
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Tip You can save or convert an Access 2002 Database in Access 2000 or Access 97 for-
.~ mat by selecting Tools=> Database Utilities => Convert Database=>To Access 97 or
4 Access 2000 File Format. The same is true for converting from Access 2000 to
2002 or 97.
Caution If you enter a file extension other than MDB, Access saves the database file but

On the

does not display it when you open the database later. By default, Access searches
for and displays only those files with an MDB file extension.

If you are following the examples in this book, note that we have chosen the name
My Access Auto Auctions for the name of the database you create as you complete
this chapter. This database is for our hypothetical business, Access Auto Auctions.
After you enter the filename, Access creates the empty database.

The CD-ROM that comes with your book contains multiple database files. The

CD-@VI \ completed file containing all the data is named Access Auto Auctions Data, and
~

the database with the completed objects is Access Auto Auctions (the completed
application, including forms, queries, reports, macros, and modules).

The CD-ROM has database files for each chapter named CHAPxxStart.mdb and
CHAPxxEnd.mdb, where xx is a chapter number; for example, 01, 02, and on and
on. If a chapter uses files where the data is split off from the other objects, the
names are CHAPxxPgmStart.mdb, CHAPxxDataStart.mdb, CHAPxxPgmEnd.mdb,
and CHAPxxDataEnd.mdb. For this chapter, you will build only a single database:
My Access Auto Auctions.

The Database Window

The Database window for the database CHAPO1Start.mdb is shown in Figure 2-4.

It comprises three basic parts. First is the Objects menu bar on the left side of the
window and below it a Groups menu bar. Along the top of the window is the second
part, the toolbar with the buttons Open, Design, and New. Finally, the third part is
the open pane to the right and center that is used to show all the objects of the
type selected (Tables, Queries, and so on).

The Database window can be thought of as a container that holds all the different
objects that make up the database itself. When you click any of the object menu
items (Tables, Forms, and so on), the open pane on the right of the menu bar dis-
plays the appropriate objects. For example, Figure 2-4 shows all the Tables objects
because the Tables button is selected (it is also the default selection). If you click
the Forms button, you will see all the forms that you have built in the open pane.

The menu bar comprises two different groups of menus: Objects types and Groups.
The Objects type menu references all the object types that are used to make up the
entire database. The Groups menu is used to store and retrieve different object
types by use of a shortcut — it can contain any type of object.
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Figure 2-4: The Database window. This window,
or container, has three basic parts: the menu bars
on the left side, the toolbar along the top, and the
open pane.

Objects menu bar

The Database window contains seven buttons on the vertical Objects menu bar;
using them, you can quickly select any of these objects that are available in Access:

4 Tables

4 Queries
4 Forms

4 Reports
4 Pages

4+ Macros

4 Modules

As you create new objects, the names of the files appear in the open pane of the

Database window. You see only the files for the particular type of object selected.
You can select an object type to view by clicking one of the object buttons.

In addition to the new objects that you create, the Database window shows several
new object shortcuts for each object type selected. For example, in Figure 2-4 you
see three new object shortcuts at the top of the object pane: Create Table In Design
View, Create Table By Using Wizard, and Create Table By Entering Data.

Only the Tables, Queries, Forms, Reports, and Pages objects have new objects
shortcuts. Queries, Forms, and Reports each have two, and the Tables and Pages
have three. To see the two for Forms, simply click the Forms button, and the first
two choices in the window pane are the new object shortcuts — Create Form In
Design View and Create Form By Using Wizard.
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Inside the Object window pane are two or three create icons and their new object
shortcut labels. These can help you get started and are provided for each type of

s object. You can turn off this new feature by choosing Tools=> Options and de-

selecting New Object Shortcuts.

There are four buttons on the right side of the toolbar that can change how you
look at the objects in the database object pane — one to see Large Icons of objects,
one for Small Icons, one for List Of Objects (default), and the last for Details Listing
Of Objects.

Figure 2-4 shows the default (List) Database window view. In it you only see the object
names; for example, table names such as tblContacts, tbiSales, tblSalesLineltems,
tbIProducts, and more. You can switch to the Details view of the object files in the
Database window by clicking the last button on the toolbar, a button that looks like
a series of lines in a box. This shows information such as a description, the date
modified, date created, and type of object. You can also view this detailed informa-
tion by clicking View from your Access menu bar and then clicking Details.

Groups menu bar

The Groups menu has one default button under it: Favorites. Groups are used to
store shortcuts to the different database objects so that they can be accessed
quickly from one place. For example, you may want to add a shortcut for the
Customer (tblContacts) table and the Customer (frmContacts) form or other differ-
ent types of objects.

When you place your database objects into a group, this creates a shortcut to that
object. For example, assume you are working with a fairly large database with sev-

"7 eral hundred objects but that you are currently working with only three of those

objects. Instead of switching between the seven database objects and browsing
for the individual object names, you can store shortcuts to all the objects you use
in a group you create.

The objects must already have been created to add them to a group. This figure
uses objects that you create later and are not yet in this database.

You are not limited to the Favorites group. You can create your own groups menu
choices under the Groups menu bar. To create a new group, right-click on the
Favorites group and select New Group. This displays a dialog box where you can
type in a group name. When you have typed in the group name, click OK and the
group is created.

To display different database objects in your groups, click and drag the object into
the desired group. The same toolbar buttons appear for the different objects as
they normally do. The only command you can’t perform when you are in a group is
to create a new object (Table, Query, Form, Report, Pages, Macro, or Module). The
toolbar buttons are described in the next section.



44 Part |, Section | 4+ Working with Data Tables and Queries

The Database window toolbar buttons

The toolbar buttons in the Database window enable you to “Open” an existing object
that is highlighted (selected); display “Design” mode for the current highlighted
object; create a “New” object; or “Delete” (the X button) the currently highlighted
object. When a button is clicked, the appropriate action is taken. Before clicking
Open or Design, you should select an object name by highlighting it. When you
select New, the type of the new object that will be created depends on the object
type button you have selected in the Objects menu bar (Form, Table, Query, or
others). If you chose the Tables type, a new table is created. When you select some
of the other object types, the toolbar buttons may change. When you select the
Reports type, for example, the three available toolbar buttons are Preview, Design,
and New.

The Access window toolbar

The toolbar shown in Figure 2-5 enables you to perform tasks quickly without using
the menus. (Tools that are not available appear in light gray.)

If you place the cursor on a button without clicking and wait a short time (a second
or two), a Help prompt known as a Too! Tip appears just below the button. If you
want even more help, press Shift+F1, and then move the cursor to the object you
want more information about and click it. You will see What’s This? help: A small
rectangle with a paragraph explaining the use of the selected object. Figure 2-5
shows the What’s This? information box for the Tables button in the database
container. Another way of getting Help is to select the Office Assistant button at
the far right of the toolbar (it has a question mark inside a bubble), and then type a
question in the Office Assistant box. Finally, you can type in your question directly
in the new Help combo box along the right-most side of the menu bar of Access.
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Figure 2-5: The Database window toolbar. Notice that
it also shows the Shift-F1 information box that is
displayed for the Tables Button in the database.
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Starting from the left, you see the following toolbar buttons:

4+ New (blank piece of paper): Opens the New File menu
4+ Open (open file folder): Opens a database
4+ Save (floppy disk): Saves an object

4 File Search (Windows logo over a piece of paper with a magnifying glass):
Searches the disk for a file

4 Print (fax/printer name) (printer): Prints an object to the printer

4 Print Preview (piece of paper with magnifying glass): Views an object as it
will look printed

4 Spelling (check mark below the letters ABC): Checks the spelling
4 Cut (pair of scissors): Removes the selection

4+ Copy (two pieces of paper): Copies the selection

4+ Paste (clipboard with piece of paper): Inserts from the clipboard

4+ Undo (an arrow rotating counterclockwise and menu selection arrow):
Undoes the last action

4 OfficeLinks (icon of a large W with envelope and menu selection arrow):
Displays the links to Word and Excel

4 Analyze (table picture with two table icons and a menu selection arrow):
Displays the Analyze commands

4 Code (rectangle with red, blue, and yellow boxes on it): Displays the Code
window — optional and visible only if loaded

4 Microsoft Script Editor (an eight inside another eight on its side): Displays
the Script Editor window — optional and visible only if loaded. The editor is
used to create VBScript or JScript for data access pages.

4 Properties (hand holding a piece of paper): Displays the Properties window

4+ Relationships (three tables with lines between them): Displays the
Relationships window

4 New Object: AutoForm (starburst over top-left corner of a table icon and a
menu selection arrow): Displays the New Object choices

4 Microsoft Access Help (cartoon caption bubble with a question mark
inside): Displays the Microsoft Access Help window

4 Toolbar Options (a menu selection arrow pointing down): Allows you to add
or remove toolbar buttons
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Creating a New Table

After you design your table on paper, you need to create the table design in Access.
Although you can create the table interactively without any forethought, carefully
planning a database system is a good idea. You can make any changes later, but doing
so wastes time; generally, the result is a system that is harder to maintain than one
that is well planned from the beginning. Before you get started, you should under-
stand the table design process.

(CrOSS- To refresh your knowledge on how to design your tables for this database, refer to
| Reference’) 46 section titled “Step 3: Data Design — What Fields Do You Have?” in Chapter 1.
!

The table design process
Creating a table design is a multi-step process. By following the steps in order, your
table design can be created readily and with minimal effort:
4+ Create a new table.
4 Enter each field name, data type, and description.
4+ Enter properties for each defined field.
4 Set a primary key.
4 Create indexes for necessary fields.
4 Save the design.
You can use any of these four methods to create a new table design:
4 Click the New toolbar button in the Tables Object container of the Database
window.
4 Select Insert = Table from the Access menu.
4 Select New Table from the New Object button in the Access toolbar.
4 Select Create table in Design view (first object in Tables pane of Database

window) if the New object shortcuts option is turned on.

Tip If you create a new table by clicking the New button in the Database window, make
sure that the Tables object button is selected first from the Objects menu bar.
s
With the “My Access Auto Auctions” database open, click the New button in the
Database window to begin creating a new table.
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The New Table dialog box

Figure 2-6 shows the New Table dialog box as Access displays it.
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Figure 2-6: The New Table dialog box.

You use this dialog box to select one of these five ways to create a new table:

4+ Datasheet View. Enter data into a spreadsheet
4 Design View. Create a table in Design view

4+ Table Wizard. Select a pre-built table that is complete with generic field
definitions

4+ Import Table. Import external data formats into a new Access table

4+ Link Table. Link to an existing external data source

Access provides several ways to create a new table. You can design the structure of
the table (such as field names, data types, and size) first, and then add data. Another
method is to use the Table Wizard to choose from a list of predefined table designs.
Access also gives you three new ways to easily create a new table. First, you can
enter the data into a spreadsheet-like form known as Datasheet View; Access will
create the table for you automatically. Second, you can use the Import Table Wizard
to select an external data source and create a new table containing a copy of the
data found in that source; the Wizard takes you through the import process. Third,
you can use the Link Table Wizard, which is similar to the Import Table Wizard
except that the data stays in the original location and Access links to it from the
new table.

To create your first table, the Datasheet View is a great method for getting started;
then you can use the table’s Design View to make any final changes and adjustments.

r Cross- The Import Table and Link Table Wizards are covered in Chapter 6.
'1 Reference
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Select New from the Database window; then select Datasheet View and click the OK
button to display a blank datasheet with which you can create a new table.

Using the Table Wizard

When you create a new table, you can type in every field name, data type, size, and other
table property information, or you can use the Table Wizard (see Figure 2-7) to select from
a long list of predefined tables and fields. Unlike the Database Wizard (which creates a
complete application), the Table Wizard creates only a table and a simple form.

Wizards can save you a lot of work; they are meant to save you time and make complex
tasks easier. Wizards work by taking you through a series of screens that ask what you want.
You answer these questions by clicking buttons, selecting fields, entering text, and making
yes/no decisions.

In the Table Wizard, first you choose between the lists of Business or Personal tables. Some
of the Business tables are Mailing List, Contacts, Employees, Products, Orders, Suppliers,
Payments, Invoices, Assets, and Students. The Personal list includes Guests, Recipes,
Exercise Log, Plants, Wine List, Photographs, Video Collection, and more.

When you select a table, a list appears and shows you all the fields that you might want in
the table. Select only the fields you want. Although they are all predefined for data type and
size, you can rename a field after it's selected. When you've chosen your fields, another
screen uses input from you to create a primary key automatically. Other screens help you to
automatically link the primary key to another table and establish relationships. Finally, the
Wizard can display the table, enable you to enter records into a datasheet, or even create an
automatic form for you. The entire process of creating a simple table and form can take less
than one minute! Whenever you need to create a table for an application on the Wizard's
list, you can save a lot of time by using the Wizard.
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Figure 2-7: This is the first screen of the Table
Wizard. It enables you to select an example type
table (Contacts in this figure) then select fields
to add to the table to be created.
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Creating a new table with a Datasheet View

The empty datasheet appears, ready for you to enter data and create a new record.
You begin by entering a few records into the datasheet. Each column will become a
field, and each row will become a record in the table. (You learn more about these
terms later in this chapter.) For now, all you have to do is add data. The more
records you add, the more accurately Access can tell what type of data you want
for each field and the approximate size of each data item.

When you first see the datasheet, it’s empty. The column headers that will become
field names for the table are labeled Fieldl, Field2, Field3, and so on. You can change
the column header names if you want; they become the field names for the table
design. You can always change the field names after you have finished creating the
table. The table datasheet is initially named 7Table followed by a number. If there are
no other tables named Table with a number, Access uses the name Tablel; the next
table is named Table2, and so forth. You can always change this name when you
save the table.

Add the five records shown in Figure 2-8, and then change the column headers to
the names shown by double-clicking on the field name (Fieldl, Field2, and so on).

/\lote You can change a column name by double-clicking the column name and editing
/

the value. When you're done, press Enter to save the new column header. If you
enter a column header name that is wider than the default column width, adjust
the column width by placing the cursor on the line between the column names
and dragging the line to the right to make it wider or to the left to make it narrower.
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Figure 2-8: A partially completed Datasheet view of the
data used to create a new table. Notice that the first six
fields have had their field names changed, and that each
column holds the same type of data.
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Tip

'] Reference

The Access and Microsoft Excel spreadsheet Datasheet windows work similarly.
s Many techniques are the same for both products; even many menus and toolbar

4 buttons are the same.

used. You can read more on this naming convention in Appendix D —Standard

fj When naming tables, fields, and other objects in this book, a naming convention is

Tip

Naming Conventions.

When you have finished entering the data, save the table and give it the name
tblContacts. To close the table and save the data entered, choose either Close from
the File menu or click the Close button in the upper-right corner of the Table window
(the button with the X on it). You can also click the Save button on the toolbar, but
this only saves the table; you still have to close it.

Clicking the Close button in the window will activate a dialog box that asks whether
you want to save changes to Tablel. You have three choices - “Yes” to save the table
and give it a name, “No” to forget everything, or “Cancel” to return to the table to
enter more data.

For this example, select “Yes” to continue the process to save the table. The Save
As dialog box appears, prompting you for a new name for the table. It shows you
the default table name of Tablel.

Enter tblContacts and click OK to continue to save the table. Yet another dialog box
appears, asking whether you want to create a primary key— a unique identifier for
each record, which you learn about later in the chapter. For now, just select No.

The tables, fields, and other objects (forms, reports, queries, and others) follow a

%, convention that can be found in Appendix D — Standard Naming Conventions. The

4  purpose of this “standard” method of naming is for clarification; for example, the
prefix tbl stands for table and Contacts is the primary name of the table. When you
look at system some time in the future, you will automatically know that tb/ stands
for table.

Access saves the table and returns you to the Database window. Notice that the
table name “tblContacts” now appears in the table object list. If you did everything
correctly, you have successfully created a table named tblContacts that has six
fields and five records. The next step is to edit the table design and create the final
table design you saw in Figure 1-5 of Chapter 1.

To open the tblContacts table in Design View, select it and then click the Design
button. Figure 2-9 shows the tblContacts Table Design window with the design that
was automatically created by the data you entered in the Datasheet View. Notice
the field names that you created by entering their names in the first row of each
column. Also notice the data types that Access automatically assigned to each field.
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It looked at the information that you typed into each column and attempted to
determine the type of data you entered. For example, it figured out that you wanted
a Date/Time type field for the dtmOrigCustDate (Original Customer Date) column,
and a Number type for the idsContactID field. In the next part of this chapter, you
learn about these field types.

Caution The field idsContactID was automatically identified as a number by Access. In reality,
we will use this as an AutoNumber field. This will be discussed later in this chapter.
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Figure 2-9: The Table Design window contains the Field Names
and Data types in the top pane and Field Properties for the
current field in the bottom pane —in this case, the properties
for the idsContactlD field.

The Table Design Window

The Table Design window consists of two areas:

4 The field entry area

4+ The field properties area

The field entry area is for entering each field’s name and data type; you can also
enter an optional description. The property area is for entering more options, called
properties, for each field. These properties include field size, format, input mask,
alternate caption for forms, default value, validation rules, validation text, required,
zero length for null checking, index specifications, and unicode compression. The
actual properties displayed depend upon the data type of the field. You learn more
about these properties later in the book.
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Tip

'] Reference

You can switch between areas (also referred to as panes) by clicking the mouse
when the pointer is in the desired pane or by pressing F6.

s

Using the Table Design window toolbar

The Table Design window toolbar, shown in Figure 2-10, contains many buttons that
assist in creating a new table definition.

T2 RED BTy |
Figure 2-10: The Table Design window toolbar.

Working with fields

Fields are created by entering a field name and a field data type in each row of the
field entry area of the Table Design window. The field description is an option to
identify the field’s purpose; it appears in the status bar during data entry. After you
enter each field’s name and data type, you can further specify how each field is
used by entering properties in the property area. Before you enter any properties,
however, you should enter all your field names and data types for this example. You
have already created some of the fields you will need.

Naming a field

A field name should be clear enough to identify the field to you, the user of the
system, and to Access. Field names should be long enough to quickly identify the
purpose of the field, but not overly long. (Later, as you enter validation rules or use
the field name in a calculation, you’ll want to save yourself from typing long field
names.)

ES-/X This book uses a naming standard for all objects. To learn more about the naming

conventions used in this book, please refer to Appendix D— Standard Naming
Conventions.

To enter a field name, position the pointer in the first row of the Table Design
window under the Field Name column. Then type a valid field name, observing
these rules:

4 Field names can be from 1 to 64 characters.

4 Field names can include letters, numbers, and many special characters.

4 Field names cannot include a period (.), exclamation point (), brackets ([ ]),
or accent grave ().
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4 You can’t use low-order ASCII characters, for example Ctrl-J or Ctrl-L. (ASCII

values 0 to 31).

4 You can’t start with a blank space.

4 You can’t use a double quotation mark (“) in the name of a Microsoft Access

project file.

You can enter field names in upper-, lower-, or mixed case. If you make a mistake
while typing the field name, position the cursor where you want to make a correc-
tion and type the change. You can change a field name at any time — even if it’s in

a table and the field contains data— for any reason.

After your table is saved, however, if you change a field name that is also used in

queries, forms, or reports, you have to change it in those objects as well.

Specifying a data type
After you name a field, you must decide what type of data the field will hold. Before
you begin entering data, you should have a good grasp of the data types that your
system will use. Ten basic types of data are shown in Table 2-1; some data types
(such as numbers) have several options.

Table 2-1

Data Types Available in Microsoft Access

Data Type Type of Data Stored Storage Size

Text Alphanumeric characters 0-255 characters

Memo Alphanumeric characters 0-65,536 characters

Number Numeric values 1, 2, 4, or 8 bytes, 16 bytes
for Replication ID (GUID)

Date/Time Date and time data 8 bytes

Currency Monetary data 8 bytes

AutoNumber Automatic number increments 4 bytes, 16 bytes for
Replication ID (GUID)

Yes/No Logical values: Yes/No, True/False 1 bit (0 or -1)

OLE Object Pictures, graphs, sound, video Up to 1GB (disk space
limitation)

Hyperlink Link to an Internet resource 0-64,000 characters

Lookup Wizard Displays data from another table Generally 4 bytes
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Figure 2-11 shows the Data Type drop-down list. It is used to select the choice for
the type of data you want to save in the field you just created. When you move the
pointer into the Data Type column, a down arrow (1) appears in the text-entry box.
To open this drop-down list, move the cursor into the Data Type column and click
the down arrow ({).
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Figure 2-11: The Data Type drop-down list. You can quickly select
the type of data you want to store in a field by clicking the list and
selecting from it. You can also type in the name of the data type.

Text data is any type of data that is simply characters. These characters comprise
alphanumeric characters, meaning numbers (0 through 9) and characters (A to Z,

a to z). Names, addresses, and descriptions are all text data, as are numeric data that
are not used in a calculation (such as telephone numbers, Social Security numbers,
and ZIP codes). Although you specify the size of each text field in the property area,
you can enter no more than 255 characters of data in any text field. Access uses
variable length fields to store its data. If you designate a field to be 25 characters
wide and you use only 5 characters for each record, then that is all the space you
will actually use in your database container. You will find that the .MDB database
file can get large quickly but text fields are not the cause. However, rather than allow
Access to create every text field with the default 50 characters or the maximum 255
characters, it is good practice to limit text field widths to the maximum you believe
they will be used for. Names are tricky because some cultures have long names.
However, it is a safe bet that a postal code might be less than 12 characters wide
while a U.S. state abbreviation is always 2 characters wide. By limiting the size of
the text width, you also limit the number of characters the user can type when the
field is used in a form.

The Memo data type holds a variable amount of data from 0 to 65,536 characters for
each record. Therefore, if one record uses 100 characters, another requires only 10,
and yet another needs 3,000, you use only as much space as each record requires.
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The Number data type enables you to enter numeric data; that is, numbers that will
be used in mathematical calculations. (If you have data that will be used in monetary
calculations, you should use the Currency data type, which enables you to specify
many different currency types.)

The Date/Time data type can store dates, times, or both types of data at once. Thus,
you can enter a date, a time, or a date/time combination. You can specify many
types of formats in the property entry area and then display date and time data as
you prefer.

The Currency data type enables you to enter numeric data; that is, numbers that will
be used with only two decimal places and can be used for mathematical calcula-
tions. You can specify many different currency formats with this data type. (If you
have data that will be used for non-Currency, numeric calculations, you should use
the Number data type.)

The AutoNumber data type stores an integer that Access increments (adds to)
automatically as you add new records. You can use the AutoNumber data type as a
unique record identification for tables having no other unique value. If, for example,
you have no unique identifier for a list of names, you can use an AutoNumber field
to identify one John Smith from another.

The Yes/No data type holds data that has one of two values and that can, therefore,
be expressed as a binary state. Data is actually stored as -1 for yes and 0 for no. You
can, however, adjust the format setting to display Yes/No, True/False, or On/Off.
When you use a Yes/No data type, you can use many of the form controls that are
especially designed for it.

The OLE Object data type provides access for data that can be linked to an OLE
server. This type of data includes bitmaps (such as Windows Paint files), audio files
(such as WAV files), business graphics (such as those found in Access and Excel),
and even full-motion video files. Of course, you can play the video files only if you
have the hardware and necessary OLE server software.

The Hyperlink data type field holds combinations of text and numbers stored as
text and used as a hyperlink address. It can have up to three parts: (1) the visual
text that appears in a field (usually underlined); (2) the Internet address — the path
to a file (UNC, or Universal Naming Convention, path) or page (URL or Uniform
Resource Locator); and (3) any sub-address within the file or page. An example of

a sub-address is the name of an Access 2000 form or report. Each part is separated
by the pound symbol (#).

The Lookup Wizard data type creates a field that enables you to use a combo box to
choose a value from another table or from a list of values. This is especially useful
when you are storing key fields from another table in order to link to data from that
table. Choosing this option in the Data Type list starts the Lookup Wizard, with
which you define the data type and perform the link to another table. You learn
more about this field type later.
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Entering a field description

The field description is completely optional; you use it only to help you remember a
field’s uses or to let another user know its purpose. Often you don’t use the descrip-
tion column at all, or you use it only for fields whose purpose is not readily recog-
nizable. If you enter a field description, it appears in the status bar whenever you
use that field in Access—in the datasheet or in a form. The field description can
help clarify a field whose purpose is ambiguous or give the user a fuller explanation
of the values valid for the field during data entry.

Creating the tblContacts Table

Working with these nine different data types (plus the Lookup Wizard), you should
be ready to create the final working copy of the tblContacts Table. When creating
the table, you will have to create a field that can be used to link this table to two
other tables, specifically the tblSales and tblContactLog tables. This link field will
be defined as an AutoNumber field, which will prove problematic for the currently
created tblContacts table.

AutoNumber fields and Access

Access gives special considerations to AutoNumber fields and assigning values to
AutoNumber fields. You cannot change a previously defined field from another type
to AutoNumber. If you try to change a previously defined field to an AutoNumber
field type, Access reports an error, as shown in Figure 2-12. The dialog box points
out that after you create a table and have added any records, you can’t change the
field type to AutoNumber from any other type.
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Figure 2-12: The warning dialog box states that you may not change
the field type of a table that already has records in it to AutoNumber.

When you created the table tblContacts by adding data in the datasheet view, Access
automatically assigned a datatype of Number to the idsContactID field. This needs
to be changed to AutoNumber. Because Access does not allow you to automatically
change it when there are records in it, you will have to either delete the records in
the table or delete the field.
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To change the idsContactID field from number to AutoNumber, you need to return
to the Datasheet View by clicking View, the left-most button under the word File.
While in Datasheet View, click on the first column of the record. Notice that when
you move your cursor over any row of this column, it changes to a small, right-
pointing arrow. While you have a pointing arrow, click on the first field to highlight
the entire record; once highlighted you can simply press the Delete key to delete
the record. Figure 2-13 shows the record highlighted and the cursor turned to a
right-pointing arrow. Access will display a confirmation dialog box confirming you
want to delete this record. Answer yes. When this is done, you can go back and
highlight the remaining records and delete them.
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Figure 2-13: Deleting a record in datasheet view.

With the records deleted you can now click the Design button (same button as the
view, simply changed to design now) and return to the Design window.

Completing the tblContacts Table

With the tblContacts Table in Design View you are now ready to create or modify
all the fields of the tblContacts Table. Table 2-2 shows the completed field entries
for the tblContacts table. If you are following the examples, you should modify the
table design now for these additional fields. Enter the field names and data types
exactly as shown. You also need to rearrange some of the fields and delete the
Value field you created. You may want to study the next few pages to understand
how to change existing fields (which includes rearranging the field order, changing
a field name, and deleting a field).

The steps for modifying the idsContactID field’s data type from Number to
AutoNumber is

1. Place the cursor in the Data Type column in the row of the idsContactID field.

2. Click the down arrow and select the data type of AutoNumber.

You can also type in the name of the data type or the first unique letters. The type
is validated automatically to make sure it's on the drop-down list. A warning mes-

\ sage appears for an invalid type.
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Table 2-2
Structure of the tblContacts Table
Field Name Data Type Description
idsContactID AutoNumber Used to link to tblSales and tlbContact Log
chrContactType Text Buyer, Seller, or Both
chrFirstName Text First name
chrLastName Text Last name
chrCompany Text Company name
chrAddress Text Address
chrCity Text City
chrState Text State
chrZipCode Text Zip code
chrCustomerType Text Holds info like Parts Store, Dealer, Auctioneer,
and so on
chrPhone Text Phone number
chrFax Text Fax number
chrEmail Text E-mail address
hlkWebsSite Text Web site
dtmOrigCustDate Date/Time First date became customer
chrTaxLocation Text State for taxing information
curCreditLimit Currency Credit limit
curCurBal Currency Current balance
chrCreditStatus Text OK, HOLD, New
dtmLastSalesDate Date/Time Date of last sale
dblIDiscountPercent Number Start discount percent authorized for contact
memNotes Memo Any miscellaneous notes
blnActive Yes/No Active contact

The steps for adding fields to a table structure are

1. Place the cursor in the Field Name column in the row where you want the field
to appear.

2. Enter the field name and press Enter or Tab.
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3. In the Data Type column, click the down arrow and select the data type.
4. Place the pointer in the Description column and type a description (optional).
Repeat each of these steps to create each of the data entry fields for the

tblContacts table. You can press the down-arrow (1) key to move between rows, or
simply use the mouse and click on any row.

Changing a Table Design

New
Feature

As you create your table, you should be following a well-planned design. Yet changes
are sometimes necessary, even with a plan —as in the case of changing the data
type from Number to AutoNumber for the idsContactID field previously. You may
find that you want to add another field, remove a field, change a field name or data
type, or simply rearrange the order of the field names. You can make these changes
to your table at any time. After you enter data into your table, however, things get a
little more complicated. You have to make sure that any changes made don’t affect
the data entered previously.

In older versions of Access (versions 95 and earlier), changes to the table design
could be made only in the Table Design window. Since Access 97, including Access
2002, you can make changes to the table design in a datasheet, including adding
fields, deleting fields, and changing field names.

\ _ In previous versions of Access, changing a field name usually meant that any
queries, forms, reports, macros, or modules that referenced that field name would
no longer work and had to be manually found and changed. Since Access 2002, it
automatically seeks out most occurrences of the name and changes it for you.

Inserting a new field

To insert a new field, in the Table Design window, place your cursor on an existing
field and select Insert => Rows or click the Insert Rows button in the toolbar. A new
row is added to the table, and any existing fields are pushed down. You can then
enter a new field definition. Inserting a field does not disturb other fields or existing
data. If you have queries, forms, or reports that use the table, you may need to add
the field to those objects as well.

Deleting a field

There are three ways to delete a field:

4+ Select the field by clicking the row selector and pressing Delete.
4 Select the field and choose Edit = Delete Rows.
4 Select the field and click the Delete Rows button on the toolbar.
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Tip

Tip

When you delete a field containing data, a warning that you will lose any data in the
table for this field displays. If the table is empty, you won’t care. If your table contains
data, however, make sure that you want to eliminate the data for that field (column).
You will also have to delete the same field from queries, forms, and reports that use
the field name.

When you delete a field, you can immediately select the Undo button and return
s the field to the table. But you must do this step before you save the changed

4 table's definition.

If you attempt to delete a field that is part of a relationship (primary or secondary
key field), Access will inform you that you cannot delete it until you delete the ref-

4 erence in the Relationships window.

If you delete a field, you must also delete all references to that field throughout
Access. Because you can use a field name in forms, queries, reports, and even table-
data validation, you must examine your system carefully to find any instances where
you may have used the specific field name.

Changing a field location

One of the easiest changes to make is to move a field’s location. The order of your
fields, as entered, determines the initial display sequence in the datasheet that dis-
plays your data. If you decide that your fields should be rearranged, click on a field
selector twice and drag the field to a new location.

Changing a field name

You can change a field name by selecting an existing field name in the Table Design
screen and entering a new name; Access updates the table design automatically. As
long as you are creating a new table, this process is easy.

Caution If you used the field name in any forms, queries, or reports, however, you must

also go to each object that references the field name and change it in them.
(Remember that you can also use a field name in validation rules and calculated
fields in queries, as well as in macros and module expressions — all of which must
be changed.) As you can seeg, it's a good idea not to change a field name; it creates
more work.

Changing a field size

Making a field size larger is simple in a table design. However, only text and number
fields can be increased in size. You simply increase the Field Size property for text
fields or specify a different field size for number fields. You must pay attention to
the decimal-point property in number fields to make sure that you don’t select a
new size that supports fewer decimal places than you currently have.
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When you want to make a field size smaller, make sure that none of the data in the
table is larger than the new field width. (If it is, the existing data will be truncated.)
Text data types should be made as small as possible to take up less storage space.

Remember that each text field uses only the number of characters actually entered
in the field. You should still try to make your fields only as large as the largest value

"4 5o that Access can stop someone from entering a value that may not fit on a form

or report.

Changing a field data type

You must be very careful when changing a field’s data type if you want to preserve
your existing data. Such a change is rare; most data types limit (by definition) what
kind of data you can input. Normally, for example, you cannot input a letter into a
Number field or a Date/Time field.

Some data types do, however, convert readily to others. For example, a Number
field can be converted to a Text data type, but you lose the understanding of mathe-
matics in the value because you can no longer perform mathematical calculations
with the values. Sometimes you might accidentally create a phone number or ZIP
code as a Number and want to redefine the data type correctly as Text. Of course,
you also have to remember the other places where you've used the field name (for
example, queries, forms, or reports).

Caution The OLE data type cannot be converted to any other format. Any field cannot be

converted to an AutoNumber field if there is any data in the table already.

You need to understand four basic conversion types as you change from one data
type to another. The paragraphs that follow describe each of these types.

To Text from other data types

Converting to Text is easiest; you can convert practically any other data type to
Text with no problems. Number or Currency data can be converted with no special
formatting (dollar signs or commas) if you use the General Number format; the dec-
imal point remains intact. Yes/No data converts as is; Date/Time data also converts
as is if you use the General Date format (mm/dd/yy hh:mm:ss AM/PM). Hyperlink
data easily converts to Text. The displayed text loses its underline but the remain-
ing Internet resource link information is visible.

From Text to Number, Currency, Date/Time, Yes/No, or Hyperlink

Only data stored as numeric characters (0, 1, 2, 3, 4, 5, 6, 7, 8, 9) or as periods, com-
mas, and dollar signs can be converted to Number or Currency data from the Text
data type. You must also make sure that the maximum length of the text string is
not larger than the field size for the type of number or currency field you use in the
conversion.
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Tip

Text data being converted to Date data types must be in a correct date or time for-
mat. You can use any legal date or time format (such as 10/12/2001, 12-Oct-00, or
October 1999), or any of the other date/time formats.

You can convert text fields to either a Yes or No value, depending on the specifica-
tion in the field. Access recognizes Yes, True, or On as Yes values, and No, False, or
Off as No values.

Access can also convert Number data types to Yes/No values. Access interprets
Null values as Null, 0 as No, and any nonzero value as Yes.

s

A text field that contains correctly formatted hyperlink text converts directly to
hyperlink format — displaying text and address.

From Currency to Number

You can convert data from Currency to Number data types as long as the receiving
field can handle the size and number of decimal places. Remember that the Field
Size property in numeric fields determines the size (in bytes) of the storage space
and the maximum number of decimal places. Anything can be converted to Double,
which holds 8 bytes and 15 decimals, whereas Single holds only 4 bytes and 7 deci-
mal places. (For more information, refer to “Entering field-size properties” later in
this chapter and to Table 2-2.)

From Text to Memo

You can always convert from Text to Memo data types because the maximum length
of a text field is 255 characters, whereas a memo field can hold up to 65,536 charac-
ters. You can convert from Memo to Text, however, only if every value in the memo
fields is less than the text field size —that is, no more than 255 characters. Values
longer than the field size are truncated.

Understanding Field Properties

Tip

After you enter the field names, data types, and field descriptions, you may want
to go back and further define each field. Every field has properties, and these are
different for each data type. In the tblContacts table, you must enter properties

for several data types. Figure 2-14 shows the property area for the field named
curCreditLimit; 10 options are available in the General section of the property area.
Notice that there are two tabs on the property box— General and Lookup. Lookup
is discussed later in this chapter.

Figure 2-14 shows 10 property options available for the Currency field named
curCreditLimit. Other types, such as Number and Date/Time (11), Text (14), or

s Yes/No (7) will show more or fewer options.
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Figure 2-14: Property area for the Currency field named curCreditLimit.

Pressing F6 switches between the field entry pane and the property pane. You
can also move between panes by clicking the desired pane. Some properties
display a list of possible values, along with a downward-pointing arrow, when
you move the pointer into the field. When you click the arrow, the values appear
in a drop-down list.

Here is a list of all the general properties (note that they may not all be displayed,
depending on which data type you chose):

4 Field Size. Text: limits size of the field to the specified number of characters
(1-255); default is 50.
4 New Values. Allows specification of increment or random type.

4+ Format. Changes the way data appears after you enter it (uppercase, dates,
and so on).

4 Input Mask. Used for data entry into a predefined and validated format
(Phone numbers, ZIP codes, Social Security numbers, Dates, Custom IDs).

4 Decimal Places. Specifies number of decimal places (Numeric/Currency only).
4 Caption. Optional label for form and report fields (replacing the field name).

4 Default Value. The value filled in automatically for new data entry into the
field.

4 Validation Rule. Validates data based on rules created through expressions
Or macros.

4+ Validation Text. Displays a message when data fails validation.
4+ Required. Specifies whether you must enter a value into a field.

4 Allow Zero Length. Determines whether you may enter the value “” into a
text field type to distinguish it from a null value.

4 Indexed. Speeds up data access and (if desired) limits data to unique values.

4 Unicode Compression. Used for multi-language applications. Requires about
twice the data storage but enables Office documents including Access reports
to be displayed correctly no matter what language or symbols are used.
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4+ IME Mode. Also known as the Kanji Conversion Mode property, this mode is
used to show whether the Kanji mode is maintained when the control is lost.

4+ IME Sentence Mode. Used to determine the Sequence mode of fields of a table
or controls of a form that switch when the focus moves in or out of the field.

4+ Smart Tags. Used to assign a specific action to obtain data in this field. For
example, the Financial Symbol Smart tag will obtain recent stock quotes on
MSN Money Central.

IME Mode and IME Sequence Mode are available only if international support for
Simplified Chinese, Traditional Chinese, or Japanese is enabled through Microsoft
Office Language Settings. IME stands for Input Method Editor.

—

Entering field-size properties

Field size has two purposes. For text fields, it simply specifies the storage and dis-
play size. For example, the field size for the chrEmail field is 100 bytes. You should
enter the size for each field with a Text data type. If you don’t change the default
field size, Access uses a 50-byte size for each text field in every record. You should
limit the size to the value equal to the largest number of characters.

For numeric data types (Number, Currency and AutoNumber), the field size enables
you to further define the type of number, which in turn determines the storage size.
There are seven possible settings in the Numeric Field Size property, as described
in Table 2-3.

You should make the field size the smallest one possible; Access runs faster with
smaller field sizes. Note that the first three settings don’t use decimal points but
allow increasingly larger positive or negative numbers. Single and Double permit
even larger numbers: Single gives you 7 decimal places, and Double allows 15. Use
the Double setting when you need many decimal places or very large numbers.

Table 2-3

Numeric Field Settings
Field Size Setting  Range Decimal Places  Storage Size
Byte 0 to 255 None 1 byte
Integer -32,768 to 32,767 None 2 bytes
Long Integer -2,147,483,648 to 2,147,483,647 None 4 bytes
Double -1.797 x 1038 to 1.797 x 103% 15 8 bytes
Single -3.4 x 10*® to 3.4 x 10%8 7 4 bytes
Replication ID N/A N/A 16 bytes

Decimal 1 — 28 precision 15 8 bytes
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Use the Currency data type to define data that stores monetary amounts.

The Replication ID (field size property) data type should be used for AutoNumber
fields that are used in databases that will be replicated, and more than 100

4 records are routinely added. This is also true for any numeric field where the field

is the primary key. When two copies of a table are synchronized, it is possible to
get duplicate fields in the numeric values unless the field type is set to Replication
ID. This will produce a 128-bit value that will require more disk space.

Using formats

Formats enable you to display your data in a form that differs from the actual key-
strokes used to enter the data originally. Formats vary, depending on the data type
you use. Some data types have predefined formats; others have only user-defined
formats, and some data types have both. Formats affect only the way your data
appears, not how it is actually stored in the table or how it should be entered.

Text and Memo data-type formats
Access uses four user-defined format symbols in Text and Memo data types:

@ Required text character (character or space)
& Text character not required

< Forces all characters to lowercase

> Forces all characters to uppercase

The symbols @ and & work with individual characters that you input, but the < and
> characters affect the whole entry. If you want to make sure that a name is always
displayed as uppercase, for example, you enter > in the Format property. If you
want to enter a phone number and allow entry of only the numbers, yet display the
data with parentheses and a dash, you enter the following into the Format property:
(@@@)@@@-@@@Q@. You can then enter 2035551234 and have the data displayed as
(203) 555-1234.

You can also specify your own Custom Format for Text and Memo fields. To specify
a custom format, you create a format specific for the field that you want to show.
The example above for telephone numbers is a type of Custom Format; however,
you have a bit more flexibility than suggested by the telephone example.

When creating a custom format, you can specify two sections for the format, sepa-
rated by a semicolon (;). The first section is the format for the fields with text; the
second is the format for fields with a zero-length value and a null value. To specify a
custom format, you can use the @ (required), & (optional), < (convert to lowercase
for display), or >(convert to all uppercase for display) symbols for the first part of
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the format and any text you wish to specify for the second part (surrounded by
quotation marks). For example, the format: “@@@-@@;“Unknown”[Red] displays
the data with a dash without you having to type a dash, and it will display the word
Unknown (colored Red) if the field is left blank.

Number and Currency data type formats

You can choose from six predefined formats for Numeric or Currency formats and
many symbols for creating your own custom formats. The predefined formats are as
shown in Table 2-4, along with a column that shows how to define custom formats.

Table 2-4

Numeric Format Examples
Format Type Number As Entered Number As Displayed Format Defined
General 987654.321 987654.3 H#H#HHHHH
Currency 987654.321 $987,654.32 $##4#, #40.00
Euro 987654.321 987,654.32 ###,##0.00
Fixed 987654.321 987654.32 H#H#HHHIE HH
Standard 987654.321 987,654.32 HH#HF HHHHH
Percent .987 98.7% ###.##%
Scientific 987654.321 9.88E+05 ###E+00
Euro 987654.321 987,654.32 H#HH HHHHHF

All the formats above are the default formats based on setting the Decimal places
property to AUTO.

Table 2-4 also shows the default format that would be built internally when selecting
any of the built-in format definitions. However, you can also specify your own cus-
tom format in this field by typing your example data. Numeric custom formats have
four parts that can be specified: (1) for positive numbers, (2) for negative numbers,
(3) for zero values, and (4) for null values. You can even specify a specific color to
display for each section. For example, you could create a custom format for Currency
that may look like this: $#,##0.00[Green]; ($#,##0.00)[Red]; “zero”;“Null” this for-
mat uses all four sections. It will display all values that are positive in green, values
that are negative in red; any field that contains a 0 with the word zero, and any field
that has not had a value entered with the word Null.
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The symbols you can use in a numeric field custom format are period (. ), comma
(,), 0 (digit place holder that shows a digit or 0), # (digit place holder that shows
the digit or nothing), $ (show the literal $), % (show % sign), E- or e- (minus sign
next to scientific notation), and E+ or e+ (displays a minus sign next to negative
numbers and a plus sign next to positive numbers). A final Currency example could
be ###0.00; (#,##0.00);;“Null”. This will show the numbers displaying negatives in
parentheses, a minimum of 0.00, and the word Null in fields with a null value. Note
that the 0 section was not used because the minimum valued displayed was
already 0.00.

Date/Time data-type formats

The Date/Time data formats are the most extensive of all, providing these seven
predefined options:

4 General Date. (Default) Display depends on the value entered; entering only
a date will display only a date; entering only time will result in no date dis-
played; standard format for date and time is 2/10/03 10:32 PM

4+ Long Date. Taken from Windows Regional Settings Section Long Date setting;
example: Wednesday, February 10, 2003

4 Medium Date. Example: 10-Feb-03
4 Short Date. Taken from Windows Regional Settings Section Short Date setting;
example: 2/10/03

Tip For the best Year 2000 compliancy, define all of your dates as Short Dates. When
_»,  the Windows Regional Settings are changed to display four digit years, so will all of
4 your date fields.

Alote Office 2003 automatically treats all two-digit dates before 30 as 2000-2029. Other
-~ dates are treated as 1930-1999.

4 Long Time. Taken from Windows Regional Settings Section Time setting;
example: 10:32:15 PM

4 Medium Time. Example: 10:32 PM

4 Short Time. Example: 22:32

You can also use a multitude of user-defined date and time settings, including these:

: (colon) Time separator; taken from Windows Regional Settings
Section Separator setting
/ Date separator

C Same as General Date format
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d, dd Day of the month — one or two numerical digits (1-31)
ddd First three letters of the weekday (Sun-Sat)
dddd Full name of the weekday (Sunday-Saturday)
ddddd Same as Short Date format

dddddd Same as Long Date format

w Day of the week (1-7)

wWwW Week of the year (1-53)

m, mm Month of the year — one or two digits (1-12)
mmm First three letters of the month (Jan-Dec)
mmmm Full name of the month (January-December)
q Date displayed as quarter of the year (1-4)

y Number of the day of the year (1-366)

vy Last two digits of the year (01-99)

yyyy Full year (0100-9999)

h, hh Hour — one or two digits (0-23)

n, nn Minute — one or two digits (0-59)

S, SS Seconds — one or two digits (0-59)

ttttt Same as Long Time format

AM/PM or A/P  Twelve-hour clock with AM/PM in uppercase as appropriate
am/pm or a/p Twelve-hour clock with am/pm in lowercase as appropriate

AMPM Twelve-hour clock with forenoon/afternoon designator, as
defined in the Windows Regional Settings Section forenoon/
afternoon setting

You can also specify custom formats for Data/Time types; however, they will be
displayed based on the settings specified in the Regional Settings Properties dialog
box in the Windows Control Panel. You can add a comma or other separator to your
custom format, but you must enclose the separator in quotation marks. For exam-
ple, the following format using the comma will display February 04, 2003 for the
date 02/04/03: mmm dd“, ” yyyy.

Yes/No data-type formats

Access stores Yes/No data in a manner different from what you might expect. The
Yes data is stored as a —1, whereas No data is stored as a 0. You'd expect it to be
stored as a 0 for No and 1 for Yes, but this isn’t the case. Without a format setting,
you must enter —1 or 0, and it will be stored and displayed that way. With formats,
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you can store Yes/No data types in a more recognizable manner. The three prede-
fined format settings for Yes/No data types are

4+ Yes/No. (Default) Displays -1 as Yes, 0 as No
4 True/False. Stores -1 as True, 0 as False
4+ On/Off. Stores -1 as On, 0 as Off

You can also enter user-defined custom formats. User-defined Yes/No formats can
contain up to three sections. The first section has no effect on the Yes/No data type
but must always be a semicolon (;). The second section is used to display a value
for the On or True values (literally stored as a —1). The third section is used to spec-
ify a value for the Off or False values (literally stored as a 0). If, for example, you
want to use the values Yep for Yes and Nope for No, you enter ;“Yep”; “Nope”. You
can also specify a color to display different values. To display the Yep value in

green and the Nope value in red, you enter ;“Yep” [Green]; “Nope” [Red].

Caution There are two problems when changing the table level format property of a logi-

cal, Yes/No, field. First, if you enter a custom format like in the above example, you
need to also change the default Lookup Display Control property from check box
to Text box to see the new format. Second, after the format is assigned and the
text box is the display method, the user will only be able to enter a 0 for —1. The
format property affects only how the value is displayed, not how it is entered into
the table.

Hyperlink data-type format

Access also displays and stores Hyperlink data in a manner different from what you
would expect. The format of this type is composed of up to three parts:

4+ Display Text. The visual text that is displayed in the field or control
4 Address. The path to a file (UNC) or page (URL) on the Internet

4 Sub-Address. A specific location within a file or page

The parts are separated by pound signs. The Display Text is visible in the field or
control, while the address and subaddress are hidden. For example, Microsoft Net
Home Pagei#http://www.msn.com.

Entering formats

The tblContacts table uses several formats. The chrState text field has a > in the
Format property to display the data entry in uppercase. The dtmOrigCustDate field
has an mmm dd yyyy format to display the date of birth as the short month name, a
space, the day and a four-digit year (Feb 04 2003). The blnActive field has a format
of Yes/No with lookup Display Control property set to Text box.
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Numeric custom formats can vary, based on the value. You can enter a four-part
format into the Format property. The first part is for positive numbers, the second
for negatives, the third if the value is 0, and the last if the value is null; for example,
##4#0; (#,##0);“--";“None”.

Table 2-5 shows several formats.

Table 2-5

Format Examples
Format Specified Data as Entered Formatted Data as Displayed
> Adam Smith ADAM SMITH
#,##0;(#,#4#0);"-0-";,"None” 15 -15 0 No Data 15 (15) -0- None
Currency 12345.67 $12,345.67
“Acct No.” 0000 3271 Acct No. 3271
mmm yy 9/11/03 Sep 03
Long Date 9/11/03 Friday, September 11, 2003

Entering input masks

Input masks enable you to have more control over data entry by defining data-
validation placeholders for each character that you enter into a field. Another

way of thinking about this is that the Input mask property lets you design a pattern
that will be used to input information into the field. This pattern, or input mask,

is what the users will see when they begin to enter the data. This pattern or mask
is not saved in the underlying data. This is different from how the field will be
displayed — controlled by the format property.

For example, if you set the input mask property to (999)000-0000, parentheses and
hyphens appear as shown when entering data and an underscore (_)appears in
place of each 9 or 0 of this phone number template. You would see (_) in your data
entry field. Access will automatically add a \ character before each placeholder; for
example, \(999\)000\-0000. You can also enter a multi-part input mask, such as
1(999)000-0000;0;“ ”. The input mask can contain up to three parts separated by
semicolons.

The first section of a multi-part mask defines the input mask itself (for example,
1(999)000-0000). The ! is used to fill the input mask from right to left when optional
characters are on the left side. The second section specifies whether Access stores
the literal display characters in the table when you enter data. If you enter a 0 for
this part, all literal display characters (for example, the parentheses and hyphen)
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are stored with the value; if you enter 1 or leave this part blank, only characters
typed into the text box are stored. The third part specifies the character that
Microsoft Access displays for spaces in the input mask. You can use any character;
the default is an underscore. If you want to display a space, use a space enclosed in
quotation marks (* 7).

When you have defined an input mask and set the Format property for the same
data, the Format property takes precedence when Access displays the data. This
means that even if you've saved an input mask with data, it is ignored when data
is formatted.

Some of the characters that can be used are shown in Table 2-6.

Table 2-6
Input Mask Characters

Character  Description

0 Digits only (0-9; entry is required; can't use plus [+] and minus [-] signs).

9 Only Digit or space (entry not required; can't use [+] and [-]).

# Digit or space and sign (entry not required; blanks converted to spaces; the
[+] and [-] signs are allowed).

L Alphabetic Letters only (A-Z, a-z; no spaces allowed; entry is required).

? Alphabetic Letters only (A-Z, a-z; no spaces allowed; entry is optional).

A Alphanumeric Letters or digits (A-Z, a-z, 0-9; no spaces allowed; entry is
required).

A Alphanumeric Letters or digits (A-Z, a-z, 0-9; no spaces allowed; entry is
optional).

& Any character or a space (A-z, 0-9; entry is required).

C Any character or a space (A-z, 0-9; entry is optional).

< Converts all characters that follow the symbol to lowercase.

> Conwverts all characters that follow the symbol to uppercase.

! Causes input mask to fill from right to left, rather than from left to right, when
characters on the left side of the input mask are optional. You can include the
exclamation point anywhere in the input mask.

\ Displays the character that follows as the literal character (for example,
appears as just A).

-/ Decimal placeholder, thousands, and date time separator determined by

Regional Settings section of the Control Panel.
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Tip

Tip

Setting the Input Mask property to the word Password creates a password entry
text box. Any character typed in the text box is stored as the character, but appears

4 as an asterisk (¥).

The Input Mask Wizard

Although you can enter an Input Mask manually, you can easily create an input mask
for text or date type fields by using the Input Mask Wizard. When you click the Input
Mask property, the builder button (three periods) appears. You can click the Build
button to start the Wizard. Figure 2-15 shows the first screen of the Input Mask
Wizard.

Input Mask Wizard

e e e L e

To soa how & Belechid mank works, use e Try [tbox
Te change B Inout Mask lat, cick the Bt Lint bution
Enput Mask D e

e | | wewt> | meen |

Figure 2-15: The Input Mask Wizard for
creating input masks for text and date
field types.

The Input Mask Wizard shows not only the name of each predefined input mask, but
also an example for each name. You can choose from the list of predefined masks;
click the Try It text box to see how data entry will look. After you choose an input
mask, the next Wizard screen enables you to customize it and determine the place-
holder symbol. Another Wizard screen enables you to decide whether to store any
special characters with the data. When you complete the Wizard, Access places the
actual input mask characters in the property sheet.

You can create your own input masks for text and date/time fields by simply click-
ing the Edit List button and entering a Descriptive name, Input Mask, place holder

s character, and a sample data content. Once created, the new mask will be avail-

able the next time you use the Input Mask Wizard.

You can enter as many custom masks as you need. You can also determine the
international settings so that you can work with multiple country masks.
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Entering decimal places

Decimal places are valid only for Number or Currency data. The number of decimal
places can be from 0 to 15, depending on the field size of the numeric or currency
field. If the field size is Byte, Integer, or Long Integer, you can have 0 decimal places.
If the field size is Single, you can enter from 0 to 7 for the Decimal Places property. If
the field size is Double, you can enter from 0 to 15 for the Decimal Places property.
If you define a field as Currency (or use one of the predefined formats, such as
General, Fixed, or Standard), Access sets the number of decimal places to 2 auto-
matically. You can override this setting by entering a different value into the
Decimal Places property.

Creating a caption

You use captions when you want to display an alternative to the field name on forms
and reports. Normally, the label used to describe a field in a form or a report is the
field name. Sometimes, however, you want to call the field name one thing while dis-
playing a more (or less) descriptive label. You should keep field names as short as
possible to make them easier to use in calculations. You may then want a longer
name to be used for a label in forms or reports. For example, you may use the field
name Length but want the label Length (in) on all forms.

Tip Many of the fields in the tables of the Access Auto Auctions system use captions
. forthe fields. It is a good idea to use a caption for your field names that will be dis-
4 played on the screen. For example, changing the name of the chrFirstName field to
First Name (with a space between the words) makes the name more understand-
able to the user.

Setting a default value

A default value is the value Access automatically displays for the field when you add
a new record to the table. This value can be any value that matches the data type of
the field. A default is no more than an initial value; you can change it during data
entry. To enter a default value, simply enter the desired value into the Default Value
property setting. A default value can be an expression, as well as a number or a text
string. Chapter 11 explains how to create expressions.

Alote Number and Currency data types are set automatically to O when you add a new
-~ record.

Working with validation

Data validation enables you to limit the values that are accepted in a field. Validation
may be automatic, such as the checking of a numeric field for text or a valid date.
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Validation can also be user-defined. User-defined validation can be as simple as a
range of values (such as those found in the Length or Weight fields), or it can be an
expression like the one found in the Gender field.

Figure 2-14 (shown earlier) displays the property area for the curCreditLimit field.
Notice the validation options for the curCreditLimit field. The Validation Rule
<250000 specifies that the number entered must be less than 250,000. The Validation
Text message “Credit can only be granted to $250,000” appears in a warning dialog
box (see Figure 2-16) if a user tries to enter a value greater than 250,000.

Access Auto Auctioms 4| Figure 2-16: A data-validation warning box. This
appears when the user enters a value in the field
that does not match the rule specified in the design
= of the table.

!5 Crudt can orly be granted to §290,000

Caution The dialog box shown in Figure 2-16 will not display if you have the Show Office

Tip

Assistant value turned on for Help. Rather, the message will be displayed in a mes-
sage box shown by the Assistant, as shown in Figure 2-17.
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Figure 2-17: The warning displayed by the Assistant
that a value was entered outside of the range of the
accepted values.

You can also use Date values with Date/Time data types in range validation.

Dates are surrounded, or delimited, by pound signs when used in data-validation
expressions. If you want to limit the dtmLastSalesDate data entry to dates between
January 1, 2000, and December 31, 2005, you enter Between #1/1/00# and
#12/31/05%#.

If you want to limit the upper end to the current date, you can enter a different set
s, of dates, such as Between #1/1/00# and Date( ).

e

Following the design in Table 2-7, you can now complete all the property settings
in the tblContacts table. Note that the design shows only the critical fields that
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must have their properties defined. You can also find this table (and the others
in this book) in the Access Auto Auctions databases on the CD-ROM that accom-

panies this book.

Table 2-7

Properties for the tblContacts Table

Field Name

Properties

idsContactID:

chrContactType:
chrFirstName:
chrLastName:
chrCompany:
chrAddress:
chrCity:
chrState:
chrZipCode:

chrCustomerType:
chrPhone:

chrFax:

chrEmail:
hlkwebsSite:
dtmOrigCustDate:

chrTaxLocation:

curCreditLimit:

curCurBal:
chrCreditStatus:
dtmLastSalesDate:

dblDiscountPercent:

memNotes:

blnActive:

Caption — a Contact ID, Indexed - Yes (No Duplicates) [Set
when you make this field the primary key field].

Caption — Contact Type.
Caption - First Name.
Caption — Last Name.
Caption — Company
Caption — Address
Caption - City

Format >, Caption — State

Input Mask — 00000\-9999;0;_, Caption — Zip Code, Indexed Yes
(Duplicates OK)

Caption — Customer Type, Indexed Yes (Duplicates OK)
Input Mask — \(999") “000\-0000;0;_, Caption — Phone
Input Mask — I\(999") “000\-0000;0;_, Caption — Fax
Field Size — 100, Caption — Email

Field Size — 100, Caption — Web Site

Format — mmm dd yyyy, Caption — Orig Cust Date

Field Size — 2, Format - >, Caption — Tax Location, Indexed Yes
(Duplicates OK)

Format — Currency, Decimal Places — 2, Caption — Credit Limit,
Validation Rule - < 250000

Caption — Current Balance
Caption - Credit Status
Caption — Last Sales Date
Caption — Discount Percent
Caption — Notes

Format — Yes/No, Caption — Active, Display Control (Lookup) —
Text Box
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Understanding the Lookup Property window

The Field Properties pane of the Table Design window has a second tab: the Lookup
tab. After clicking this tab, you may see a single property, the Display Control prop-
erty. This property is used for Text, Number, and Logical fields.

Figure 2-18 shows the Lookup Property window for the blnActive Yes/No field
where Display Control is the only property. This property has three choices: Check
Box, Text Box, and Combo Box. Choosing one of these determines which control
type is used when a particular field is added to a form. Generally, all controls are
created as text boxes except Yes/No fields, which are created as a check box by
default. For Yes/No data types, however, you may want to use the Text Box setting
to display Yes/No, True/False, or another choice that you specifically put in the for-
mat property box.

If you are working with text fields instead of a Yes/No field and know a certain text
field can only be one of a few combinations, select the combo box choice for the
display control. When you select the Combo Box control type as a default, the prop-
erties change so that you can define a combo box.

| Reference

L

s

ij You learn about combo boxes in Chapter 10.
|

Gorarpl LSO
Dieglary Contral

Figure 2-18: The Lookup property Display
Control for a Yes/No field.

The properties for a Lookup field are different for each data type. The Yes/No data

- type fields differ from text fields or numeric fields. Because a Lookup field is really
a combo box (you learn more about these later), the standard properties for a
combo box are displayed when you select a Lookup field data type.

Determining the Primary Key

Every table should have a primary key — one or more fields with a unique value
for each record. (This principle is called entity integrity in the world of database
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management.) In the tblContacts table, the idsContactID field is the primary key.
Each contact has a different idsContactID value so that you can identify one from
the other. If you don’t specify a primary key (unique value field), Access can create
one for you.

Creating a unique key

Without the idsContactID field, you'd have to rely on another field for uniqueness.
You couldn’t use the chrLastName field because two customers could have the same
last name. In fact, you couldn’t even use the chrLastName and chrFirstName fields
together (multi-field key), for the same reason —two people could be named James
Williamson. You need to come up with a field that makes every record unique.
Looking at the table, you may think that you could use the chrLastName and
chrFirstName and chrCompany fields, but theoretically, it’s possible that two people
work at the same company with the same name. The easiest way to solve this prob-
lem is to create a single field with a unique value for each record —for example, the
idsContactID field.

| Reference

fj Multiple-field primary keys are discussed in Chapter 3.
|

Tip

If you don’t designate a field as a primary key, Access can create an AutoNumber
field and add it to the beginning of the table. This field contains a unique number
for each record in the table, and Access maintains it automatically. For several
reasons, however, you may want to create and maintain your own primary key:

4 A primary key is an index.

4 Indexes maintain a presorted order of one or more fields that greatly speeds
up queries, searches, and sort requests.

4+ When you add new records to your table, Access checks for duplicate data
and doesn’t allow any duplicates for the primary key field.

4 Access displays your data in the order of the primary key.
By designating a field such as idsContactID as the unique primary key, you can see

your data in an understandable order. In our example, the idsContactID field is
assigned automatically by Access in the order that a record is put into the system.

When creating a unique primary key, many developers believe that you should cre-
ate it based on some method. For example, if it is a customer name, you may want

4 1o use the first four letters of their last name, the first initial, and then a three-digit

unique number. Bill Jones could be JONESB0O1, Adam Jones could be JONESAQ02,
and on and on.
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Creating the primary key

The primary key can be created in any of four ways:

4 Select the field to be used as the primary key and choose Edit => Primary Key.

4 Select the field to be used as the primary key and select the Primary Key
button (the key icon) in the toolbar.

4 Right-click the mouse to display the shortcut menu and select Primary Key.
4 Save the table without creating a primary key, and Access automatically
creates an AutoNumber field.

Before you click the Primary Key button or select the menu choice, you must click
the gray area in the far-left side of the field that you want as the primary key. A right-
pointing triangle appears. After you select the primary key, a key appears in the gray
area to indicate that the primary key has been created.

Because a primary key must contain a unique value and that value cannot be a
blank, you need to make sure that the table tblContacts is still empty in the My
Access Auto Auctions database and then assign the primary key. Follow these steps
to empty the table and create a primary key:

1. Select and open the table named tblContacts in the Database window.

2. Select all the fields by clicking in the first (selector) field and while holding
the mouse button drag across all records. The records should be highlighted.

3. Press the Delete key and answer Yes to the dialog box that appears and says
“You are about to delete X record(s).”

. Click the Design button to move to the design window.
. Select the idsContactID field.
. Click the Primary Key button to make the idsContactID field the primary key.

N S U1 e

. Save the file.

The Indexes window

A primary key is really an index. In the table Design View, the key icon beside the
idsContactID field indicates that this field is the primary key for the table. You can
also see the primary key by looking at the Indexes window. (Figure 2-19 shows a pri-
mary key in the Indexes window.) You can display or hide this window by toggling
the Indexes button on the toolbar or selecting View &> Indexes from the menu bar.
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Using the Indexes window, you can determine whether an index is a primary key,
whether or not it is unique, and whether null values should be ignored. Notice that
the window in Figure 2-19 shows four indexes. All four indexes are built on a single
field (idsContactID, chrZipCode, chrCustomerType, and chrTaxLocation) and in
Ascending Order. Each index has an Index name — the idsContactID field is the
Primary Key index; notice the key symbol in the first column. Looking at the pri-
mary properties pane of the window in Figure 2-19, you can see that it says this key
is the Primary key and that the Unique property is set to Yes and Nulls are not
ignored.

2 gl
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Figure 2-19: The Indexes window that shows all
the indexes built for the tblContacts table. You can
add more indexes directly into this window.

Aote ~ Ifyou create the tblContacts table as described in Table 2-7 you should have cre-
=il ated these four indexes.

The Table Properties window

Just as each field has a property area, the overall table has one, too. While in the
Table Design window, right-click while the cursor is inside the design area and
choose Properties or click the Properties button (hand with a piece of paper) on
the Table Design toolbar to display the Table Properties window.

g Cross- Figure 2-20 shows the Table Properties window. Here you can enter the validation
| Reference’) | ,jc and message that are to be applied to the overall record that will be enforced

when you save a record. You can assign a Description name for the table that will
be displayed in datasheet mode. You can set up a default sorting order (other than
by primary key) and even a default filter to show only a subset of the data. This is
also where you can set up your sub-datasheets.
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Figure 2-20: Setting general Table properties.

Printing a Table Design

Tip

You can print a table design by using Tools &> Analyze = Documenter. The Database
Documenter is an Access tool that makes it easy to document your database objects.
When you select this command, Access shows you a dialog box that lets you select
objects to print. In Figure 2-21, there is only one object, the tblContact table, under
the Tables tab. You can select it by clicking the check box next to the table name.

2 Curvent Detabase
) quenes M rorma

o8 rncaies
= Taties

~ = miCostacts

Figure 2-21: The Access Documenter dialog box.

You can also set various options for printing. When you click the Options button,
a dialog box appears that enables you to select which information from the Table
Design to print. You can print the various field names, all of their properties, the
indexes, and even network permissions.

After you select which data you want to view, Access generates a report; you can
view it in a Print Preview window or send the output to a printer.

The Database Documenter creates a table of all the objects and object properties

%, you specify. You can use this utility to document such database objects as forms,

4 queries, reports, macros, and modules.
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Saving the Completed Table

You can save the completed table design by choosing File => Save or by clicking the
Save button on the toolbar. If you are saving the table for the first time, Access asks
for the name of the table; enter it and click OK. Table names can be up to 64 charac-
ters long and follow standard Access field-naming conventions. If you have saved
this table before and want to save it with a different name, choose File=> Save As
and enter a different table name. This creates a new table design and leaves the
original table with its original name untouched. If you want to delete the old table,
select it in the Database window and press Delete. You can also save the table when
you close it.

Manipulating Tables in a Database Window

As you create many tables in your database, you may want to use them in other
databases or copy them for use as a history file. You may want to copy only the
table structure. You can perform many operations on tables in the Database win-
dow, including

4 Renaming tables

4 Deleting tables

4+ Copying tables in a database

4+ Copying a table from another database

You can perform these tasks by direct manipulation or by using menu items.

Renaming tables

You can rename a table with these steps:

1. Select the table name in the Database window.
2. Click once on the table name.
3. Type the name of the new table and press Enter.
You can also rename the table by selecting Edit => Rename or by right-clicking a

table and selecting Rename from the shortcut menu. After you change the table
name, it appears in the Tables list, which re-sorts the tables in alphabetical order.

Caution If you rename a table, you must change the table name in any objects where it
was previously referenced, including queries, forms, and reports.
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Deleting tables

You can delete a table by selecting the table name and pressing the Delete key.
Another method is to select the table name and select Edit => Delete or by right-
clicking a table and selecting Delete from the shortcut menu. Like most delete oper-
ations, you have to confirm the delete by selecting Yes in a Delete Table dialog box.

Copying tables in a database

By using the Copy and Paste options from the Edit menu or the toolbar buttons,
you can copy any table in the database. When you paste the table back into the
database, you can choose from three option buttons:

4 Structure Only

4 Structure and Data

4 Append Data to Existing Table
Selecting the Structure Only button creates a new table design with no data. This
enables you to create an empty table with all the same field names and properties

as the original table. This option is typically used to create a temporary table or a
history structure to which you can copy old records.

When you select Structure and Data, a complete copy of the table design and all of
its data is created.

Selecting the button Append Data to Existing Table adds the data of one table to
the bottom of another. This option is useful for combining tables, such as when you
want to add data from a monthly transaction table to a yearly history table.

Follow these steps to copy a table:

1. Select the table name in the Database window.

2. Select Edit => Copy.

3. Select Edit = Paste.

4. Type the name of the new table.

5. Choose one of the Paste options.

6. Click OK to complete the operation.
Figure 2-22 shows the Paste Table As dialog box, where you make these decisions.
To paste the data, you have to select the type of paste operation and type the name

of the new table. When you are appending data to an existing table, you must type
the name of an existing table.
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Paste Table As 0| Figure 2-22: Pasting a table activates this
Tabie tiame [ ]| dialog box. You can paste only the structure,
T Carce the data and structure, or the data to an
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Copying a table to another database

Just as you can copy a table within a database, you can copy a table to another
database. There are many reasons why you may want to do this. Possibly you share
a common table among multiple systems, or you may need to create a backup copy
of your important tables within the system.

When you copy tables to another database, the relationships between tables are
not copied; Access copies only the table design and the data. The method for copy-
ing a table to another database is essentially the same as for copying a table within
a database. To copy a table to another database, follow these steps:

. Select the table name in the Database window.

. Select Edit => Copy.

. Open another database.

. Select Edit => Paste.

. Type the name of the new table.

. Choose one of the Paste options.
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. Click OK to complete the operation.

Adding Records to a Database Table

So far you have only created one table in the My Access Auto Auctions database:
tblContacts.

Adding records is as simple as selecting the table name in the database container
and clicking on its name to bring up the table in datasheet view. Once opened, you
can type in values for each field. Figure 2-23 shows adding records in datasheet
mode to the table.

You can enter information into all fields except the Contact ID field (idsContactID).
AutoNumber fields will enter a number automatically for you.
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Figure 2-23: Adding records to a table using the table datasheet.

Although you can add records directly into the table through the datasheet view, it
is not the most efficient way. It is better to add records through use of forms.

m Chapter 4 covers adding records to tables using forms.
Reference
- + + +



Entering Data
into Tables
and Forms

In Chapter 2, you created a database container named My
Access Auto Auctions to hold the tables, queries, forms,
reports, and macros that you will create as you learn Access.
You also created a table named tblContacts in datasheet mode
and in the Design surface. In this chapter, you will use a data-
sheet to enter data into an Access table. Then you will work
with displaying the data in the datasheet in many different
ways. Using a datasheet to view and work with your data
enables you to see many records at once. Using the tblContacts
and tblProducts tables, you will learn to add, change, and
delete data, as well as learn about the features available in
Access for displaying data in a datasheet.

On the This chapter uses the database named CHAPO3Start.mdb.
cn@“ If you have not already copied it onto your machine from
the CD, you will need to do so now.

Understanding Datasheets

Using a datasheet is one of the many ways that you can view
data in Access. Datasheets display a list of records in a format
commonly known as a browse screen, in dBASE, a table view in
Paradox, and a spreadsheet in Excel or Lotus 1-2-3. The format
is also referred to as a browse table or table view.

A datasheet is like a table or spreadsheet because data is dis-
played as a series of rows and columns. Figure 3-1 is a typical
datasheet view of data. Like a table or spreadsheet, a datasheet
displays data as a series of rows and columns. Each row rep-
resents a single record, and each column represents a single

CHAPTER
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4

Moving within

a datasheet

Opening a

new datasheet

Using special data
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Finding and
replacing values
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field in the table. By scrolling up or down in the datasheet, you can see records that
don’t fit onscreen at that moment, and by scrolling left or right, you can see more
columns or fields.

Datasheets are completely customizable, so you can view your data in many ways.
By changing the font size, you can see more or less of your table onscreen. You can
rearrange the order of the records or the fields. You can hide columns, change the
displayed column width or row height, and lock several columns in position so that
they continue to be displayed as you scroll around other parts of your datasheet.

1967 Shally Stu Cans $83.000 90
196 Shally Siy Cons §185.000 80
2001 BMY 740 Cans 337,000,800
2001 Aucks Gre Cans 529,500 08 535,000 00
1947 Auchs VWhi Caey $25,000 00 52090090
1968 Fordman f Cany 531,000 .08 SB7 000 80
1559 Fordman 1 Can 59,500 00 514,000 00
1588 Fordmae Cons 2000 §700.00
2001 Fordmaa Cans 511.000.08 $17.000.80
19% CADOY C Cans 58,500 00 31250090
1937 Fordmae Cons o e
1933 Fordmas Cany 52,500 09 §.200 90
1586 BAIY 3¢ Caes 52,800 .00 $3,500.00
1969 Antgue Ci Cann £580 08 317,900 80
198 BUCKY Can 55,500 08 §7.200 90
1569 Shelly Con Cary 535,500 .08 340,000 90
1988 Becky C Can $4.500 00 8579000
1563 Rarw Dodg Caey 529,500 00 $33,500 80
1572 Chawy gron Cars §2980008  $3500000
1992 Bascky R WManbant 51,500 00 §1,850 90
2003 N Van_ Mintvans S21.00000 52400000
1552 Fordmaa Mnhans 53.000.00 §5,500.00
1999 Fordmas Menhans 54,500 00 56,800 00
2002 Fordman | Meniany SHO0M §1450080
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Figure 3-1: A typical datasheet view of data. Each column holds the common
information that is found in a single field (like the Description or Retail Price).
Each row represents a single record in the table.

You can sort the datasheet quickly into any order by using one toolbar button. You
can filter the datasheet for specific records — making other records invisible. You can
also import records directly to the datasheet or export formatted records from the
datasheet directly to Word, Excel, or other applications that support OLE (Object
Linking and Embedding) 2.x.

The Datasheet Window

The Datasheet window is similar to other object windows in Access. The actual
Datasheet window is open within the Access window. At the top of the Access
window, you see the title bar (displaying Microsoft Access), the menu bar, and
the toolbars.
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Quick Review of Records and Fields

As you recall, a table is a container for entering related information — patient records, a card
list (Birthday/Xmas/Holiday), birthday reminders, payroll information, and on and on. Each
table has a formal structure comprised of fields. Each field, when displayed in a datasheet
(a two-dimensional sheet of information) can be found in each column, going from top to
bottom. Each field has a specific type of data— text, numeric, date type, and so on. Each field
has a unique name that is used to categorize the information stored in it. The table is com-
posed of records, where each record stores information about a single entity (like a single
customer or single product) in the fields of the table. One record is made up of information
stored in all the fields of the table structure. For example, if a table has three fields— name,
address, and phone number — then record one has one name, one address, and one phone
number in it. Record two also has only one name, one address, and one phone number in
it. All three fields can be found in each record —only the contents of those fields change.
That is why a datasheet is an ideal way of looking at the contents of a table all at once —you
can see the individual field contents by looking down any column (field). You can also
review a single record’s values by finding the row (record) that holds the information that
you want to review and simply looking across the row to see all values for that specific
record.

At the bottom of the Access window, you see the status bar. The status bar displays
assorted information in the datasheet; for example, it may contain field description
information (like in Figure 3-1, “Up to 100 character description of the product”),
error messages, and warnings. If the field was given a description when it was cre-
ated, the Field Description that you enter for each field is displayed here. If a specific
field doesn’t have a Field Description, Access displays the words Datasheet View.
Generally, error messages and warnings appear in dialog boxes in the center of the
screen rather than in the status bar. If you need help understanding the meaning of
a button in the toolbar, move the mouse over the button, hovering over it, and a
tooltip appears with a one- or two-word explanation.

In the center of the Access window in Figure 3-1 is another window —the actual
Datasheet window. This Datasheet window displays the data in rows and columns.
Each record occupies one row, and each column—headed by a field name in the
first row or field title area of the browse window — contains that field’s values. The
display arranges the records initially by primary key and the fields by the order of
their creation in the table design.

The right side of the window contains a scrollbar for moving quickly between records
(up and down). As you scroll between records, a Scroll Tip (shown in Figure 3-1)
tells you precisely where the scrollbar takes you. In Access 2003, the size of the
scrollbar thumb gives you a proportional look at how many of the total number of
records are being displayed. In Figure 3-1, the scrollbar thumb takes up about 12
percent of the scroll area, and 28 of 60 records are shown onscreen. You also have a
proportional scrollbar at the bottom of the window for moving among fields (left to
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right and back). Also located at the bottom of the Datasheet window are the
Navigation buttons (along the left side of the bottom of the frame). You can also
use these buttons to move between records.

Moving within a datasheet

You can move easily in the Datasheet window by using the mouse pointer to indicate
where you want to change or add to your data—just click a field and record location.
In addition, the menus, toolbars, scrollbars, and navigation buttons make it easy to
move among fields and records. You can think of a datasheet as a spreadsheet with-
out the row numbers and column letters. Instead, your columns have field names,
and your rows are unique records that have identifiable values in each cell.

Table 3-1 lists the navigational keys that you can use for moving within a datasheet.

Table 3-1
Navigating in a Datasheet
Navigational Direction Keystrokes
Next field Tab
Previous field Shift+Tab
First field of current record Home
Last field of current record End

Next record

Previous record

Down arrow ({)

Up arrow (T)

First field of first record Ctrl+Home
Last field of last record Ctrl+End
Scroll up one page PgUp
Scroll down one page PgDn

Go to record number box F5

The Navigation buttons

The Navigation buttons (shown in Figure 3-2) are the six controls located at the
bottom of the Datasheet window, which you click to move between records. The
two leftmost controls move you to the first record or the previous record in the
datasheet (table). The three rightmost controls position you on the next record,
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last record, or new record in the datasheet (table). If you know the record number
(the row number of a specific record), you can click the record number box, enter a
record number, and press Enter.

[Mocord: 4] 4T N DT B ]

Figure 3-2: The Navigation buttons of
a datasheet.

If you enter a record number greater than the number of records in the table, an

~~ error message appears stating that you can’t go to the specified record.

The Datasheet toolbar

The Datasheet toolbar (shown in Figure 3-3) provides a way to work with the
datasheet. The toolbar has many familiar objects on it, as well as some new ones.

E-Ba &l [ MY px Da. O
Figure 3-3: The Datasheet toolbar.

The first icon is the View button, which allows you to switch between Table Design
View, Datasheet View, PivotTable View, and PivotChart View. You can see all four
choices by clicking the button’s down-arrow (triangle pointing down). Clicking
Design View permits you to make changes to the design of your table. You can then
click the Datasheet View to return to the datasheet.

If you originally displayed a data-entry form, this icon has three primary choices:
=~ Table Design View, Datasheet View, and Form View, as well as the PivotTable and
PivotChart Views.

The next icon, Save, looks like a floppy disk. Click this icon to save any layout
changes to the datasheet.

Caution Save does not allow you to roll back changes to the data. As you move from record

to record, the data is forever changed.

You can use the next icon, File Search, to activate the Basic Search dialog box
(default), as shown in Figure 3-4. You can use this Search Box to search for specific
files on your hard drive or network drive. You can switch to the Advance Search by
selecting it at the bottom of the Basic File Search box.
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; Baic Pl Sanech + »| Figure 3-4: The dialog box of the new toolbar
(® 18 4] button, File Search. This new tool lets you search
Sashin for a specific file on your hard drive.
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The next set of three icons includes Print (which looks like a printer and sends the
datasheet information to your printer in a quick, two-dimensional table report) and
Print Preview (which looks like a printed page with a magnifying glass and shows
onscreen how your datasheet looks when printed). The third icon lets you spell-
check your data using the standard Microsoft Office spell-checking feature.

Following the printer and spelling grouping are the editing buttons — Cut, Copy, and
Paste —that are represented by these icons, respectively: scissors, two sheets of
paper, and a clipboard. These three buttons allow you to remove a value, copy a
value, and paste a value to the table. The objects that can be copied, removed, or
pasted include a single value, a datasheet row, a column, or a range of values. You
can copy and paste objects to and from other programs (such as Microsoft Word or
Excel), but the Format Painter is not available in a datasheet.

The next icon, which looks like an arrow pointing counterclockwise, lets you Undo
a change to a record, or, more globally, undo formatting.

The next icon is the Internet icon that enables you to insert a hyperlink.

The next two icons are the QuickSort icons. They are easy to identify — one is the
letter A on top of the letter Z with the arrow pointing down (to represent alphabeti-
cal sort order), and the other icon is the reverse, Z to A (representing reverse sort
order). You can select one or more columns and click one of these buttons to sort
the data instantly, in ascending or descending order, using the selected columns as
the sorting criteria.
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The next three icons in this toolbar look like funnels. They let you determine and
display only selected records. The first icon, Filter By Selection, lets you filter
records to match a specific highlighted value in a given field. Each time you highlight
a value, you add the selection to the filter. This additive process continues until the
filter is cleared. (See the detailed discussion of this filter later in this chapter.)

The second icon, Filter By Form, turns each column of data into a combo box where
you can select a single value from the datasheet and filter for matching records.
Figure 3-5 illustrates how this works. A special window appears with the name of
the table, which is tblProducts, and the Filter By Form title. Once open, you can
click on a field, like in Figure 3-5, and select which choice you want to filter by. In
Figure 3-5 you could select from “Cars, Minivans, Motor Homes, SUV, Trucks.” Once
selected, Access display only records that match your choice.

Figure 3-5: The Filter By Form window for filtering records via a series of
field values. You simply select the value that you want from one or more
columns and click the Filter By Form button.

You use the last icon in the group to turn any filter on or off; it is a toggle button.
The first time you press it, you activate the search specified in the Filter By Form
or Filter By Selection.

The Find icon is a pair of binoculars; clicking it displays a dialog box that lets you
search for a specific value in a specific field.

The next two icons allow you to add a new record or delete an existing record. To
create a new record, click the icon with the arrow and asterisk, and a new record
row is added at the bottom of the datasheet. To delete an existing record, click
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anywhere in the record row that you want to delete and then click the icon with the
arrow and X. A message displays, warning you that you are about to delete a record
and that you won'’t be able to undo your change; select Yes to continue or No to
save the record.

The next icon is the Database Window icon, which displays the Database window.
Next is the New Object: AutoForm icon, which contains a pull-down menu that gives
you choices so that you can create new objects, such as tables, queries, forms,
reports, macros, and modules. Two interesting choices are the first two— AutoForm
and AutoReport. When you click either of these, you immediately create a single
record form or report that can be used without any further formatting.

The last icon is the Microsoft Access Help icon. When you click it, the Microsoft
Access Help Window appears; here you can access help locally or through Office
online at microsoft.com.

Opening a Datasheet

To open a datasheet from the Database window, follow these steps:

1. Using the CHAPO3Start.mdb database from the CD, click the Tables button on
the Objects menu bar of the Database window (in this case, CHAP(03Start).

2. Click the table name that you want to open. (In this example, tbIProducts.)
3. Click Open.

An alternative method for opening the datasheet is to double-click on the
tblProducts table name.

Tip If you are in any of the design windows, you can click on the Datasheet button and

~ view your data in a datasheet.
s

Entering New Data

When you open a datasheet, all the records in your table are visible; if you just cre-
ated your table design, however, the new datasheet doesn’t yet contain any data.
Figure 3-6 is an empty datasheet. When the datasheet is empty, the record pointer
on the first record is displayed as a right-pointing triangle.
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Figure 3-6: An empty datasheet. Notice that the first record is blank
and the record pointer, a right-pointing triangle, is shown in the
left-most column.

If the datasheet already contains records, you enter information into a new record
by clicking either the New Record button on the toolbar or the New Record button
on the datasheet navigation bar. Access moves the pointer to the first field of the
new record row, just below the last entered record. With the cursor is in the first
field of the new record, you type in the value you want to enter, and then moving
to the next field, enter a value, and so on. As you begin entering the record, the
record pointer turns into a pencil, indicating that the record is being edited. A sec-
ond row also appears as you begin to enter the first record; this row contains an
asterisk in the record-pointer position, which indicates the next new record. The
new-record pointer always appears in the last row of the datasheet; after you enter
arecord, it is inserted at the bottom of the table, immediately before the last row (a
new blank record). Figure 3-7 shows adding a new record into the tblProducts table
and the next new blank record below it.

The cursor generally starts in the first field of the table for data entry.

B hiProducts  Table

[T Proowio | Dascagtion | Cont Retsd Pece | SelePrce | Twable |  Auchion
N E 1553 chavy 4xd Pickup sibers Trucks 1 $15,908 00 52095 00 $15.93 %0

| |11 1598 Fordman £ whte pckup Trucks 1 51150000 51550000 31395080 =] a
[ 117 1954 Fordnan XLP Ext Trucks 1 5500000 $7,800.08 s6owe B a
| |TRK-118 1950 GMY 1500 CUSTOMEZED Trucks 1 $4,700 00 $6,100.00 #5300 B =}
| [e11e 1339 Dedgwe Pickup Trucks 1 51450000 51595000 31350000 2B a
[z 2001 Dodgee Dakoty sives puckup  Trucks 1 $1700000 52150000 $199%e0 @ a
| |TRe-1m 1984 Dodge Dakoty gresa peckup  Trucks 1 600000 5760008 sTane B a
[ meax 1959 Dedgo Dabkota Spost Trucks 1 51520000 51850000 $1Tane0 @ =}
[ | 1388 Fordmam T250 Bechet Treck  Trucks 1 5250000 5350008 psw B a
| |42 1958 Fordmam Tanger XLX Trucks 1 $1200000 S1550000 31490000 B a
|| TR-207 2003 Fordman T-150 Regelar Cob Trucks 1 $740000 SN0 $19.80090 ] ]
|| TRe-211 2084 Toyota Range Trucks 2 15300 5000 5080 -] a
- q 5800 50.08 3080 -] [ |

Figure 3-7: Entering a record into the datasheet of the tbIProducts table of the
Chap03Start.mdb Database.
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To add a new record to the open datasheet view of the tblProducts, follow these
steps:

1. Click the New Record button.

2. Type in a value for all fields of the table, moving between fields by pressing
the Enter key or the Tab key.

When adding or editing records, you may see four different record pointers:

4 Current record
4 Record being edited
4 Record is locked (multi-user systems)

4 New record

Caution If the record contains an AutoNumber field, Access shows the name (AutoNumber)
in the field. You cannot enter a value in this type of field; rather, simply press the
Tab or Enter key to skip this field. Access automatically puts the number in for you
when entering data.

Saving the record

After you have entered all the values in the record, you normally move to the next
record. This action saves the record. Any time you move to a different record or
close the table, the last record you worked on is written to the database and the
record pointer changes from a pencil to a right-pointing triangle.

To save a record, you must enter a valid value (unique) into the primary key field.
The primary key is validated for data type, uniqueness, and any validation rules that
you have entered into the Validation Rule property. If you enter a duplicate value or
do not enter a value, Access reports an error when you attempt to save the record.
Figure 3-8 shows the error message Access shows when a duplicate field value is
entered in the primary key field.

Wicrosolt Access %
The chingis you reduetied 1 T tbie wire NO! CoMES DECIuIE Triy nould Ceate duphcate values n B

! Wi, primary by, o relaSonghip. Change B dats in e Seid or faids that contan dupicate dats, romove e
i, or redefre e i 10 et duphiate el and iy agan

[l

Figure 3-8: The error message Access displays when attempting
to save a record with a duplicate primary key value entered into
the new record.
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The Undo Current Field/Record icon in the toolbar can undo changes only to the
current record. After you move to the next record, you must use the regular Undo

"4 icon. This works for a single record only. After you change a second record, you

cannot undo the first record.

You can save the record to disk without leaving the record by selecting Records =
s, Save Record or by pressing Shift+Enter.

s

After you've entered a record, you understand what happens as you enter the first
record. Next you learn how Access validates your data as you make entries into the
fields.

Understanding automatic data-type validation

Access validates certain types of data automatically. Therefore, you don’t have to
enter any data-validation rules for these data types when you specify table proper-
ties. The data types that Access validates automatically include

4 Number/Currency
4 Date/Time
4 Yes/No

Number or Currency fields allow only valid numbers to be entered into the field.
Initially, Access lets you enter a letter into a Number field. When you move off the
field, however, a dialog box appears with this message: The value you entered
isn't valid for this field. The same is true of any other inappropriate char-
acters. If you try to enter more than one decimal point, you get the same message.
If you enter a number too large for a certain Number data type, you also get this
message.

Date and Time fields are validated for valid date or time values. If you try to enter a
date such as 14/45/05, a time such as 37:39:12, or a single letter in a Date/Time field,
a dialog box appears with this error message: The value you entered isn't
valid for this field.

Yes/No fields require that you enter one of these defined values: Yes, True, -1, or

a number other than 0 (it displays as a —1) for Yes; or No, False, Off, or 0 for No. Of
course, you can also define your own acceptable values in the Format property for
the field, but generally these are the only acceptable values. If you try to enter an
invalid value, the dialog box appears with the usual message to indicate an inappro-
priate value.
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Tip

Tip

Understanding how properties affect data entry

Because field types vary, you use different data-entry techniques for each type.
Previously in this chapter, you learned that some data-type validation is automatic.
Designing the tblContacts table, however, means entering certain user-defined for-
mat and data-validation rules. The following sections examine the types of data
entry.

Standard text data entry

The first field in the tblContacts table is an AutoNumber field; the next 13 fields are
Text fields. After skipping the first field Contact ID, you simply enter a value in each
field and move on. The Zip Code field uses an input mask (00000\-9999;0;) for data
entry. The Phone and Fax fields also use an input mask (!1\(999”) “000\-0000;0;).
These are the only fields that use any special formatting via the input mask. If you
enter a value in lowercase in the State or Tax Location fields, they display in upper-
case. This is done by specifying upper case (>) in the format property. You can vali-
date text for specific values, and you can display it with format properties.

Sometimes you want to enter a Text field on multiple lines. You can press

.~ Ctrl+Enter to add a new line. This is useful, for example, in large text strings for for-

4 matting a multiple-line address field. It is also useful in Memo fields for formatting
multiple-line entries.
Date/Time data entry

The Orig Cust Date and Last Sales Date fields in the tblContacts table are Date/Time
data types, which both use a format value of Short date. However, they could have
been defined as having a format of medium date (16-Mar-03) or long date (Sunday,
March 16, 2003). Using either of these formats simply means that no matter how
you type in the birth date — using month and year, day month year, or month day
year, it always displays as the format specified —short date (03/16/03), medium
date (16-Mar-03), or long date (Sunday, March 16, 2003). So if you type 4/8/05 or

8 Apr 05, Access displays the value in the correct format when you leave the field.
The value 4/8/2005 is really stored in the table.

Formats affect only the display of the data. They do not change storage of data in
the table.

s

Number/Currency data entry with data validation

The Credit Limit field in the tblContacts table has a validation rule assigned to it. It
has a Validation Rule property to limit the amount of credit to $250,000. If the rule is
violated, a dialog box appears with the validation text entered for the field. If a con-
tact is allowed to have more than $250,000 credit, the validation rule can simply be
changed in the table design.
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OLE object data entry

You can enter the OLE (Object Linking and Embedding) data-type Picture field into
a datasheet, even though you don’t see the picture. An OLE field can hold many dif-
ferent item types, including

4 Bitmap pictures

4 Sound files

4 Business graphs

4+ Word or Excel files

4 Web page or Hyperlink

Any object that an OLE server supports can be stored in an Access OLE field. OLE
objects are generally entered into a form so you can see, hear, or use the value.
When OLE objects appear in datasheets, you see text that tells what the object is
(for example, you may see Paintbrush Picture in the OLE field). You can enter OLE
objects into a field in two ways:

4 Pasting from the Clipboard

4 Inserting into the field from the Insert => Object menu dialog box

fﬁix For thorough coverage of using and displaying OLE objects, see Chapter 12.

l1 Reference

Memo field data entry

The last field in the table is memNotes, which is a Memo data type. This type of field
allows up to 65,536 characters of text for each field. Recall that you entered a long
string (about 260 characters) into the Memo field. As you entered the string, how-
ever, you saw only a few characters at a time. The rest of the string scrolled out of
sight. By pressing Shift+F2, you can display a Zoom box with a scrollbar (see Figure
3-9) that lets you see about 1,000 characters at a time.
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Figure 3-9: The Zoom box for a memo field. Notice
that you can now see a lot more of the note in the memo
field — not all 65,536 characters, but still quite a lot.
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When you first display text in a zoomed window, all the text is selected and high-

- lighted in reverse video. You can de-select the text by pressing the Home key.

New
Feature

o

\ _ Inthe Zoom box, you see a Font button at the bottom. When you press this button,
a dialog box appears, allowing you to determine the type of font to be used to dis-
play the memo in the memo Zoom box.

When you change the font for the text in a memo field, all the text is affected. You

-~ can't change the format of a single word or sentence.

Navigating Records in a Datasheet

‘\l ote

It’s not unusual to want to make changes to records after you’'ve entered them. You
may want to change records for several reasons:

4 You receive new information that changes existing values

4 You discover errors that change existing values

4 You need to add new records
When you decide to edit data in a table, the first step is to open the table —if it isn’t

already open. From the Database window, open the tblProducts datasheet by double-
clicking tblProducts in the list of tables.

If you are in any of the Design windows, you can click the Datasheet button to

-~ make changes to the information within the table.

Tip

When you open a datasheet in Access that has related tables, a column with a plus
sign (+) is added to access the related records, or sub-datasheets, and is displayed

4 as the first column. Figure 3-10 shows the tblSales datasheet with the plus sign in

the first column; clicking this opens a sub-datasheet of the line items for that sale.
Sub-datasheets are thoroughly explained in Chapter 6.

Moving between records

You can move to any record by scrolling through the records and positioning your
cursor on the desired record. When your table is large, however, you want to get to
a specific record as quickly as possible.
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Figure 3-10: The Sales datasheet with the plus sign in the first
column for expanding each record to show related line items.

You can use the vertical scrollbar to move between records. The scrollbar arrows,
however, move the record pointer only one record at a time. To move through many
records at a time, you must use the scrollbar elevator (known as a scroll box in
Windows 95/98/NT) or click the area between the scrollbar elevator and the scroll-
bar arrows.

The Edit => Go To menu, shown open in Figure 3-11, has several choices to help you
quickly move around the worksheet.

You can also use the five Navigation buttons, located along the bottom of the
Datasheet window (also shown in Figure 3-11), for moving between records. You
simply click these buttons to move to the desired record. If you know the record
number (row number of a specific record), you can click the record number box,
enter a record number, and press Enter. You can also press F5 to move to the record
number box.

Watch the Scroll Tips when you use scrollbars to move to another area of the
-, datasheet. Access does not update the record number box until you click a field.

s

Finding a specific value
Although you can move to a specific record (if you know the record number) or to a
specific field in the current record, usually what you really want to find is a certain
value in a record. You can use one of three methods for locating a value in a field:

4 Select Edit = Find

4 Select the Find button in the toolbar (a pair of binoculars)

4 Press Ctrl+F
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Figure 3-11: Moving between records using the Go To menu. You can do the
same thing by using the Navigation buttons along the bottom of the window.

Choosing any of these methods displays the Find and Replace dialog box (shown in
Figure 3-12). To limit the search to a specific field, make sure your cursor is on the
field that you want to use in the search before you open the dialog box. You can
also choose to search the entire table for the specified record by clicking the Look
In combo box and selecting the table.
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Figure 3-12: The Find and Replace dialog box. The
fastest way to activate it is to simply press the Ctrl+F
key combination.

Tip If you highlight the entire record by clicking the record selector (the small gray box
1»} next to the record), Access automatically searches through all fields.
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The Find and Replace dialog box lets you control many aspects of the search. In the
Find What text box, you enter the value to be searched for. You can also display and
choose from a list of items that you have previously searched for in this database.
You can enter the value just as it appears in the field, or you can use three types of
wildcards:

* (any number of characters)
? (any one character)

# (any one number)

To look at how these wildcards work, first suppose that you want to find any value in
the Description field of the tblProducts table beginning with 2001; for this, you type
2001*. Then suppose that you want to search for values ending with Sedan, so you
type *Sedan. If you want to search for any value that begins with 2001, ends with
Sedan, and contains any number of characters in between, you type 2001*Sedan.

The Match drop-down list contains three choices:

4 Any Part of Field
4 Whole Field
4 Start of Field

The default is Whole Field. This option finds only the whole value you enter. For
example, the Whole Field option finds the value FORD only if the value in the field
being searched is exactly FORD. If you select Any Part of Field, Access searches to
see whether the value is contained anywhere in the field; this search finds the value
FORD in the field values FORDMAN and FORD. A search for FORM using the Start of
Field option searches from the beginning of the field, returning no values because
the field always begins with a year (1999, 2003, and so on). You can choose one of
three search direction choices (Up, Down, All) in the Search combo box.

In addition to these combo boxes, you can use two check boxes at the bottom of
the Find and Replace dialog box— Match Case and Search Fields As Formatted.
Match Case determines whether the search is case-sensitive. The default is not
case-sensitive (not checked). A search for SMITH finds smith, SMITH, or Smith. If
you check the Match Case check box, you must then enter the search string in the
exact case of the field value. (The data types Number, Currency, and Date/Time do
not have any case attributes.)

If you have checked Match Case, Access does not use the value Search Fields as
Formatted (the second check box), which limits the search to the actual values dis-
played in the table. (If you format a field for display in the datasheet, you should
check the box.)
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The Search Fields as Formatted check box, the selected default, finds only text that
has the same pattern of uppercase and lowercase letters as the text you specified in
the Find What box. Clear this box to find text regardless of case.

Caution Using Search Fields as Formatted may slow the search process.

When you click the Find Next button, the search begins. If Access finds the value,
the cursor highlights it in the datasheet. To find the next occurrence of the value,
you must click the Find Next button again. You can also select the Find Next button
to find the first occurrence. The dialog box remains open so that you can find multi-
ple occurrences. When you find the value that you want, select the Close command
button to close the dialog box.

Changing Values in a Datasheet

If the field that you are in has no value, you can type a new value into the field.
When you enter new values into a field, follow the same rules as for a new-record
entry.

‘\Iote Usually, you change values by moving to the value that you want to change or edit
-~ and making the change.

Replacing an existing value manually

Generally, you enter a field with either no characters selected or the entire value
selected. If you use the keyboard to enter a field, normally you select the entire value.
(You know that the entire value is selected when it is displayed in reverse video.)
When you begin to type, the new content replaces the selected value automatically.

To select the entire value with the mouse, use any of these methods:

4 Click just to the left of the value when the cursor is shown as a large plus sign.

4 Select any part of the value and double-click the mouse button. (This usually
works unless the text contains a space.)

4 Click to the left of the value, hold down the left mouse button, and drag the
mouse to select the whole value.

4 Select any part of the value and press F2.

Tip You may want to replace an existing value with the default from the Default Value
. table property. To do so, select the value and press Ctrl+Alt+Spacebar. If you want
4 to replace an existing value with that of the same field from the preceding record,
you can press Ctrl+' (single quote mark). You can press Ctrl+; (semicolon) to place
the current date in a field as well.
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Changing an existing value

Pressing Ctrl+— (hyphen) deletes the current record.

If you want to change an existing value instead of replacing the entire value, you can
use the mouse and click in front of any character in the field. When you position the
mouse pointer in front of an individual character, you activate Insert mode; the
existing value moves to the right as you type the new value. If you press the Insert
key, your entry changes to Overstrike mode; you replace one character at a time as
you type. You can use the arrow keys to move between characters without disturb-
ing them. Erase characters to the left by pressing Backspace, or to the right of the

cursor by pressing Delete.

Table 3-2 lists editing techniques.

Table 3-2
Editing Techniques

Editing Operation

Keystrokes

Move the insertion point within a field
Insert a value within a field

Select the entire field

Replace an existing value with a new value

Replace a value with the value of the
previous field

Replace the current value with the
default value

Insert a line break in a Text or Memo field
Save the current record

Insert the current date

Insert the current time

Add a new record

Delete the current record

Toggle values in a check box or option button

Undo a change to the current record

Press the right- (—) and left-arrow (<) keys
Select the insertion point and type new data
Press F2 or double-click the mouse button
Select the entire field and type a new value

Press Ctrl+' (single quote mark)
Press Ctrl+Alt+Spacebar

Press Ctrl+Enter

Press Shift+Enter or move to another record
Ctrl+; (semicolon)

Ctrl+: (colon)

Ctrl++ (plus sign)

Ctrl+— (minus sign)

Spacebar

Press Esc or click the Undo button
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Fields that you can't edit

Some fields can’t be edited, such as:

4 AutoNumber fields. Access maintains AutoNumber fields automatically, cal-
culating the values as you create each new record. AutoNumber fields can be
used as the primary key.

4+ Calculated fields. Access creates calculated fields in forms or queries; these
values are not actually stored in your table.

4 Locked or disabled fields. You can set certain properties in a form to disallow
entry for a specific field. You can lock or disable a field when you designate
Form properties.

4 Fields in multi-user locked records. If another user locks the record, you
can’t edit any fields in that record.

Using the Undo Feature

The Undo button is often dimmed in Access so that it can’t be used. As soon as you
begin editing a record, however, you can use this button to undo the typing in the
current field. You can also undo a change with the Esc key; pressing Esc cancels
either a changed value or the previously changed field. Pressing Esc twice undoes
changes to the entire current record.

Several Undo menu commands and variations are available to undo your work. The
following list explains how you can undo your work at various stages of completion:

4+ Edit=> Can’t Undo. Undo is not available.
4+ Edit~> Undo Typing. Cancels the most recent change to your data.

4+ Edit~> Undo Current Field/Record. Cancels the most recent change to the
current field. Cancels all changes to the current record.

4+ Edit~> Undo Saved Record. Cancels all changes to last saved record.

As you type a value into a field, you can select Edit => Undo or use the toolbar Undo
button to undo changes to that value. After you move to another field, you can
undo the change to the preceding field’s value by selecting Edit => Undo Current
Field/Record or by using the Undo button. You can also undo all the changes to an
unsaved current record by selecting Edit > Undo Current Field/Record. After you
save a record, you can still undo the changes by selecting Edit => Undo Saved
Record. However, after the next record is edited, changes are permanent.
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Copying and Pasting Values

Copying or cutting data to the Clipboard is a Microsoft Windows task; it is not
actually a specific function of Access. After you cut or copy a value, you can paste
into another field or record by using Edit > Paste or the Paste button in the toolbar.
You can cut, copy, or paste data from any Windows application or from one task

to another in Access. Using this technique, you can copy entire records between
tables or databases, and you can copy datasheet values to and from Microsoft Word
and Excel.

Replacing Values

To replace an existing value in a field, you can manually find the record to update or
you can use the Find and Replace dialog box. You can display the Find and Replace
dialog in four ways:

4 Select Edit = Find

4 Select the Find button in the toolbar (a pair of binoculars)
4 Press Ctrl+F

4+ Select Edit => Replace

This dialog box allows you to do a find and replace in the current field or in the
entire datasheet. You can find a certain value and replace it with a new value in
every place in the table that you are in.

After the Find and Replace dialog box is active, you should first click the Replace
tab and type in the value that you want to find in the Find What text box, as shown
in Figure 3-12. After you have selected all the remaining search options (turn off
Search Fields As Formatted for example), click the Find Next button. You are taken
to the first occurrence of what you want to find. After you get there, if you want to
change the value of the current found item (under the cursor), click the Replace
button, and it replaces the selected value. For example, Figure 3-13 shows that you
want to find the value Motor Homes in the Category field of the tblProducts table
and change it to the value Camper.

You can select your search options in the Find tab and then click the Replace tab to
continue the process. However, it is far easier to simply do the entire process using
the Replace tab. Enter what you want to find and the value that you want to use to
replace the existing value. After you have completed the dialog box with all the cor-
rect information, select one of the command buttons on the side.
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Figure 3-13: Find and Replace dialog box with the
Replace tab showing. In this case you want to replace
the value Motor Homes with Camper.

4+ Find Next. Finds the next field that has the value in the Find What field.
4 Cancel. Closes the form and performs no find and replace.

4+ Replace. Replaces the value in the current field only. (Note: You must use the
Find Next button first.).

4+ Replace All Finds all the fields with the Find What value and automatically
replaces them with the Replace value.

Use the Find Next and Replace commands if you aren’t sure about changing all the
fields with the Find What value. When you use this command, you can pick the

fields that you want to replace and the fields that you want to leave with the same
value.

Adding New Records

You can add records to the datasheet by positioning the cursor on the datasheet’s
last line (where the record pointer is an asterisk) and entering the new record. You
can go to a new record in many ways: You can select Insert = New Record, or you

can go directly to a new record by using the New Record button in the toolbar, the
navigation button area, or the menu selection Edit => Go To = New Record. Another

way to move quickly to the new record is to go to the last record and press the
down-arrow ({) key.

Sometimes you want to add several new records and make all existing records
temporarily invisible. The menu item Records => Data Entry clears the screen tem-
porarily of all records while you are editing new records. When you want to restore
all records, select Records = Remove Filter/Sort.
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Deleting Records

You can delete any number of records by selecting the record(s) and pressing the
Delete key. You can also select the records and choose Edit => Delete or place your
cursor in a record and select Edit &> Delete Record. When you press Delete or choose
the menu selection, a dialog box asks you to confirm the deletion (see Figure 3-14).
If you select Yes, the records are deleted. If you select Cancel, no changes are made.

Caution The Default value for this dialog box is Yes. Pressing the Enter key automatically
deletes the records. If you accidentally erase records using this method, the action
can't be reversed.

Wicrosoh Accen 4| Figure 3-14: The Delete Record dialog
You are sbout to delete 1 record(s). box warns you that you are about to
1 110 e you wr e sle .0 P e cowaben delete x number of records —the default
- d'w"'_’ . = - response is YES (OK to delete) so be
CED v | careful when deleting records.

Caution If you have relations set between tables and Enforce Referential Integrity is
checked —for example, the tblContacts (Customer) table is related to the tblSales
table —then you can't delete a record unless the Cascade Delete check box is also
checked and you are attempting to delete from the lowest child in the relationship
builder (tblSales versus tblContacts). Otherwise, you receive an error message dia-
log box that reports that the record can't be deleted or changed because the table
'<tablename>' includes related records.

You can select multiple contiguous records. To do so, click the record selector of
the first record that you want to select and drag the record-pointer icon (right-
pointing arrow) to the last record that you want to select.

Adding, Changing, and Deleting Columns

A very dangerous feature in Access 2003 is the capability to add, delete, and rename
columns in a datasheet. This feature actually changes the data design. When you go
to the Table Design screen and make changes, you know that you are changing the
underlying structure of the data because you can see yourself do it. Within a data-
sheet, however, you may not realize the consequences of the changes that you are
making. Any field name that is changed may cause any query, form, report, macro,
or module that uses that name to no longer function. If you are creating applications
for others, you should not allow users to use a datasheet to make the changes
described in this part of the book.
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Deleting a column from a datasheet

You can delete columns from a datasheet by selecting one column at a time and
selecting Edit &> Delete Column. When you take this action, a dialog box warns that
you will be deleting all the data in this column, as well as the field itself, from the
table design. More importantly, if you have used this field in a data-entry form or a
report, you get an error message the next time you use any object that references
this field name. You can’t delete more than one column at a time.

Adding a column to a datasheet

You can add new columns to a datasheet by selecting Insert = Column, which cre-
ates a new column to the left of the column that your insertion point was in. The
new column is labeled Fieldl. You can then add data to the records for the column.

Adding a new column also adds the field to the table design. When you save the
datasheet, Access writes the field into the table design, using the characteristics
of the data for the field properties.

Changing a field name (column header)

When you add a new field, you want to change the column name before you save
the datasheet. You can change a column header by double-clicking the column
header and editing the text in the column header. When you save the datasheet,
this column header text is used as a field name for the table design.

Caution When you change a column header, you are changing the field name in the table.
If you have used this field name in forms, reports, queries, macros, or modules,
they no longer work until you change them in the other objects. This is a danger-
ous way to change a field name; only experienced users should use it.

Displaying Records

A number of mouse techniques and menu items can increase your productivity
when you add or change records. Either by selecting from the Format menu or by
using the mouse, you can change the field order, hide and freeze columns, change
row height or column width, change display fonts, and change the display or
remove gridlines.

Changing the field order

By default, Access displays the fields in a datasheet in the same order that they
appear in a table or query. Sometimes, however, you need to see certain fields next
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to each other in order to better analyze your data. To rearrange your fields, select a
column (as shown in Figure 3-15) and drag the column to its new location.

() WiProducts - Table
| Produci D . Descaption | Catwgory Com | Retad Price |
¥ |car-a01 2y . 32 656 00 5 5 00

:rlyf (1N | iy O

Figure 3-15: Selecting a column to change the field order.

You can select and drag columns one at a time, or you can select multiple columns
to drag. Suppose you want the field Quantity in Stock to appear before the field
Description in the datasheet of the tbIProducts. Use the following steps to make
this change:

1. Position the mouse pointer on the Quantity field (column) name. The cursor
changes to a down arrow.

2. Click to select the column and hold down the mouse button. The entire
Quantity column is now highlighted. Release the mouse button.

3. Click the mouse button again; the pointer changes to an arrow with a box
under it.

4. Drag the column to the left edge of the datasheet between the Product ID
and Description field. A thin black column will appear between them (as in
Figure 3-15).

5. Release the mouse button; the column is now moved to in front of the
Description field of the datasheet.

With this method, you can move any individual field or contiguous field selection.
You can move the fields left or right or past the right or left boundary of the
window.
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Moving fields in a datasheet does not affect the field order in the table design.
2

Changing the field display width

You can change the field display width (column width) either by specifying the width
in a dialog box (in number of characters) or by dragging the column border. When
you drag a column border, the cursor changes to the double-arrow symbol.

To widen a column or to make it narrower, follow these two steps:

1. Place the mouse pointer between two column names on the field separator
line. The mouse pointer turns into a small line with arrows pointing to the left
and right —if you have it in the correct location.

2. Drag the column border to the left to make the column smaller or to the right
to make it larger.

You can resize a column instantly to the best fit (based on the longest data value)
.. by double-clicking the right column border after the cursor changes to the double
4 arrow.

Resizing the column doesnt change the number of characters allowed in the
table’s field size. You are simply changing the amount of viewing space for the
data contained in the column.

Alternatively, you can resize a column by choosing Format => Column Width or by
right-clicking the column header and selecting Column Width from the menu. When
you click Column Width, the dialog box in which you enter column width in number
of characters displays, as shown in Figure 3-16. You can also return the column to
its default size by checking the Standard Width check box.

You can create an icon on your toolbar for Column Width. To do this, click the down
arrow next to the Help button on the toolbar and select Add or Remove Buttons.
Then select the Table Datasheet choice, and finally select the Column Width button.
This button becomes the last button on that toolbar. To remove it, just repeat the
process.

Column Width 4| Figure 3-16: The Column Width dialog box.
cam e
I Standand Width Cancal

Bast Mt
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Caution You can hide a column if you drag the column gridline to the gridline of the next
column to the left. This also happens if you set the column width to 0 in the
Column Width dialog box. If you do this, you must use Format=> Unhide Columns
to redisplay the columns.

Changing the record display height

You can change the record (that is, row) height of all rows by dragging a row’s bor-
der to make the row height larger or smaller, or you can select Format => Row Height.
Sometimes you may need to increase the row height to accommodate larger fonts
or text data displays of multiple lines.

You can also create an icon on your toolbar for Row Height. To do this, click the
down arrow next to the Help button and select Add or Remove Buttons. Then select
the Table Datasheet choice, and finally select the Row Height button. This button
becomes the last button on that toolbar. To remove it, just repeat the process.

When you drag a record’s border, the cursor changes to the vertical two-headed
arrow that you see at the left edge of Figure 3-17.

1 thiProducts - Table oo
Produci 0| Quanéty in Stock Category | Cost | RetsdPrice | SalaFal
CAR-B01 1 2081 Spostate Cars SIZE5 00 $I899500 59

+ CAR-B02

$21.50000 2

081 BIEY 740 Sedan Cars
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Figure 3-17: Changing a row’s height. Simply put the mouse pointer
between two rows. When the mouse pointer changes to arrows
pointing up and down, drag the height to what you want.

To increase or decrease a row’s height, follow these steps:
1. Place the mouse pointer between two rows on the gray record selector. The
cursor changes to the double pointing arrow (up and down).

2. Drag the row border upward to shrink all row heights. Drag the border down-
ward to increase all row heights.
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_‘\Iote The procedure for changing row height changes the row size for all rows in the
-~ datasheet.

You can also resize rows by choosing Format = Row Height. A dialog box appears
so that you can enter the row height in point size. You can also return the rows to
their default point size by checking the Standard Height check box.

Caution If you drag a record’s gridline up to meet the gridline immediately above it in the
previous record, all rows are hidden. This also occurs if you set the row height
close to O (for example, a height of 0.1) in the Row Height dialog box. In that case,
you must select Format => Row Height and reset the row height to a larger number
to redisplay the rows.

Displaying cell gridlines
Normally gridlines appear between fields (columns) and between records (rows).

By selecting Format = Datasheet, you can determine whether to display gridlines
and how they look. Figure 3-18 shows the Datasheet Formatting dialog box that

you use.
Datasheet Formatting %]
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Figure 3-18: Changing cell gridlines

The Datasheet Formatting dialog box gives you complete control over gridlines.
Using the Gridlines Shown check boxes, you can eliminate both Horizontal and
Vertical gridlines. If you choose to keep the gridlines, you can change both the
Gridline Color and the Background Color. A sample shows you what the effect you
have chosen looks like. You can also determine whether the gridlines are Flat
(default white background with silver gridlines), Raised (default silver background
with gray gridlines), or Sunken (default silver background with white gridlines).
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Caution You can also determine the Border and Line Styles for each of the different
datasheet borders. You can determine a different border for the Datasheet Border,
Horizontal Gridline, Vertical Gridline, and Column Header Underline. To select a
different border style for each border in the datasheet, first select the Border that
you want to update from the left combo box and then the Line Style from the
combo box on the right. Repeat the process for each border. Each border in Figure
3-19 has a different line style.

The different line styles that you can use for the different datasheet borders include

Transparent Border Short Dashes Dash-Dot
Solid Dots Dash-Dot-Dot
Dashes Sparse Dots Double Solid

7 thiProducts - Table ST

Produci 10| Quanity in Stock Dascagtion Category | Cost | RetsdPrce | SeleFal
CARB01 V12081 Soodtete 2 62600 | 338.995.00
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Figure 3-19: Different line styles are used for the different borders in
the datasheet. In this case, the cell effect has been changed to change
the Gridline Color (dark black) and change the Horizontal lines to dashes.

Changing display fonts

You can resize the row height and column width automatically by changing the dis-
play font. By default, Access displays all data in the datasheet in the MS Sans Serif
8-point Regular font. You may find that this font does not print correctly because
MS Sans Serif is only a screen font. Arial 8-point Regular is a good match. Select
Format = Font to change the font type style, size, and style.

Setting the font display affects the entire datasheet. If you want to see more data on
the screen, you can use a very small font. You can also switch to a higher-resolution
display size if you have the necessary hardware. If you want to see larger characters,
you can increase the font size.
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To change the font to Courier 12-point bold, follow these steps:

1. Select Format => Font. A dialog box appears.

2. Select Courier from the Font combo box, as shown in Figure 3-20.
3. Select Bold from the Font style combo box.

4. Enter 12 into the text box area of the Size combo box.

5. Click OK.

3
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Figure 3-20: Changing to a different font
and font size in the datasheet.

As you change font attributes, a sample appears in the Sample area. This way, you
can see the changes that you are making before you make them. You can also change
the font color if you want.

Hiding and unhiding columns

You can hide columns by dragging the column gridline to the preceding field or by
setting the column size to 0. You can also use the Hide Columns dialog box to hide
one or more columns. To hide a single column, follow these steps:

1. Position the cursor anywhere within the column that you want to hide.

2. Select Format = Hide Columns. The column disappears. Actually, the column
width is simply set to 0. You can hide multiple columns by first selecting them
and then selecting Format > Hide Columns.

After you've hidden a column, you can redisplay it by selecting Format > Unhide
Columns. This action displays a dialog box that lets you hide or unhide columns
selectively by checking off the desired status of each field. When you are finished,
click Close; the datasheet appears, showing the desired fields.
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Freezing columns

When you want to scroll among many fields but want to keep certain fields from
scrolling out of view, you can use Format > Freeze Columns. With this selection, for
example, you can keep the Product ID and Description fields visible while you scroll
through the datasheet to find the product’s features. The columns that you want to
keep visible remain frozen on the far-left side of the datasheet; other fields scroll
out of sight horizontally. The fields must be contiguous if you want to freeze more
than one at a time. (Of course, you can first move your fields to place them next to
each other.) When you’re ready to unfreeze the datasheet columns, simply select
Format => Unfreeze All Columns.

Tip When you unfreeze columns, the column doesn’t move back to its original position.

You must move it manually.
s

Saving the changed layout

When you close the datasheet, you save all your data changes but you lose all your
layout changes. As you make all of these display changes to your datasheet, you
probably won’t want to make them again the next time you open the same datasheet.
By default, however, Access does not save the datasheet’s layout changes. If you
want your datasheet to look the same way the next time you open it, you can select
File > Save; this command saves your layout changes with the datasheet. You can
also click the Save icon on your toolbar (the icon with the floppy disk on it).

Caution If you are following the example, don't save the changes to the tbIProducts table.

Saving a record

As you move off a record, Access saves it. You can press Shift+Enter to save a record
without moving off it. A third way to save a record is to close the table. Yet another
way to save a record is to select Records o> Save Record.

Sorting and Filtering Records in a Datasheet

Finding a value lets you display a specific record and work with that record. If you
have multiple records that meet a find criteria, however, you may want to display
just that specific set of records. Using the Filter and Sort toolbar icons (or the
Records menu option Sort), you can display just the set of records that you want
to work with. You can also sort selected records instantly into any order that you
want: Use the two QuickSort buttons to sort the entire table, or use the three filter
buttons to select only certain records.
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Using the QuickSort feature

Sometimes you may simply want to sort your records into a desired order. The
QuickSort buttons on the toolbar let you sort selected columns into either ascend-
ing or descending order. The toolbar contains a different button for each order.
Before you can click either the Sort Ascending (A-Z) or Sort Descending (Z-A)
QuickSort buttons, you must select the fields that you want to use for the sort.

You select a field to use in the sort by placing your cursor in the field in any record.
After the cursor is in the column that you want to use in the sort, click the QuickSort
button. The data redisplays instantly in the sorted order.

If you want to sort your data on the basis of values in multiple fields, you can high-
light more than one column: Highlight a column (as previously discussed), hold
down the Shift key, and drag the cursor to the right. These steps select multiple
contiguous fields. When you select one of the QuickSort buttons, Access sorts the
records into major order (by the first highlighted field) and then into orders within
orders (based on subsequent fields). If you need to select multiple columns that
aren’t contiguous (next to each other), you can move them next to each other, as
discussed earlier in this chapter.

Tip If you want to re-display your records in their original order, use Records > Remove
~ Filter/Sort.
A
- Cross- You learn more about sorting in Chapter 4.
'] Reference
!

Using Filter By Selection

Filter By Selection is a technology within Access that lets you select records
instantly on the basis of the current value that you selected. For example, using
the tblProducts table, move your cursor to the Category column and click the Sort
Ascending (A to Z) button. Access sorts the data by type of vehicle. Now highlight
any of the records with the value Minivans. When you press the Filter By Selection
button, Access selects only the records where the Category is Minivans. The
tbIProducts table contains seven records. After you have selected Minivans and
pressed the Filter By Selection button, only seven records are shown and all have
the value Minivans in the Category field.

The navigation button area of the Datasheet window tells you whether the database
is currently filtered; in addition, the Apply Filter/Remove Filter icon (third filter icon
that looks like a large funnel) is depressed, indicating that a filter is in use. When
you toggle this button, it removes all filters or sorts. The filter specification does
not go away; it is simply turned off.

Filter By Selection is additive. You can continue to select values, each time pressing
the Filter By Selection button.
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You can also right-click the field content that you want to filter by and then select

~} Filter By Selection from the menu choices.

If you want to further specify a selection and then see everything that doesn’t
match that selection (for example, where Description not equal to 2003 Mini Van),
move the cursor to the field (Description field where the value is 2003 Mini Van)
that you want to say doesn’t match and right-click on the datasheet and select Filter
Excluding Selection. You are now left with six records. This selects all Minivans
except the 2003 Mini Vans records.

Imagine using this technique to review sales by salespeople for specific time periods
or products. Filter By Selection provides incredible opportunities to drill down into
successive layers of data. As you add to Filter By Selection and Filter Excluding
Selection, it continues to add to its own internal query manager (also known as
Query By Example). Even when you click the Remove Filter icon to redisplay all the
records, Access still stores the query specification in memory. Figure 3-21 shows
this Filter By Selection screen in a Datasheet.

| Casgory |
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11999 Fordman E320 Carge Van Ihmrpny $4.500 M £6,500 00
1 1952 Fordnan Comrsios Van Lbmrams $3.000.00 5550000
1 1952 Buxcky Roade Estate Wages 31,5000 §1,85000
L] 300 $0.00
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Figure 3-21: Using Filter By Selection. In this case you see all records
for Minivans except 2003 Mini Van records.

Filter By Selection has some limitations. Most importantly, all the choices are added
together (that is, Minivans and not 2003 Mini Van). This means that the only opera-
tion you can perform is a search for records that meet all the specified conditions.
Another option, Filter By Form, lets you create more complex analyses.

If you want to use the Filter By Selection but can’t find the selection that you want
to use, but you know the value, right-click the field that you want to apply the filter
to and select Filter For. This option allows you to type in the selection to filter for.
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Using Filter By Form

Filter By Selection is just one way to filter data in Access. Another way is Filter By
Form. Selecting the second filter icon changes the datasheet to a single record;
every field becomes a combo box that enables you to select from a list of all values
for that field. As Figure 3-22 shows, the bottom of the form lets you specify the OR
conditions for each group of values that you specify.

In Figure 3-22, you can see two conditions created in the Filter By Selection example
(described previously) in the single line of the Filter By Form screen. If you click
the Or tab, you can enter a second set of conditions. Suppose you want to see SUV
records also. You already have the specification for Minivans, except 2003 Mini Van.
You would click on the Or tab (located at the bottom of the screen) and then select
SUV from the now-empty Category combo box. When you click the Apply Filter but-
ton (the large funnel), 15 records display—SUVs and Minivans (except 2003 Mini Van).

Figure 3-22: Using Filter By Form lets you set multiple conditions for
filtering at one time. Notice the Or tab at the bottom of the window.

You can have as many conditions as you need. If you need even more advanced
manipulation of your selections, you can choose Records = Filter => Advanced
Filter/Sort and get an actual QBE (Query by Example) screen that you can use to
enter more complex queries.

rCross- Later chapters explain more advanced concepts of queries.
Reference

Printing Records

You can print all the records in your datasheet in a simple row-and-column layout.
Later you learn to produce formatted reports. For now, the simplest way to print is
to select File = Print or use the Print icon in the toolbar. This selection displays the
standard Print dialog box, as shown in Figure 3-23.
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Figure 3-23: The Print dialog box.

Assuming that you set up a printer in Microsoft Windows, you can select OK to
print your datasheet in the font that you selected for display (or the nearest printer
equivalent). The printout reflects all layout options that are in effect when the
datasheet is printed. Hidden columns don’t print. Gridlines print only if the cell
gridline properties are on. The printout also reflects the specified row height and
column width.

Only so many columns and rows can fit on a page; the printout takes up as many
pages as required to print all the data. Access breaks up the printout as necessary
to fit on each page. For example, the tbIProducts table printout is six pages. Three
pages across are needed to print all the fields in the tblProducts table; each record
requires three pages in length. Each record of the tblContacts table requires four
pages in length.

Printing the datasheet
You can also control printing from the Print dialog box, selecting from several
options:
4 Print Range. Prints the entire datasheet or only selected pages or records.
4 Copies. Determines the number of copies to be printed.
4+ Collate. Determines whether multiple copies are collated.
You can also click the Properties button and set options for the selected printer or

select the printer itself to change the type of printer. The Setup button allows you
to set margins and print headings.

Using the Print Preview window

Although you may have all the information in the datasheet ready to print, you may
be unsure of whether to change the width or height of the columns or rows, or
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whether to adjust the fonts to improve your printed output. For that matter, you
may not want to print out the entire datasheet; you may need printed records from
only pages 3 and 4. Before making such adjustments to the datasheet properties,
you should view the report onscreen. To preview your print job, either click the
Print Preview button on the toolbar (a sheet of paper with a magnifying glass) or
select File > Print Preview. The Print Preview window appears (see Figure 3-24). The
default view is the first page in single page preview. To view multiple pages, as in
figure 3-24, select the multiple page button on the Print Preview toolbar (a square
with four pages inside it), then select the type of view —in this case, 2 x 3.

Figure 3-24: Print preview of a datasheet. You can specify up to
12 pages to view at one time through the View > Pages menu.

After you select the Print Preview button, the screen changes to Print Preview
mode. You see an image of your first printed page; a set of icons appears on the
toolbar. You can use the Navigation buttons (in the lower-left section of the Print
Preview window) to change pages, just as you use them to select records in a
datasheet.

The toolbar buttons provide quick access to printing tasks:

4 Close Window. Returns to Datasheet view

4 Print. Displays the Print dialog box, which is accessible when you select
File > Print from the menu bar

4 One Page. Toggles in and out to make the Print Preview show a single page
4+ Two Pages. Shows two pages in the Print Preview

4 Zoom Control. Adjusts the Print Preview screen to show more or less detail
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You can view more than two pages by selecting View => Pages and selecting One

s (1), Two (2), Four (4), Eight (8), or Twelve (12).
s

If you are satisfied with the datasheet after examining the preview, select the Print
button on the toolbar to print the datasheet. If you are not satisfied, select the
Close button to return to datasheet mode to make further changes to your data or
layout.

+ 0+ 0+
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SO far, you have learned to create a simple table, to enter
its data, and to display it in a datasheet. In the next chap-
ter, you learn to use simple queries. All these techniques can
be demonstrated using only a single table. However, as you
learned in Chapters 1 and 2, most database systems are com-
posed of many tables that are interrelated. The tblContacts
table has been an excellent sample of a single table; it contains
many different data types that lend themselves to productive
examples.

It’s time now to move into the real world of relational
database management.

This chapter will use the database named CHAPOA4Start.
mdb. If you have not already copied it onto your machine
from the CD, you will need to do so now. If you're follow-
ing the examples, you can use the tables already in this
database or create these tables yourself in a database of
your own naming.

If you want to create each of these tables, you can use
Appendix B as a reference for each table's description;
then use the steps you learned in Chapter 2 to create each
table.

Tables Used in the Access
Auto Auctions Database

Figure 4-1 diagrams the database of the Access Auto Auctions
system. There are 11 tables in the figure, each of which requires
its own table design, complete with field names, data types,
descriptions, and properties.
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Figure 4-1: The database diagram for the Access Auto Auctions system. This
diagram shows all the tables that are used in the system and how they relate
to each other.

‘Cm;X Figure 4-1 shows lines joining the tables. These are the relationship lines between

the tables. Each line indicates a separate relationship between two tables; these
are established either at the table level (using the Relationships window of
Access) or by using a query. In this chapter, you learn to use the Relationships win-
dow to establish a relationship at the table level.

If you closely look at the lines between the tables in Figure 4-1, you will observe
that some of the lines (relations) between the tables have writing above them.

For instance, the line between the tblSales and tblSalesLineltems tables shows

a darkened, thicker line near both tables and a light line connecting them. The

one near the tblSales table shows the number 1 above it, and the one near the
tblSalesLineltems table shows the infinity symbol (=) next to it. This simply means
that there can be many line items (the infinity symbol) for every one sale. You can
specifically tell Access that this is the case when you create the relationship diagram
of all tables in your system. This will be discussed more, later in this chapter.

Of the 11 tables in the database diagram, 6 hold the main data about any sales in
Access Auto Auctions and 5 are used for lookups.

A'lookup table is simply a table that is used to hold secondary information that is
related to the overall system. Lookup tables are good for holding common informa-
tion that will be used over and over in a system. For example, the tblSalesPerson
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lookup table holds the actual name of the sales person, and the tblTaxRates table
holds the correct tax rates for a specific tax location. These tables are used by the
system to verify that the users enter an accurate Sales Person ID and Tax Location
in the tblSales table. Other lookup tables are used to verify data being entered

into other tables. For example, the Customer Type in Contacts is verified by the
tblCustomerTypes table, and the Category field in the tblProducts table is verified
by the tblCategories table. You can eliminate the lookup tables and still use the sys-
tem if you want, although some of the value of the system may be lost. The six main
tables are listed below:

4 tblContacts: Contains information about each customer, such as purchaser
or seller (one purchaser can have many sales).

4 tblSales: Contains information about each sale (each sale can have many
items purchased, but only one purchaser, contact).

4 tblSalesLineltems: Contains information about each item purchased during
a sale (each line item will have one item detailed).

4 tblProducts: Contains information about individual products that can be
found in the tblSalesLineltems table (each line item will have a detail line in
the Products table).

4 tblSalesPayments: Contains information about each payment made by the
customer for a specific Sale (each sale can have more than one payment until
it is paid in full).

4 tblContactLog: Contains information about any contacts made with the

Customer/Seller (each Customer/Seller may contact the Access Auto Auctions
system more than one time for questions or problems).

The five lookup tables are listed below:
4+ tblPaymentType: Used by the tblSalesPayments table to retrieve

Payment type.

4+ tblCustomerTypes: Used by the tblContacts table to retrieve a list of valid
Customer types.

4+ tblTaxRates: Used by the tblSales table to retrieve valid Tax Rates for
each sale.

4 tblSalesPerson: Used by the tblSales table to retrieve valid SalesPerson
information for each sale.

4 tblCategories: Used by the tblProducts table to retrieve valid category
information for each item.

Alote Technically, the tblContact table is a lookup to the tbiSales table. This will be dis-
-l cussed more, later in this chapter.
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To set relations between tables, you must first establish a link between fields, known
as key fields, that contain some common information. The fields themselves do not
need to have the same name (for example, the common link between the tblSales
table and the tblContacts table — IngzBuyer versus idsContactID).

However, the contents in the linked fields must be of the same data type and
length. Most importantly, the information contained within both fields (one value
in each table) for any specific record must be the same in both tables for the link
to work. Generally, a relationship is established by linking key fields between
tables — the primary key in one table (the senior table, such as tblSales is primary
to tblSalesLineltems and tblSalesLineltems is primary to tblProducts) to a foreign
key in another table (the junior or secondary table — tlbSales is secondary to
tblContacts). A table can have both a primary key and a foreign key in it—as is the
case with the tblSales table, idsInvoiceNumber is a primary key (used to link to the
tblSalesltems and tblSalesPayments tables) and IngzBuyer is a foreign key (used to
link back to the tblContacts table).

A table can even have more than one primary or foreign key. It is easy to identify
the primary key of any table when you look at its structure in the Relationships
window or in the Query Design window — it will be in bold. It is more difficult to
identify foreign keys, because they have no specific font formatting.

In Figure 4-1, each table has one or more fields in bold. These are the fields that
define each table’s primary key.

Understanding Keys

When you create your tables, as in those created in Chapter 2, you should assign
each table a primary key — one or more fields whose contents are unique to each
record. This key is a way to make sure that the table records contain only one
unique value; for example, you may have several Contacts named Michael Irwin,
and you may even have more than one living at the same address. So in a case like
this, you have to decide on how you can create a record in the Customer database
that will let you identify each Michael Irwin separately. That is what a primary key
field can do for you. For example, the idsContactID field (a unique number that
you assign to each Customer or Seller [Contact] that comes into your office) is
the primary key in the tblContacts table— each record in the table has a different
idsContactID number. (No two records have the same number.) This is important
for several reasons: (1) you do not want to have two records in your database for
the same customer, because this can make updating the customer’s record virtually
impossible; (2) you want to be assured that each record in the table is accurate,
thus the information extracted from the table is accurate; and (3) you do not want
to make the table (and its records) any bigger than necessary.
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The capability to assign a single, unique value to each record makes the table “clean”
and reliable. This is known as entity integrity in the world of database management.
By having a different primary key value in each record (such as the idsContactID in
the tblContacts table), you can tell two records (in this case, customers) apart. This
is important because you can easily have two individual customers named Fred
Smith in your table.

Theoretically, you could use the customer name and the customer’s address, but

two people named Fred D. Smith could live in the same town and state, or a father
and son (Fred David Smith and Fred Daniel Smith) could live at the same address.
The goal of setting primary keys is to create individual records in a table that will
guarantee uniqueness.

If you don’t specify a primary key when creating Access tables, Access asks
whether you want one. If you say yes, Access creates a primary key for you as an
AutoNumber data type. It places a new sequential number in the primary key field
for each record automatically. Table 4-1 lists tables and their primary keys.

In Access, you can specify that a field be created that is an AutoNumber data type —

- afield that Access will automatically put a unique value in every time you add a new

record to the table. It is important to note that you cannot use an AutoNumber
data field in both tables to enforce referential integrity (more on this topic later)
between tables. Therefore, it is important to specify another data type —such as
Text or Numeric — for the primary key. (More about this topic later in this chapter.)

Table 4-1

Tables and Primary Keys
Table Primary Key
tblContacts idsContactID
tbiSales idsinvoiceNumber
tblSalesLineltems IgzInvoiceNumber + idsLineNumber
tblProducts chrProductiD
tblContactLog IngzContactID + idsEntrylD
tblSalesPayments IngzinvoiceNumber + idsLineNumber
tblSalesperson idsSalespersonID
tbITaxRates chrTaxLocation
tbICustomerTypes chrCustomerType
tbIPaymentType chrPaymentType

tblCategories chrCategory
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Deciding on a primary key

As you learned previously, a table normally has a unique field (or combination of
fields) —the primary key for that table—which makes each record unique. Often
it’s an ID field that uses the Text data type or Auto number. To determine the con-
tents of this ID field, you specify a method for creating the value in the field. Your
method can be as simple as letting Access automatically assign a value or using the
first letter of the real value you are tracking along with a sequence number (such as
A001, A002, A003, BO0O1, B002, and so on). The method may rely on a random set of
letters and numbers for the field content (as long as each field has a unique value)
or a complicated calculation based on information from several fields in the table.

Table 4-2 lists the Access Auto Auctions tables and explains the plan for deriving
the primary key values in each table.

As Table 4-2 shows, it doesn’t take a great deal of work (or even much imagination)
to derive a plan for key values. Any rudimentary scheme with a good sequence num-
ber always works. Access automatically tells you when you try to enter a duplicate
key value. To avoid duplication, you can simply add the value of 1 to the sequence
number. You may think that all these sequence numbers make it hard to look up
information in your tables. Just remember that normally you never look up informa-
tion by an ID field. Generally, you look up information according to the purpose of
the table. In the tblContacts table, for example, you would look up information by
Customer Name — last and first names. In some cases, the Customer Name is the
same, so you can look at other fields in the table (ZIP code, phone number) to find
the correct customer. Unless you just happen to know the Contact ID Number,
you’ll probably never use it in a search for information.

Table 4-2
Deriving the Primary Key
Table Derivation of Primary Key Value
tblContacts Individuals: AutoNumber field assigned by Access; incremented
in sequence.
tbiSales Invoice Number: AutoNumber field assigned by Access;
incremented in sequence.
tbiSalesLineltems Invoice Number (from Sales) and an AutoNumber set by Access;
incremented in sequence.
tblProducts Product Number, entered by the person putting in a new product.
tblSalesPayments Invoice Number (from Sales) and an AutoNumber set by Access;

incremented in sequence.
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Table Derivation of Primary Key Value

tblContactLog Contact ID (from Contacts) and an AutoNumber set by Access;
incremented in sequence.

tblIPaymentType Type of Payment - VISA, CASH, etc. used as lookup.

tblCustomerTypes Type of Customer — Dealer, Auctioneer, Parts, etc. used as lookup.

tbiSlaesperson Sales Person ID: AutoNumber field assigned by Access.

tbITaxRates Tax Location: entered by the person putting in a new record.

tblCategories Category of Items: entered by the person putting in a new record.

Benefits of a primary key

Have you ever placed an order with a company for the first time and then decided
the next day to increase your order? You call the people at the order desk. Some-
times they ask you for your customer number. You tell them that you don’t know
your customer number. This happens all the time. So they ask you for some other
information — generally, your ZIP code or telephone area code. Then, as they nar-
row down the list of customers, they ask your name. Then they tell you your cus-
tomer number. Some businesses use phone numbers as a unique starting point.

Database systems usually have more than one table, and these tend to be related

in some manner. For example, the tblContacts table and tblSales table are related
to each other via a link field called IngzBuyer in tbiSales and idsContactID in
tblContacts. The tblContacts table always has one record for each customer
(buyer/seller), and the tblSales table has a record for Sales Invoice that the customer
makes (every time he purchases something). Because each customer is one physical
person, you only need one record for the customer in the tblContacts table. Each
customer can make many purchases, however, which means you need to set up
another table to hold information about each sale—thus the tblSales table. Again,
each invoice is one physical sale (on a specific day at a specific time). Each sale has
one record in the tblSales table. Of course, you need to have some way to relate the
Buyer to the Sales they make in the tblSales table. This is accomplished by using a
common field that is in both tables. In this case, the field IngzBuyer in tblSales and
idsContactID in tblContacts (which has the identical type of information in both
tables).

When linking tables, you link the primary key field from one table (the idsContactID
in the tblContacts table) to a field in the second table that has the same structure
and type of data in it (the IngzBuyer field in the tblSales table). If the link field in the
second table is not the primary key field (and usually it isn’t), it’s known as a foreign
key field (discussed later in this chapter).
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Tip

Tip

Besides being a common link field between tables, a primary key field in Access has
these advantages:

4+ A primary key field is one that is used to create an index for the table that
greatly speeds up queries, searches, and sort requests.

4 When you add new records, you must enter a value in primary key field(s).
Access will not allow you to enter Null values, which guarantees that you’ll
have only valid records in your table.

4 When you add new records to a table that has a primary key, Access checks
for duplicate data and doesn’t enable you to enter duplicates for the primary
key field — thus it maintains its integrity.

4+ By default, Access displays your data in the order of the primary key.

An index is a special internal file that is created to put the records in a table in
some specific order. For instance, the primary key field in the tblContacts table is

7 an index that puts the records in order by idsContactID field. Using an indexed

table, Access can display records in a specific manner and quickly find any record
within the table using the index.

If you define a primary key based on part of the data in the record, you can have
Access automatically place your data in an understandable order. In the example,
the tblSalesLineltems database, the primary key is composed of two fields —
IngzInvoiceNumber (which comes from the tblSales table) and a line number for
a sequence (idsLineNumber field). This way, the tblSalesLineltems table places all
related sales together in a sequential order displayed alphanumerically.

Primary key fields should be made as short as possible (built using as few charac-
ters and fields as possible), because they can affect the speed of operations in a

4 database.

Creating a primary key

As discussed in Chapters 1 and 2, a primary key is created by selecting the field
(or fields) that you want to use as a primary key and clicking on the Primary Key
button on the toolbar (the button with the key on it). If you are specifying more
than one field, you specify the fields that you want for the primary key and again
click the Primary Key button. Selecting each field while holding down the Ctrl key
specifies the fields.

When you’re specifying multi-field primary keys, the selection order is important.
Therefore, check your selection by clicking the Indexes button on the toolbar
and looking at the field order. Figure 4-2 shows the two-field index for the
tblSalesLineltems table. Notice that the IngzinvoiceNumber field is before the
idsLineNumber field in the Indexes: tblSalesLineltems dialog box.
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Figure 4-2: The Indexes: tblSalesLineltems dialog box showing
a two-field primary key.

The Indexes: tblSalesLineltems dialog box shown in the center right-hand side of
Figure 4-2 is opened when you open a table in Design View and select View =
Indexes from the Access menu or click on the Indexes button (center of the toolbar
with a series of parallel lines and a lighting bolt along side of them —to the right of
the Key button). When the dialog box is open, it shows you all of the Indexes in that
table—including primary keys, foreign keys, and other indexes for sorting. Notice
that it shows the word PrimaryKey only in the ldgzInvoiceNumber field, although it
still shows the graphical key (for primary key) to the left of both fields. This simply
means that both fields together make up the primary key.

The order of these fields is critical; if you reverse them and make the idsLineNumber
field the first part of the primary key, it will not work correctly —you may create a
situation where you do not have a viable way to create unique records in the table.

‘\Iote There are two additional index names in the Indexes: tblSalesLineltems dialog box.

=~ These are not keys, but indexes used to speed sorts used in these tables. If you

regularly sort data in tables by the same field or fields, you should create an index

for that field. An index is an internal table of values that maintains the order of the

records. This way, when you need to sort data or find a piece of data instantly,

Access can search through the index keys in a known order, rather than searching
sequentially through the data.

Caution Creating indexes slows data entry; each new record, deleted record, or change to
the indexed field requires a change to the index. Use the index fields only when
you actually need them — for example, when you need to speed sorting your appli-
cation for later use. You will have to balance the display and reporting speed with
the need of data-entry speed.
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Understanding foreign keys

Primary keys guarantee uniqueness in a table, and you use the primary key field in
one table to link to related records in another table (the Sales purchased by a spe-
cific Customer). The common link field in the other table (records that are associ-

ated with a record in the primary table) may not be (and usually isn’t) the primary
key in the other table.

The common link field is a field or fields that hold the same type of data (matching
the content of the field exactly) as in the primary key of the link table. This common
link field, or combination of fields, is known as a foreign key field. Like a primary key,
which must be created in a special way, a foreign key must be created using the same
structure; however, it can be any field(s) in any order of the structure of the table.
You are not limited to a specific field order when you create the table’s structure.
By matching the same values (from a primary key field in a record in the primary
key table to the values in a specific field of one or more records in a foreign key
table) in both tables, you can relate records between tables.

In the relationship diagram of Figure 4-1, you saw a relationship between the
tblContacts and tblSales tables. The primary key of tblContacts, idsContactID, is
related to the IngzBuyer field in tblSales. In tblSales, IngzBuyer is the foreign key
because it is the key of a related “foreign” table.

An example would be William Gleason in the tblContacts table with the idsContactID
of 18. The one record in the Customer table with the idsContactID 18 is linked to two
records in the tblSales table — one record of a sale on February 27, 2003 with an
invoice number of 5and another for a sale on January 10, 2004 and invoice number
of 32. Thus, there is one record in the tblContacts table with 18 in the idsContactID
Field and two records in the tblSales table with IngzBuyer field having an 18 in it.

A relation also exists between the tblSales and tblSalesLineltems tables. The primary
key of idsInvoiceNumber in tblSales is related to the IngzinvoiceNumber field (part
of the complex primary key of tblSalesLineltems — comprises two fields) in the
tblSalesLineltems table. In the tblSalesLineltems table, IngzinvoiceNumber is the
foreign key because it is the key of a related foreign table.

‘\lote IngzinvoiceNumber is also the principal part of the complex primary key in the
-~ tblSalesLineltems table.

Understanding Relations between Tables

At the beginning of this chapter, you saw 11 tables in the Access Auto Auctions
database and 10 relationships. Before you learn to create these relationships, it is
important to understand them.
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A review of relationships

First, you can create relationships between tables at two places: in the Relationships
window that will relate them at a table level, and when you create queries to display
information from those tables (known as the query level).

Relationships established at the table level take precedence over those established
at the query level. If you specify a relationship between tables at the table level (in

the Relationships window), Access will recognize it automatically when you create

a multiple-table query that uses fields from more than one table.

When you create a query and no Relationships are set, Access will automatically
try to set relations between tables with similar field names.

s

With that said, it is now important to understand that there are four types of rela-
tionships that you can set between two tables:

4 One-to-one

4 One-to-many
4 Many-to-one
4+ Many-to-many

Understanding the four types of table relationships

When you physically join two tables (by connecting fields with like information),
you create a relationship that Access recognizes. Figure 4-3 shows the relationships
between all the tables in the Access Auto Auctions system.

Notice that there are three one-to-many relationships between the primary tables
(tblSales-to-tblSalesPayments, tblSales-to-tblSalesLineltems, and tblContacts-to-
tblContactsLog), two one-to-many relationship between the primary tables
(tblSalesLineltems-to-tbIProducts and tblSales-to-tblContacts), and five one-to-many
relations between the five lookup tables and the primary tables. The relationship
that you specify between tables is important. It tells Access how to find and display
information from fields in two or more tables. The program needs to know whether
to look for only one record in a table or look for several records on the basis of the
relationship. The tblSales table, for example, is related to the tblContacts table as

a many-to-one relationship. This is because the focus of the Access Auto Auctions
system is the Sales. This means that there will always be only one contact (buyer)
related to every Sales record; that is, many sales can be associated with a single
buyer (contact). In this case, the Access Auto Auctions system is actually using the
tblContacts table like a lookup type.

133


Robert
Highlight

Robert
Highlight


134

Part I, Section | + Working with Data Tables and Queries

5]

Figure 4-3: The Access Auto Auctions tables relationships.
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Relationships can be very confusing; it all depends upon the focus of the system.
For instance, when working with the tblContacts and tblSales tables, you can
always create a query that has a one-to-many relationship to the tbiSales table,
from the tblContacts. Although the system is concerned with sales (invoices), there
are times that you will want to produce reports or views that are buyer-related
instead of invoice-related. Because one buyer can have more than one sale, there
will always be one record in the tblContacts table for at least one record in the
tblSales table; there could be many related records in the tblSales table. So Access
knows to find only one record in the Customer table and to look for any in the
tblSales table (one or more) that have the same Customer Number.

The one-to-one relationship

The one-to-one relationship, though rarely used in database systems, can be a very
useful way to link two tables together.

A good example of a one-to-one relationship occurs in most billing systems; a billing

file is created to allow additional information necessary to invoice customers at a
location other than their listed addresses. This file usually contains the customer
number and another set of address fields.

Only a few customers would have a separate billing address, so you wouldn’t add
this information to the main customer table. A one-to-one relationship between a
customer table and billing table may be established to retrieve the billing address
for those customers who want to have a separate address for billing purposes and
one for catalogs or other uses. Although all the information on one table could be
added to the other, the tables are maintained separately for efficient use of space.
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The one-to-many relationship

The one-to-many relationship is used to relate one record in a table with many
records in another. Examples are one sale to many line items or one customer to
many customer contacts. Both of these examples are one-to-many relationships.
The tblSales-tblSalesLineltems relationship links the Invoice Number (the primary
key of the tblSales table) to the Invoice Number in the tblSalesLineltems table
(which becomes the foreign key of the tblSales table). There are only three one-to-
many relations in the Access Auto Auctions system related to tblSales, there are
five one-to-many relations in the entire system.

The many-to-one relationship

The many-to-one relationship (often called the lookup table relationship) tells Access
that many records in the table are related to a single record in another table.
Normally, many-to-one relationships are not based on a primary key field in either
table. Access Auto Auctions has seven lookup tables (five primary lookup tables
and two are primary tables of the system that are used as a “lookup” table — for
example tblContacts can be a lookup table to tblSales), each having a many-to-one
relationship with the primary table. The tblContacts table has a many-to-one rela-
tionship with the tblCustomerTypes table; each Customer Type record can be used
for many buyers (contacts). Although (in theory) some consider this relationship a
one-to-one, it is known as a many-to-one relationship because it does not use a pri-
mary key field for the link, and many records from the primary table link to a single
record in the other table.

Some one-to-many relationships can be reversed and made into many-to-one rela-
tionships. If you set a relationship from tblSales to tblContacts, for example, the
relationship becomes many-to-one; many Sales can have the same buyer (contact).
So relationships depend on how the information in your tables is used and inter-
preted. Thus, one-to-many and many-to-one relationships can be considered the
same — just viewed from opposite perspectives.

The many-to-many relationship

The many-to-many relationship is the hardest to understand. Think of it generally
as a pair of one-to-many relationships between two tables, with a special table cre-
ated (called a junction table) that is used to link them together. The junction table
is composed of a minimum of two fields — the foreign keys from both tables it is
linking together. These two fields are subsequently used to create the primary key
in the junction table. This junction table could easily be created in the case of the
tables, tblSales and tblSalesLineltems, in the Access Auto Auctions database by
simply creating another table in between that contains both the invoice number
and product number, making the primary key a combination of these two fields,
and separating the Sales and Lineltems with this new table.

For a true many-to-many relationship between these two tables, there has to be a
junction table that is composed of a complex primary key created by joining the
primary key from both tables in a single primary key in the junction table.
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Understanding Referential Integrity

In addition to specifying relationships between tables in an Access database, you
can also set up some rules that will help in maintaining a degree of accuracy, or
Referential Integrity, between the tables. For example, you would not want to delete
a contact (buyer or seller) record in your tblContacts table if there are related sales
records in the tblSales table. If you did delete a customer record without first delet-
ing the customer’s sales (or a seller without first deleting any items sold to you by
them), you would have a system that had sales without any buyers. This type of
problem could be catastrophic.

Imagine being in charge of a bank that tracks loans in a database system. Now imag-
ine that this system has no rules that say, “Before deleting a customer’s record, make
sure that there is no outstanding loan.” It would be disastrous! So a database system
needs to have rules that specify certain conditions between tables — rules to enforce
the integrity of information between the tables. These rules are known as referential
integrity; they keep the relationships between tables intact in a relational database
management system. Referential integrity prohibits you from changing your data in
ways that invalidate the links between tables.

Referential integrity operates strictly on the basis of the tables’ key fields; it checks
each time a key field, whether primary or foreign, is added, changed, or deleted. If
a change to a value in a key field creates an invalid relationship, it is said to violate
referential integrity. Tables can be set up so that referential integrity is enforced
automatically.

When tables are linked, one table is usually called the parent and the other (the table
it is linked to) is usually called the child. This is known as a parent-child relationship
between tables. Referential integrity guarantees that there will never be an orphan,
a child record without a parent record.

r Cross- If you connect to an SQL Server back end database or use the Microsoft Database
Rfefeipnce Engine and create an Access Data Project, the Relationships window is different.
|

This is discussed in Chapter 28.

Creating Relationships

Unless you have a reason for not wanting your relationships always to be active,
create your table relationships at the table level using the Relationships window.
The table relationships can be overridden later, in a query, if necessary. For normal
data entry and reporting purposes, however, having your relationships defined at
the table level makes it much easier to use your database system.

Access has a very powerful Relationships window. With it, you can add tables, use
drag-and-drop methods to link tables, easily specify the type of link, and set any ref-
erential integrity between tables.
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Using the Relationships window

You begin creating relationships in the Database window. From this window, you
can select ToolsRelationships or click the Relationships button on the toolbar
(usually the third button from the right side —three little squares, one on the left
and two on the right, with blue tops and lines from the left one to the other two).
The main Relationships window appears, which lets you add tables and create links
between them.

Figure 4-4 shows the Relationships window with the 11 tables that you will add
below and the Show Table window open to select those tables. Notice the toolbar
associated with it (the arrow is pointing to the three icons). It has three options
specific to the Relationships window — Show Direct Relationships, Show All
Relationships, and Clear Layout (center right of toolbar). When first opened, the
Relationships window is a blank surface. Tables are added to the window by using
one of these methods:

4 Add the tables before entering the Relationships window from the Show Table
dialog box that’s first displayed.

4 Click the Show Table button on the toolbar.
4 Click Relationships > Show Table from the menu bar.

4 While in the Relationships window, click the right mouse button (which
displays the shortcut menu) and select Show Table from the menu.

To start the Relationships window and add the Access Auto Auctions tables to the
Relationships window, follow these steps:

1. Click the Relationships button on the toolbar. Access opens the Show Table
dialog box.

2. Select all the tables (tblCategories, tblContactLog, tblContacts,
tblCustomerTypes, tbIPaymentType, tblProducts, tblSales, tblSalesLineltems,
tblSalesPayments, tblSalesperson, tlbTaxRates) by clicking tblCategories,
holding Shift, and clicking tblTaxRates. Then click Add.

3. Click the Close button on the Show Table dialog box. Your screen should look
similar to the one in Figure 4-4 (minus the Show Table window). Notice that
Access has placed each table in the Relationships window. Each table is in its
own box; the title of the box is the name of the table. Inside the table box are
the names of the fields for each table. Currently, there are no relationships, or
lines, between the tables. Now you are ready to set relationships between them.

If you select a table by mistake, it can be removed from the window by clicking in
it and pressing the Delete key.

You may want to move and resize each table window to see all the fields, as shown

% in Figure 4-5.
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Figure 4-5: The Relationships window with tables sized and repositioned, ready
to create the relationships between them.
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Creating relationships between tables

With the tables positioned similar to those in Figure 4-5 in the Relationships window,
you are ready to create relationships between the tables. To create a relationship
between two tables, select the common field in one table, drag it to the field in the
table you want to relate it to, and drop it on the common field.

Follow these steps to create a relationship between the tblSales and tblContacts
tables:

A ote
—

1. Click the inqzBuyer field of the tblSales table.

If you select and begin to move a field in error, simply move the field icon to the
window surface; it turns into the international No symbol. While it is displayed as
this symbol, release the mouse button and field linking stops.

. While holding down the mouse button, move the cursor to the tblContacts

table. Notice that Access displays a field-select icon (a small rectangular box
with lines inside of it) as you hold and drag the inqzBuyer field from the
tblSales table.

. Drag and drop the field-select icon to the idsContactID field of the tblContacts
table. Access displays the Edit Relationships dialog box, as shown in Figure 4-6.

. Click the Create button to create the relationship. Access closes the dialog

box and places a join line between the tblSales and tblContacts tables.

Fdit Relationships 7| Figure 4-6: The Edit Relationships dialog box
Table/Query Funted Table/Quary that is activated when you drag and drop the
J Cance inqzBuyer field from the tblSales table onto
Cacid ot °| ... || theidsContactiD field of the tblContacts table.

I Enforce Referental Integsty

Lelatonahip Tvoe Oreg-To-Bharry

Creacw Morw

/N ote
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You can edit the relationship for any join by double-clicking the join line between
the two tables. For example, double-clicking the join line between the tbiSales and
tblContacts tables reactivates the Edit Relationships dialog box for that link.
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Access automatically tries to determine the type of link between the two tables by

s looking at the data in the records of both tables and displays it at the bottom of

4 the Relationships dialog box. Figure 4-6 shows that the type of relationship

between the tblContacts and tbiSales tables is a one-to-many type (or a many-to-

one from the Sales to Contacts). However, it does not physically display the type of

link between the tables in the Relationships window unless Enforce Referential
Integrity is checked on.

Specifying relationship options in the
Edit Relationships dialog box

The Edit Relationships dialog box has several options for the relationship between
the Contacts and Sales tables. Figure 4-6 shows the dialog box and all the options.
The Edit Relationships dialog box tells you which table is the primary table for the
relationship (the one on the left side of the dialog box—in this case, tblContacts)
and whether referential integrity is enforced (a check box below the names of the
related fields on the left side). The dialog box also tells you the type of relationship
(one-to-one or one-to-many — at the bottom of the dialog box) and lets you specify
(after selecting Enforce Referential Integrity) whether cascading updates and deletes
(automatically fix key changes or deletions in related records) between related
tables are allowed.

For the following sections, activate the Edit Relationships dialog box for the link
- between the tblContacts and tblSales tables. To do so, double-click the join line
between the tables.

Checking the primary table

The top of the dialog box has two table names —tblContacts on the left and tblSales
on the right. The tblContacts table is considered the primary table for this relation-
ship (because its primary index is being used for it). The dialog box shows the
related fields for each table in a separate box immediately below the table names.
Make sure that the correct table name is in both boxes and that the correct field is
specified (idsContactID and indzBuyer).

Caution If you relate two tables incorrectly, simply click the Cancel button in the Edit

Tip

Relationships dialog box. Access closes the dialog box and erases the join line, and
you can begin again.

If you relate two tables by the wrong field, simply select the correct field for each
s, table by using the combo box under each table name.
s
Checking the Join Type between tables

The right side of the Edit Relations window has four buttons — OK, Cancel, Join
Type, and Create New ... buttons. Pressing the OK button returns you to the
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Relationships window with any changes specified. The Cancel button will cancel
the current changes and also return you to the Relationships window. The Create
New ... button will let you specify a new relation between two tables and fields.

The one button that you should also click after you first activate the Edit Relations
dialog box is Join Type. This button will activate another window — the Join
Properties dialog box. This dialog box lets you decide if you want to see records

in both tables, see all records in one table or the other, or see only those that are
related. For instance, to make sure that you have the correct join type between the
tblSales and tblContacts tables, follow these steps:

1. Click the Join Type button to activate the Join Properties Dialog box.

2. Click the option that says “Include ALL records from ‘tblSales’ and only those
records from ‘tblContacts’ where the joined fields are equal.” (the third option
on the authors system). The relationship between these tables should now
look like the one in Figure 4-7.

3. Click the OK button to return to the Edit Relationships Dialog box.

4. Click the OK button of the Edit Relationships dialog box to return to the
Relationships window.

Join Properties 70| Figure 4-7: A dialog box to set up the
1 Oy ekt sons b jwd feis Son ot wikswe | Join properties between the tbliSales and

2 e s s Bom miconscs oy sose e | thlContacts tables. Notice that it specifies
froem DS whive T jorned Aeia e eaual

T 3 Inchde AL record Som 'Sithler’ and only Shose reconds ALL records from the tblSales table.
from "DiContacty’ shive e Jenad falds e s

o Canl

You have now specified that the relationship is from the tblSales table to the
tblContacts table — meaning that many sales can be related to a single contact.

The Relationships window should now show an arrow going from the tblSales table
to the tblContacts table. At this point, you are ready to set Referential Integrity
between the two tables.

Each relationship will be different, depending upon the focus of the tables. You
should click on the Join Type button for each relationship to make sure that

2 you have specified the correct data relationship between tables.

Enforcing referential integrity

After specifying the relationship, verifying the table and related fields, and specify-
ing the type of join between the tables, you can set referential integrity between the
tables by clicking the Enforce Referential Integrity check box below the table infor-
mation. If you choose not to enforce referential integrity, you can add new records,
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change key fields, or delete related records without worrying about referential
integrity — thus making it possible to change critical fields without being warned or
prevented from doing so. With no integrity active, you can create tables that have
orphans (Sales without a Contact) or parents without children (Contact without
Sales). With normal operations (such as data entry or changing information), refer-
ential integrity rules should be enforced. By setting this option, you can specify
several additional options.

Re-open the Edit Relationships dialog box for the relations between the tblSales and
tblContacts tables by double-clicking on the join line.

Clicking the check box in front of the option Enforce Referential Integrity activates
the two Cascading choices (Update and Delete) in the dialog box and enforces
Referential Integrity. Figure 4-8 shows the Edit Relationships dialog box with
Referential Integrity activated.

Fdit Relationships 70| Figure 4-8: Referential Integrity set between
Table Quer Rebeted Table/Query the tbiSales and tblContacts tables.
. ,
caContactl _-lr-:,-:!!u. e - —
Jon Type |

W Endoroe Referensal integety Creats lerw ]
[ Comcade Uodate Related Fuids
™ Cancade Deiwte Aeisted Recerde

Lelatonahip Tvoe Oreg-To-Bharry

-Alote You might find, when you specify Enforce Referential Integrity and click the Create
=~ button (or the OK button if you've reopened the Edit Relationships window to edit
a relationship), that Access will not allow you to create a relationship and enforce
referential integrity. The reason probably is that you are asking Access to create a
relationship supporting referential integrity between two tables that have records
that violate referential integrity rules, such as a child table with orphans in it. In
such a case, Access warns you by displaying a dialog box similar to that shown in
Figure 4-9. The warning happens in this example because there are some records
in the tbiSales database with no value in the IngzSalespersonID field of the record
to correspond to a record in the tbiSalesperson table. This means that Access can-
not create referential integrity between this table and that you will have to go
through the table and add values that will allow a corresponding relation between
the two tables. Access returns you to the Relationships window after you click the
OK button; you will need to de-select the Enforce Referential Integrity check box if

it reports you cannot create it.
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Figure 4-9: A dialog box warning that referential integrity cannot
be created between two tables due to violations in some of the
records between the two tables — one or more tblSales without
a Salesperson ID is probably the problem.

Tip To solve any conflicts between existing tables, you can create a Find Unmatched
s query by using the Query Wizard to find the records in the many-side table (in the
4 case of the example in Figure 4-9, the tblSales table) that violate referential
integrity. Then you can convert the Unmatched query to a Delete query to delete
the offending records or add the appropriate value to the IngzSalespersonlD field.

You learn how to do this in Chapter 38.

Caution When selecting Enforce Referential Integrity, Access does not check to see if you
have Contacts without Sales. This is not an issue with referential integrity. You can
have multiple Contacts that have no Sales, known as widow records. However,
these records do not violate integrity; thus they are not checked for by Access.
Even with enforcement on, you can still create a parent record without children (a
Contact without any Sales). However, you can create a Find Unmatched query to
delete these records. This will be covered in Chapter 38.

You could remove the offending records and return to the Relationships window
and set referential integrity between the two tables. However, you should not do
this, because Salesperson is not a critical field that requires Referential Integrity
to be set between these tables.

Choosing the Cascade Update Related Fields option

If you specify Enforce Referential Integrity in the Edit Relationships dialog box,
Access activates a check box option labeled Cascade Update Related Fields. This
option tells Access that a user can change the contents of a related field (the pri-
mary key field in the primary table —idsContactID, for example).

When the user changes the contents of the primary key field in the primary table,
Access verifies that the change is to a unique value (because there cannot be dupli-
cate records in the primary table) and then goes through the related records in the
many table and changes the foreign key value from the old value to the new value.
Suppose you code your customers by the first two letters of their last names, and
one of your customers gets married and changes the name that Access knows to
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look for. If the Primary Key depended up a scheme dependent upon the last name
(like the first two letters of the last name), you could change the primary key, and
all changes would ripple through other related records in the system.

If this option is not selected, you cannot change the primary key value in the pri-
mary table that is used in a relationship with another table.

If the primary key field in the primary table is a related field between several
- tables, this option must be selected for all related tables or it will not work.

Choosing the Cascade Delete Related Records option

Similarly, if you specify Enforce Referential Integrity in the Edit Relationships dialog
box, Access activates the Cascade Delete Related Records check box. By selecting
this option, you tell Access that if a user attempts to delete a record in a primary
table that has child records, first it must delete all the related child records and
then delete the primary record.

This can be very useful for deleting a series of related records. For example, if you
have chosen Cascade Delete Related Records and you try to delete a particular cus-
tomer (who moved away from the area), Access first deletes all the related records
from the related tables —tblSales and tblSalesLineltems — and then deletes the cus-
tomer record. In other words, Access deletes all the records in the sales line items
for each sale for each customer —the detail items of the sales, the associated sales
records, and the customer record — with one step.

If you do not specify this option, Access will not enable you to delete a record that
has related records in another table. In cases like this, you must delete all related
records in the tblSalesLineltems table first, then delete related records in the
tblSales table, and finally delete the customer record in the tblContact table.

Tip To use this option, you must specify Cascade Delete Related Records for all of the
_», table’s relationships in the database. If you do not specify this option for all the

4 tables in the chain of related tables, Access will not allow cascade deleting.
Caution Use this option with caution! Access does not warn that it is going to do a cascade

delete when you build a Delete query. The program just does it. Later you may
wonder where all your records went. However, if you delete a record in a form that
has a subform with related records in it, Access will display a message saying it will
delete “this record and all its related records.”

Finishing the relationships between the tables

of the Access Auto Auctions system

With the first relationship created for the system; between the tblSales and
tblContacts, you can quickly create the remaining relations. Table 4-3 shows the
table relationships (how each table relates or is linked to another), which fields are
used to build the link, and the type of join line used between the tables.
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Table 4-3
Table Relationships

From Table To Table Enforce Ref.

(field) (field) Integrity Type of Join Line
tblContacts tblSales YES Include ALL records from
idsContactID IngzBuyer tbiSales and only those

records from tblContacts
where the join fields are
equal
tbiSales tblSalesLineltems YES Include ALL records from
idsInvoiceNumber IngzinvoiceNumber tbiSales and only
those records from
tbiSaleslineltems where
the join fields are equal
tbiSales tblSalesPayments YES Include ALL records from
idsIinvoiceNumber IngzlnvoiceNumber tbiSales and only
those records from
tblSalesPayments where
the join fields are equal
tbiSales tblSalesperson NO Include ALL records from
IngzSalespersonID idsSalespersonID tbiSales and only those
records from
tbiSalesperson where the
join fields are equal
tbiSales tblTaxRate NO Include ALL records from
chrTaxLocation chrTaxLocation tbiSales and only those
records from tblTaxRates
where the join fields are
equal
tbiSalesLineltems tblProducts YES Include ALL records from
chrProductiD chrProductiD tbiSalesLineltems and only
those records from
tblProducts where the
join fields are equal
tblProducts tblCategories NO Include ALL records from
chrCategory chrCategory tblProducts and only those

records from tblCategories
where the join fields are
equal

Continued
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Table 4-3 (continued)

From Table To Table Enforce Ref.
(field) (field) Integrity Type of Join Line
tblContacts tblContactLog YES Include ALL records from

idsContactID IngzContactID tblContacts and only those
records from tblContactLog

where the join fields are

equal
TbContacts tblCustomerTypes NO Include ALL records from
chrCustomerType chrCustomerType tblContacts and only
those records from
tblCustomerTypes where
the join fields are equal
tblSalesPayments tblPaymentType NO Include ALL records from
chrPaymentType chrPaymentType tblSalesPayments and only

those records from
tbIPaymentType where the
join fields are equal

After you have created all your relations, the final relationships window should look
like the one shown in Figure 4-10. Notice that Access only shows the type of rela-
tionships (one-to-many or many-to-one) where you set Enforce Referential Integrity
to YES. It also shows arrows between tables showing which table has precedence
(which table will include ALL records). The table without the arrow pointing to it
will include ALL records; the one with the arrow pointing to it will include only
those records that match the other table.

Saving the relationships between tables

The easiest way to save the relationships you created between the tables is to click
the Save button on the toolbar and then close the window. Another method is to
close the window and answer Yes to the Save Relationships dialog box that appears.

Adding another relationship

After you specify all the tables, the fields, and their referential integrity status, you
can add tables to the Relationships window by clicking the Relationships button on
the toolbar and adding new tables.

Again, if there is data in a new table that violates referential integrity between it and
arelated table, you must fix the offending table by removing the records before you
can set referential integrity between the tables.
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Figure 4-10: The final relationships created, showing the type of relations and
demonstrating which tables have precedence.

Deleting an existing relationship

To delete an existing relationship, open the Relationships window, right-click the
join line you want to delete, and select Delete from the Menu. Like in previous
versions of Access, you could simply press the Delete key and answer Yes to the
question Are you sure you want to delete the selected relationship?

Join lines in the Relationships window

When you create a relationship between two tables, Access automatically creates a
thin join line from one table to another. Figure 4-10 shows a simple join line between
several tables; for example, between tblSales and tblSalesperson or tblTaxRates,
tblContacts and tblCustomerTypes, and on and on.

If you specify that you want to enforce referential integrity, however, Access changes
the appearance of the join line. The join lines between tblSales and tblContacts or
tblSalesLineltems and tblSalesPayments are examples where the join line changes.
It becomes thicker at each end (alongside the table). It also has either a 1 or the
infinity symbol (o) over the thick bar of the line (on each side of the join line).

Printing a report of the relationships

When you have defined the relationships for your tables, you can create a graphical
report of the relationships of the tables by selecting File => Print Relationships from
the Access menu while the Relationships window is open.
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Using Subdatasheets

AI ote

With your relationships set, you can revisit the table design and set up a sub-
datasheet to view for the tables you have created one-to-may relationships between.
Because some of the tables may have more than one relationship, this is a good idea.

Sometimes when viewing information in datasheets, you want to see a table’s
related records that are in a different table.

Access 2003 has the capability to view hierarchical data in the Datasheet view. You

=~ can set up the sub-datasheets manually in the design of the table or you can have
the database automatically determine them based on the relationships between
tables. The sub-datasheets can be viewed with a table, query, form, and subform
datasheets.

You will know that a relationship with another table has been set up when you view
records in a datasheet, because a new column will be added to the left-hand side of
the datasheet with a + next to each row, as shown in Figure 4-11.
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Figure 4-11: Displaying a datasheet that has related tables. Notice the
plus sign field next to each Invoice Number (to the left). Clicking this
will expand a new datasheet (sub-datasheet) of related records in the
tlbSalesLineltems table.

When you click the + sign for a row, the related records in the sub-datasheet are
shown. The tables that are set up to be sub-datasheets may have sub-datasheets for
them, which allow the viewing of both related records for the main table that you
are in and related records for the sub-datasheet.
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Setting up sub-datasheets

You can set up sub-datasheets in the design view of a table by clicking View =
Properties from the Access menu bar, or by clicking the Properties button on your
toolbar. This displays the Table Properties dialog box as shown in Figure 4-12.
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Figure 4-12: Table Properties.

Selecting a sub-datasheet name

If you are moving directly from Access 97 to Access 2003, you will notice that five new
properties have been added to the Table Properties dialog box. All of these proper-
ties are related to sub-datasheets. Also notice the value entered for Subdatasheet
Name — [Auto]. [Auto] automatically assigns the sub-datasheet name based on
relationships set up in the database. To display a list of Tables and Queries in the

database, click anywhere in the Subdatasheet Name field and a combo box displays,
as shown in Figure 4-13.

(& Table Properties 0| Figure 4-13: Displaying Table and
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Entering the Link Child Fields and the Link Master Fields

The Link Child Fields and Link Master Fields property settings (immediately below
the Subdatasheet Name property) must have the same number of fields and must
represent data of the same type. For example, in this case, the tblSales (Master)
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table and the tblSalesLineltems (Child) table have different field names (one each)
that contain the same type of data, Access will automatically pull the correct field
name into these properties from the Relationship builder that you just created —
IngzInvoiceNumber for Link Child Fields and idsInvoiceNumber for Link Master
Fields. The subform will automatically display all the tblSalesLineltems found for
each record identified in the main table’s (tblSales) Invoice Number field.

Although the data must match, the names of the fields can differ, as in the example
above.

If you change the name of either or both fields in the tables (which we don’t recom-
mend), you will have to enter these field names into the correct property.

Without the link fields entered, no records will be displayed when you try to display
your sub-datasheet for the tblSales table because Access doesn’t know what fields
to automatically link (they would have to be the same name).

Caution If you have not set the link between tables and you have created your relationship
diagram, Access 2003 may still display the plus sign. If you click on the plus sign
in datasheet mode, Access will display an Insert Subdatasheet dialog box like
the one in Figure 4-14. Simply select the table you want to link (such as
tbiSalesLineltem), and Access will associate the correct property value in the sheet
for you.

sk Chilg By -
sk Mgnser Figice ~

Figure 4-14: The Insert Subdatasheet
dialog box.

Entering a Subdatasheet Height

The property for the Subdatasheet Height has a default value of 0 inches. This will
show you the related records in a sheet that is up to 2 inches high. If the records
don’t fit in this space, scroll bars permit a view of all the records.
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To change the height to a smaller or larger number, type in your preferred height in
inches.

Expanding the Subdatasheet

The Subdatasheet Expanded field is a Yes/No field. If you have Yes entered in this
field, the sub-datasheets are expanded, as shown in Figure 4-15.
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Figure 4-15: Viewing data in a datasheet with the Subdatasheet Expanded
option set to Yes in the Table Properties from the Table Design window.
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In this chapter, you learn what a query is and you learn
about the process of creating queries. Using the Sales
(tblSales), Contacts (tblContacts), Sales Line Items
(tblSalesLineltems), and Products (tbIProducts) tables, you
create several types of queries for the Access Auto Auctions
database.

This chapter will use the database named CHAPO5Start.
mdb. If you have not already copied it onto your machine
from the CD, you will need to do so now. After you have
completed this chapter, your database should resemble
the one in CHAPO5End.mdb.

Understanding Queries

A database’s primary purpose is to store and extract informa-
tion. Information can be obtained from a database immediately
after you enter the data or years later. Of course, obtaining

information requires knowledge of how the database is set up.

For example, reports may be filed manually in a cabinet,
arranged first by order of year and then by a sequence number
that indicates when the report was written. To obtain a spe-
cific report, you must know its year and sequence number. In
a good manual system, you may have a cross-reference book
to help you find a specific report. This book may have all
reports categorized alphabetically by type of report (rather
than topic). Such a book can be helpful, but if you know only
the report’s topic and approximate date, you still may have to
search through all sections of the book to find out where to
obtain the report.

CHAPTER

v+
In This Chapter
Understanding

the different types

of queries

Creating queries

Selecting tables and
fields for queries

Displaying
information in queries

Sorting information
in queries

Selecting specific
records in queries

Printing the results
of queries

Adding more than
one table to a query

Working around
query limitations

Understanding
types of joins

Changing the
type of join

Creating an inner
join and an outer join
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Unlike manual databases, computer-automated databases can easily obtain infor-
mation to meet virtually any criteria you specify.

This is the real power of a database —the capacity to examine the data any way
you want to look at it. Queries, by definition, ask questions about the data stored
in the database. After you create a query, you can use its data for reports, forms,
and graphs.

What is a query?

The word query is from the Latin word qucerere, which means to ask or inquire. Over
the years, the word guery has become synonymous with quiz, challenge, inquire, or
question. Therefore, you can think of a query as a question or inquiry posed to the
database about information found in its tables.

A Microsoft Access query is a question that you ask about the information stored

in your Access tables. The way you ask questions about this information is by using
the query tools. Your query can be a simple question about information stored in

a single table, or it can be a complex question about information stored in several
tables. After you ask the question, Microsoft Access returns only the information
you requested.

Using queries this way, you can ask the Access Auto Auctions database to show
you only the trucks that were sold in the year 2003. To see the types of trucks sold
for the year 2003, you need to retrieve information from three tables — tblSales,
tblSalesLineltems, and tblProducts tables. Figure 5-1 is a typical Query Design
window. Although it may look complex, it is actually very simple and easy to
understand.

After you create and run a query, Microsoft Access will retrieve and display the

set of records you asked for in a datasheet. This set of records is called a dynaset,
which is the set of records selected by a query. As you've seen, a datasheet looks
just like a spreadsheet, with its rows of records and columns of fields. The datasheet
(of the dynaset) can display many records simultaneously.

You can easily query information from a single table using the Search and Filter
capabilities of the datasheet view of a table (Filter by Selection and Filter by Form,
as you did in Chapter 3). Using a query, you can view information from one table,
or you can create a query and view common information from two or more tables
at the same time (as in Figure 5-1). Many database queries will require information
from several tables.

If you click the Datasheet View button on the toolbar, you will see that the query
shows six records that match the query that was designed in Figure 5-1. This is a
relatively easy query to design when you understand how the query design tool
works. This query design has many of the elements present that show the power of
the Access query engine — sorting a resulting dynaset, specifying multi-field crite-
ria, and even using a complex Or condition in one of those fields.
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Figure 5-1: A typical three-table select query. This query will
display the sales date, number of trucks, and type of truck for
all trucks sold in the year 2003.

Access will let you build very complex queries using these same tools. Suppose, for
example, that you want to send a notice to all previous buyers of more than one car
in the past year that 11 new cars are up for auction. This type of query requires get-
ting information from four tables: Contacts, Sales, Sales Line Items, and Products —
although the main information you are looking for is in Contacts and Products.

/\Iote In this case, you want Access to show you a datasheet of all Contact names and
~~  addresses where they have met your specified criteria (two or more cars pur-
chased in 2003). Access can retrieve customer names and cities from the Contacts
table and then obtain the number of cars from the Products table and the year of
sale from the Sales table. Figure 5-2 shows this complex query. Access then takes
the information that's common to your criteria, combines it, and displays all the
information in a single datasheet. This datasheet is the result of a query that draws
from the tblContacts, tblSales, tblSalesLineltems, and tblProducts tables. The
database query performed the work of assembling all the information for you.
Figure 5-3 shows the resulting datasheet.

(B Guery' - Select Guery 2ou

Figure 5-2: A complex query of customers that purchased more than one
car in the year 2003.
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Figure 5-3: The resulting datasheet of customers that purchased more than
one car in the year 2003.

« Cross- As you learned in Chapter 3, you can use filters and filter by form to manipulate a
Reference’)  single table. So, in this chapter, you will work with several tables —the tblContacts,

tblSales, tbiSalesLineltem, and tblProducts tables.

Types of queries

Access supports many different types of queries. They can be grouped into six
basic categories:

4 Select. These are the most common types of query. As its name implies, the
select query selects information from one or more tables (based on specific
criteria), creating a dynaset and displaying this information in a datasheet
that you can use to view and analyze specific data; you can make changes
to your data in the underlying tables.

4+ Total. These are special versions of select queries. Total queries provide the
capability to sum or produce totals (such as count) in a select query. When

you select this type of query, Access adds a Total row in the QBE (Query by
Example) pane.

4 Action. These queries enable you to create new tables (Make Tables) or
change data (delete, update, and append) in existing tables. When you make
changes to records in a select query, the changes must be made one record
at a time. In action queries, changes can be made to many records during a
single operation.

4+ Crosstab. These queries can display summary data in cross-tabular form like
a spreadsheet, with the row and column headings based on fields in the table.
By definition, the individual cells of the resultant dynaset are tabular — that
is, computed or calculated.

4 SQL. There are three SQL (Structured Query Language) query types — Union,
Pass-Through, and Data Definition—which are used for advanced SQL database
manipulation (for example, working with client/server SQL databases). You can
create these queries only by writing specific SQL commands.
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4+ Top(n). You can use this query limiter only in conjunction with the other five
types of queries. It enables you to specify a number or percentage of the top
records you want to see in any type of query.

Query capabilities

Queries are flexible. They provide the capability of looking at your data in virtually
any way you can think of. Most database systems are continually evolving, develop-
ing more powerful and necessary tools. The original purpose they are designed for
changes over time. You may decide that you want to look at the information stored
in the database in a different way. Because information is stored in a database, you
should be able to look at it in this new way. Looking at data in a way that’s different
from its intended manner is known as performing ad hoc queries. Querying tools
are among the most powerful and flexible features of your Access database. Here

is a sampling of what you can do:

4 Choose tables. You can obtain information from a single table or from many
tables that are related by some common data. Suppose you're interested in
seeing the customer name along with the items purchased by each customer
(from the tblContacts where type is a buyer or both). When using several
tables, Access returns the data in a combined single datasheet.

4 Choose fields. You can specify which fields from each table you want to see in
the resultant dynaset. For example, you can look at the customer name, cus-
tomer ZIP code, Sales date, and Invoice Number separated from all the other
fields in the tblContacts or tblSales table.

4+ Choose records. You can select the records to display in the dynaset by speci-
fying criteria. For example, you may want to see records for Sellers only in the
tblContacts.

4 Sort records. You may want to see the dynaset information sorted in a specific
order. You may need, for example, to see customers in order by last name and
first name.

4+ Perform calculations. You can use queries to perform calculations on your
data. You may be interested in performing such calculations as averaging,
totaling, or simply counting the fields.

4 Create tables. You may need another database table formed from the com-
bined data resulting from a query. The query can create this new table based
on the dynaset.

4 Create forms and reports based on a query. The dynaset you create from
a query may have just the right fields and data that you need for a report or
form. When you base your form or report on a query, every time you print the
report or open the form, your query will retrieve the most current information
from your tables.

157



158  Part], Section | ¢ Working with Data Tables and Queries

4+ Create graphs based on queries. You can create graphs from the data in a
query, which you can then use in a form or report.

4+ Use a query as a source of data for other queries (subquery). You can create
additional queries based on a set of records that you selected in a previous
query. This is very useful for performing ad hoc queries, where you may
repeatedly make small changes to the criteria. The secondary query can be
used to change the criteria while the primary query and its data remain intact.

4+ Make changes to tables. Access queries can obtain information from a wide
range of sources. You can ask questions about data stored in dBASE, Paradox,
Btrieve, and Microsoft SQL Server databases.

How dynasets work

Access takes the records that result from a query and displays them in a datasheet,
in which the actual records are called a dynaset. Physically, a dynaset looks like a
table; in fact, it is not a table. The dynaset is a dynamic (or virtual) set of records.
This dynamic set of records is not stored in the database.

Alote When you close a query, the query dynaset is gone; it no longer exists. Even though
~—  the dynaset itself no longer exists, the data that formed the dynaset remains stored
in the underlying tables.

When you run a query, Access places the resultant records in the dynaset. When
you save the query, the information is not saved; only the structure of the query is
saved —the tables, fields, sort order, record limitations, query type, and so forth.
Consider these benefits of not saving the dynaset to a physical table:

4 A smaller amount of space on a storage device (usually a hard disk) is needed.
4+ The query uses updated versions of any records changed since the query was

last run.

Every time the query is executed, it reads the underlying tables and re-creates
the dynaset. Because dynasets themselves are not stored, a query automatically
reflects any changes to the underlying tables made since the last time the query
was executed — even in a real-time, multi-user environment.

Creating a Query

After you create your tables and place data in them, you are ready to work with
queries. To begin a query, follow these steps:

1. From the Database window, click the Queries Objects button.

2. Click the New button, which is the third button from the left.
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The New Query dialog box appears, as shown in Figure 5-4. You select from
the five choices. The first choice displays the Query Design window.

3. Select Design View and click the OK button.

Figure 5-4: The New Query dialog box
is activated by clicking the New button
in the query container.

Figure 5-5 shows two windows. The underlying window is the Query Design window
(titled Queryl: Select Query). The accompanying Show Table dialog box is nonmodal,
which means that you must do something in the dialog box before continuing with
the query. Before you continue, you should add tables for the query to work with;
in this case, the tblProducts table is highlighted to be added.

b

Show Table

Titled | Quaries | Bots

Figure 5-5: The Show Table dialog box in the Query Design window.

Selecting a table

The Show Table dialog box shown in Figure 5-5 displays all tables and queries in
your database. You should see all the tables in the CHAP(05Start database. You can
add the tblProducts table to the query design with these steps:
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1. Select the tblProducts table from the Show Table dialog box.

2. Click the Add button to add the tblProducts table to the Query Design window.
Or you can double-click the table name instead of pressing the Add button.

3. Click the Close button.

Figure 5-6 shows the tblProducts table added to the query design surface, in the
upper pane of the window.

5]

Figure 5-6: The Query Design window with the tbIProducts
table in the upper pane and the bottom pane currently empty.
Notice that the bar between the two panes is dark: This is the
pane-resizing bar that has been clicked to activate it.

When starting a new query, you can alternatively click the New Object button on
the toolbar of the Database window (when the Query container is active) and

7 choose Query. If you have already selected and opened a table or query before you

start a new query, Access will assume you want to use the table or query already
opened and load the selected table or query automatically.

While in Query Design mode, you can activate the Show Table dialog box to add
more tables at any time; select Query > Show Table or click the Show Table button
(picture of table with plus sign).

You can also add tables by moving the mouse to any empty place in the top-half
_»  of the window (the Table/Query pane) and clicking the right mouse button to acti-
4 vate the shortcut menu. Then select Show Table.

When you want to delete a table from the Table/Query pane (top pane of the Query
Design window), click the table name in the query/table entry pane (the upper por-
tion of the window shown in Figure 5-6 — currently containing a single table, named
tblProducts) and either click Delete or select Query=> Remove Table.
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You also can add a table to the Query/Table Pane by selecting the Database win-
s, dow and dragging and dropping a table name from the Tables window into the

4 Query window.

Using the Query window

The Query window has two main views, the Design View and the Datasheet View.
The difference between them is self-explanatory: The Design View is where you
create the query, and the Datasheet View is where you display the query’s dynaset.

The Query Design window should now look like Figure 5-6, with the tblProducts
table displayed in the top half of the Query Design window.

The Query Design window is currently in the Design View; it consists of two panes:

4 The table/query entry pane
4 The Query by Example (QBE) design pane (also called the QBE grid)

The table/query entry pane, the upper pane, is where tables and/or queries and
their design structures are displayed. The visual representation of the table is a
small window inside the table/query entry pane. It shows the table name in the

title bar of this small window and displays all the fields in the listbox of the window.
This window can be resized by clicking on the edges and dragging it right or down
to make it wider or longer.

The Query by Example (QBE) pane, the lower pane, is used for holding the field
names that will be displayed and any criteria that will be used by the query. Each
column in the QBE design pane contains information about a single field from a
table or query in the upper pane.

Navigating the Query Design window

The title bar at the top of the Query Design window bears information about a par-
ticular window, the type of query, and the query name. Any new query is named
Queryl. Note that the title bar in Figure 5-6 displays the query type and name as
Queryl: Select Query.

The two windowpanes are separated horizontally by a pane-resizing bar. This bar, the
dark line between the panes in Figure 5-6, is used to resize the panes. To enlarge the
upper pane, click the bar and drag it down or drag the bar up to enlarge the lower
pane. When you move the mouse pointer over the pane-resizing bar, the pointer
turns into a small line with an arrow pointing up and another pointing down.

You switch between the upper and lower panes either by clicking the desired pane
or by pressing F6 to move to the other pane. Each pane has scrollbars to help you
move around.
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Tip

Tip

If you make the tbIProducts design structure longer, you can see more fields at one
5 time. If you make it wider, you can see more of a field’s name. To see more fields,

2 first make the top pane larger; then size the tbIProducts structure vertically.

You write the query by dragging fields from the upper pane to the lower pane of the
Query window.

After placing fields on the QBE pane (lower pane), you can set their display order
by dragging a field from its current position to a new position in the pane.

Using the Query Design toolbar

The toolbar in the Query Design window contains several buttons specific to build-
ing and working with queries, as shown in Figure 5-7.

FEFE 2ot ihz* 3> 25 8l
Figure 5-7: The default Query Design toolbar, with
21 buttons visible.

This toolbar has many buttons that can be helpful when designing your queries.
Although they will be used and explained as they are used in the query chapters of
this book, the primary buttons that will be used are listed below:

4+ View (first button). This button is used to switch between the Datasheet View
and Design View of the query. It also enables you to display the underlying
SQL statement that was created in the Query (more on this later).

4 Save (second button). This button is used to save the query as you are work-
ing on it. It is a good idea to save your work often, especially when creating
complex queries.

4 Query Type (twelfth button). The button with two datasheets overlapping
each other with a pull-down menu arrow is the Query type menu. It can be
found underneath the Window menu item on the menu bar. It is used to spec-
ify the type of query you want to create.

4 Run (thirteenth button, an exclamation point). This button is used to run a
query. When working with Select Queries, as in this chapter, it simply displays
the datasheet — serving the same function as the View button (first button).
However, when working with action queries that will be covered in later chap-
ters, it will actually run the series of actions specified by the user in the query.

4 Show Table (fourteenth button). This button will activate the Show Table dia-
log box and enable you to add additional tables to the query.
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The remaining buttons are used for more advanced queries, creating quick reports
and forms, showing the database window, printing the contents of the query, or
copy/paste actions.

Using the QBE pane of the Query Design window
As you saw earlier, Figure 5-6 displays an empty Query Design pane (QBE grid),
which has six named rows:

4 Field. This row is where field names are entered or added.

4+ Table. This row shows the table the field is from (useful in queries with multi-
ple tables).

4+ Sort. This row enables you to enter sort directives for the query.

4 Show. This check box determines whether to display the field in the resulting
dynaset.

4 Criteria. This row is where you enter the first line of criteria to limit the
record selection.

4 Or. This row is the first of a number of rows to which you can add multiple
values to be used in criteria selection.

You learn more about these rows as you create queries in this chapter.

Selecting Fields

There are several ways to add fields to a query. You can add fields one at a time,
select and add multiple fields, or select and add all fields. You can use your key-
board or mouse to add the fields.

Adding a single field

You can add a single field in several ways. One method is to double-click the field
name in the field list (also called a table window); the field name will immediately
appear in the first available column in the QEB pane. You can also add a field graph-
ically to the QEB pane by following these steps:

1. Highlight the field name in the table window located in the table/query entry
area—in this case, the chrDescription field.

2. Click the chrDescription field, and while holding the pointer down, drag the
Field icon, which appears as you move the mouse, toward the QBE Design pane.

3. Drop the Field icon in the desired column of the QBE Design pane.
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The Field icon looks like a small rectangle when it is inside the tblProducts table.
As the mouse is dragged outside the tblProducts table, the icon changes to a circle-
with-slash (the international symbol for “no”), which means that you cannot drop
the Field icon in that location. When this icon enters any column in the QBE column,
the field name appears in the Field: row.

If you drop the Field icon between two other fields, it appears between those fields

=~ and pushes all existing fields to the right.

If you select a field accidentally, you can de-select it by releasing the mouse button

s while the icon is the No symbol.
s
Another way to add fields to the QBE Design pane is to click an empty Field: cell in
the QBE Design pane and then type the field name in the field cell. Another method
is to select the field you want from the drop-down list that appears when you click
the down arrow button in the Field: cell of the QBE pane. Figure 5-8 shows selecting
the chrDescription field from the drop-down list. Once selected, simply move to the
next field cell and select your next field you wish to see in the query.

5]

Figure 5-8: Adding fields in the QBE Design pane (grid).
In the first column of the QBE pane, lower half, clicking the
down arrow reveals a drop-down list from which you can
select a field.

After you have selected your fields, you can run your query to see the results. To
run the query, click the Datasheet button on the toolbar (the first icon from the left).
When you are finished, click the Design button on the toolbar (the first one on the
left) to return to design mode. You can also run the query by clicking the Run icon
on your toolbar with the exclamation point on it, or by selecting Query=>Run. To
return to the design window, click the Design View button on your toolbar (the first
icon from the left).
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Adding multiple fields

You can add more than one field at a time by selecting the fields you want to place
in the query and then dragging and dropping the selection in the QBE pane. The
selected fields do not have to be contiguous (one after the other). Figure 5-9 illus-
trates the process of adding multiple fields. Notice that three of the fields are con-
tiguous and the fourth is further down in the table structure.

S]]
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Figure 5-9: Selecting several fields graphically to move to the
QBE Design pane. Notice that the field icon comprises three
fields, which tells you that you are adding more than one field
to the QBE pane.

To add multiple contiguous fields, follow these steps:
1. Remove any existing fields in the QBE pane by selecting Edit => Clear Grid from
the menu.

2. Highlight in the table/query entry area the first field name that you want to
add —in this case, chrDescription.

3. Hold the Shift key down and click the last field that you want to select —in
this case, intQtyInStock. (All the fields in between will be selected as well.)

4. Click the selected fields and drag the Multiple Field icon, which appears as
you move the mouse. The icon appears as a group of three field icons.

5. Drop the Multiple Field icon in the desired column of the QBE Design pane.
To add multiple noncontiguous fields to the query, follow these steps:

1. Remove any existing fields in the QBE pane by selecting Edit => Clear Grid from
the menu.

2. Highlight in the table/query entry area the first field name that you want to
add; for this example, click the chrDescription field.
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3. Hold the Ctrl key down and click each field that you want to select. (Only the
fields you select are highlighted.) For this example, click the chrCategory,
intQtyInStock, and curSalePrice fields.

4. Click the selected fields and drag the Multiple Field icon, which appears as
you move the mouse. The icon appears as a group of three field icons.

5. Drop the Multiple Field icon in the desired column of the QBE Design pane.

Notice that in the second example, you selected three fields that were contiguous —
using the non-contiguous method. You can select any field using the Ctrl key —
contiguous or non-contiguous — but you can select only one field at a time.

Adding all table fields

In addition to adding fields (either in groups or individually), you can move all the
fields to the QBE pane at once. Access gives you two methods for choosing all fields:
dragging all fields as a group or selecting the all-field reference tag—the asterisk (*).

Dragging all fields as a group

To select all the fields of a table, perform these steps:

1. Remove any existing fields in the QBE pane by selecting Edit => Clear Grid from
the menu.

2. Double-click the title bar of the table to select all the fields.
3. Point to any of the selected fields with the mouse.

4. Drag the Multiple Field icon to the QBE pane.

This method fills in each column of the QBE pane automatically. All the fields are
added to the QBE pane from left to right, based on their field order in the tbIProducts
table. By default, Access displays only the fields that can fit in the window. You can
change the column width of each field to display more or fewer columns.

Selecting the all-field reference tag

The first object (above the field names) in the tblProducts table is an asterisk, which
appears at the top of the field list. When you select all fields by using the asterisk,
you don’t see the fields in the QBE Design pane; tbIProducts.* in the Field: row indi-
cates that all tbIProducts table fields are selected. (This example assumes that the
QBE Design pane is empty when you drag the asterisk from the tblProducts table to
the QBE Design pane.)

The asterisk places the fields in a single Field: cell. Dragging multiple fields with the
first technique added actual table field names to the Query Design window; each
field is in a separate Field: cell across the QBE pane. If you change the table design
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later, you must change the design of the query, too. By using the asterisk for select-
ing all fields, you won’t have to change the query later if you add, delete, or rename
fields in the underlying table or query. (Access automatically adds or removes
fields that change in the underlying table or query.)

To add the all-fields reference tag to the Query Design pane, follow these steps:

1. Remove any existing fields in the QBE pane by selecting Edit => Clear Grid from
the menu.

2. Click the asterisk (*) in the tblProducts table to select this field.

3. Click the selected field and drag the Field icon to the first cell in the QBE
Design pane.

The all-fields reference tag is in the QBE pane. This query displays the tbIProducts
fields.

Displaying the Dynaset

With the all fields reference tag (asterisks) selected, display the resultant dynaset
by selecting either View => Datasheet View or the Datasheet button on the toolbar.
The datasheet should look like the one shown in Figure 5-10. You can also display

the dynaset by clicking the exclamation point icon or selecting Query = Run from
your Access menu.
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Figure 5-10: The datasheet of the tbIProducts table with all
the fields selected for the query using the asterisks, or all-field
reference tag (*).
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Working with the datasheet

Access displays the dynaset (resulting view of records of the query) in a datasheet.
The techniques for navigating a query datasheet, as well as for changing its field
order and working with its columns and rows, are exactly the same as for the other
datasheets you worked with in Chapter 3.

Access enables you to sort and filter the results of a datasheet created by a query.
All data in Access is editable all the time.

Changing data in the query datasheet

The query datasheet offers you an easy and convenient way to change data quickly.
You can add and change data in the dynaset, and it will be saved to the underlying
tables.

When you’re adding or changing data in the datasheet, all the table properties
defined at the table level are in effect.

Returning to the query design
To return to the query design mode, select the Design View button on the toolbar
(the first button on the left).

Tip You can also toggle between the design and datasheet mode by selecting View =>
Datasheet View or Viewr> Design View from the Query menu.

Caution Clear the query grid by selecting Editr> Clear Grid. Next, add all the fields to the
query grid by double-clicking the tbIProducts data structure title bar and dragging
all the selected fields to the query grid.

Working with Fields

There are times when you want to work with the fields you've already selected —
rearranging their order, inserting a new field, or deleting an existing field. You may
even want to add a field to the QBE pane without showing it in the datasheet.

Selecting a field

Before you can move a field’s position, you must first select it. To select it, you will
work with the field selector row.
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The field selector row is the narrow gray row above the Field: row of each column.
This row is approximately half the size of the others; it’s important to identify this
row because this is where you select columns, either single or multiple columns.
Recall that each column represents a field. To select the chrCategory field, move
the mouse pointer until a small selection arrow (in this case, a dark downward
arrow) is visible in the selector row and then click the column. Figure 5-11 shows
the selection arrow above the chrCategory column just before it is selected.

5]

Figure 5-11: Selecting a column in the QBE pane. The pointer
changes to a down-pointing arrow when you move over

the selection row. After the arrow changes, you can click the
selection row and the entire column will be highlighted.

Tip You can select multiple contiguous fields by clicking the first field you wish to select
s, and then dragging across the field selector bars of the other fields.
s
Caution Extend mode will also enable you to chose more than one contiguous field in the

QBE pane. If extend mode (F8) is on, you must first move the cursor into the col-
umn of the field that you wish to select (by clicking in any field) This moves the
insertion point (I cursor) into the row whose column you want to select. If the
insertion point is in an adjacent column and you select a column, you will select
the adjacent column (containing the insertion point) as well. To deactivate extend
mode (EXT), press the Esc key. You can see that EXT mode is active by looking at
the bottom frame of Access —the letters EXT will be active on the right side of the
frame (about a quarter of the way in).
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Changing field order

After your fields are selected, you can move them. (Of course, you could delete all
the fields and conditions and start the query over — although this method can be
bothersome.) With the fields selected, you can move the fields on the QBE design
by simply dragging them, as you have learned to move columns in a datasheet.
Follow these steps to move a field:

1. Add several fields to the QBE pane.

2. Select the field you want to move (chrCategory) by clicking the field selector
above the field name. The column is highlighted — as the chrCategory field is
in Figure 5-12.

3. Click and hold the field selector again; the QBE Field icon, a small graphical
box, appears under the arrow.

4. While holding down the left mouse button, drag the column to its new posi-
tion (in this case, to the left of chrDescription).

5. Release the left mouse button to drop the field in its new position.
Figure 5-12 shows the chrCategory field highlighted (selected). As you move the

selector field to the left, the column separator between the fields chrProduct and
chrDescription changes (gets wider) to show you where chrCategory will go.

5]

Figure 5-12: Moving the chrCategory field to between
chrProduct and chrDescription. Notice the QBE field icon
below the arrow near the chrDescription column.

Resizing columns in design mode

The QBE pane generally shows about five or six field columns in the viewable area
of your screen —the remaining fields can be viewed by moving the horizontal scroll
bar along the bottom of the window.
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There are times that you may want to show more fields than those visible on the
screen. You can resize the width of the field columns to make them smaller (or larger
to show less) by moving the mouse pointer between the field selectors of the fields
you want to adjust. After you have moved it between the two field selectors, the
pointer turns into a thick vertical bar with arrows pointing to the left and right.
With the sizing pointer, you can drag left or right to adjust the width of the column.

Removing a field

You can remove a field from the QBE Design pane. Select the field or fields to be
deleted in the QBE Design pane, and then press Delete or select Edit => Delete. To
remove the curCost field from the QBE Design pane, follow these steps:

1. Select the curCost field (or any other field) by clicking the field selector above
the field name.
2. Press Delete.

If the field is not selected but the insertion point is in it, you can select Edit=>
Delete Columns. You can delete all the fields in the QBE Design pane in a single

s operation: Select Edit> Clear Grid from the Query Design window’s menu bar.

Inserting a field

You insert fields from the table/query entry pane in the QBE Design pane by select-
ing field(s) from the table/query entry pane and then dragging your selection to the
QBE Design pane. These steps insert the Customer Number field:

1. Select the curCost field from the field list in the table/query entry pane (top
pane).

2. Drag the field to the column where you want the field. If it is to go between
two columns, put it to the left side of the column you want it to go before.

3. Drop the field by releasing the left mouse button.

Dragging a field to the QBE Design pane inserts it where you drop the field. If you
drop it on another field, it is inserted before that field. Double-clicking the field in
the table/query entry pane appends the field to the Field: list in the QBE Design pane.

Changing the field display name

To make the query datasheet easier to read, you can rename the fields in your
query. The new names become the tag headings in the datasheet of the query. To
follow along with this example, create a query using the fields from the tbIProducts
as shown in Figure 5-12. To rename the field chrProductID to Product ID and
chrDescription to Description, follow these steps:

171
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1. Click to the left of the ‘c’ of chrProductID in the Field: row of the QBE Design pane.
2. Type Product ID and a colon (:) between the new name and the old field name.

3. Click to the left of the ‘c’ in chrDescription and type in Description:.

The heading now is Product ID:chrProductID and Description:chrDescription. When
the datasheet appears, you see Product ID and Description.

/\Iote Changing the datasheet caption changes only the name of the heading for that
~=" field in the datasheet. It does not change the field name in the underlying table.

Showing table names

Multiple tables can make it difficult to determine where a field has come. That’s
why the Table: row automatically shows where a field came from.

When you select a field for display in the QBE pane, the name of the source table is
shown in the row directly below the field name. If you want to hide this row, click
View ©> Table Names as shown in Figure 5-13. The row with the table names disap-
pears. To view the tables, follow the same procedure to turn it on. As Figure 5-13
shows, the table names are in the row immediately below the field name. Looking
closely at the QBE pane, you can see the field name chrLastName and chrFirstName
in the first row (Field:), and immediately below them is the name of the table
tblContacts; moving to the rightmost field in view, dtmSalesDate, has the table
tblSales in the Table: row.

| #] Microsaht Acc

Figure 5-13: View/Hide Table: Row. You can hide the Table: row by selecting
View = Table Names from the Access Menu.
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Showing a field

While performing queries, you may want to temporarily show only some of the
fields. Suppose, for example, you use the tblContacts table and select several fields
to display — chrContactType, chrLastName, chrFirstName, chrAddress, chrCity,
and chrState. Then you decide that you want to temporarily look at the same data,
less the chrContactType and chrAddress fields. You can start with a new query,
deleting all the fields in the QBE pane, or you can simply indicate which fields you
want to see in the datasheet by de-selecting the Show: box for the fields you do not
want to see.

When you select fields, Access automatically makes every field a displayed field.
Every Show: property is displayed with a check mark in the box.

To de-select a field’s Show: property, simply click the field’s Show: box, and the box
clears. As you see in Figure 5-14, two fields have their Show: box de-selected. To re-
select the field later, simply click the Show: box again.

RITTT

Figure 5-14: The Show: row is checked only for the fields
chrLastName, chrFirstName, chrCity, and chrState. The other
fields shown, chrContactType and chrAddress, have the Show:
check box unchecked.

Caution If you save a query that has an unused field (its Show: box is unchecked), Access
eliminates the field from the query pane.

Changing the Sort Order

When viewing a dynaset, you may want to display the data in a sorted order. You
may want to sort the dynaset to make it easier to analyze the data (for example,
to look at all the tblProducts in order by Category).

Sorting places the records in alphabetical or numeric order. The sort order can be
ascending (0 to 9 and A to Z) or descending (9 to 0 and Z to A). You can sort by a
single field or sort using several fields.

Just as Access has a Show: property row for fields, there is a Sort: property row for
fields in the QBE Design pane. In the following section, you learn to set this property.
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Specifying a sort
To sort the records in the datasheet of Figure 5-14 by chrLastName and then by
chrFirstName in ascending order, perform these steps:

1. Using the same query in Figure 5-14, click the Sort: cell for the chrLastName

field. An arrow appears in the cell.

2. Click the down arrow at the right of the cell.

3. Select Ascending from the list.

4. Click in the Sort: cell for the chrFirstName field.

5. Select Ascending from the list.
Figure 5-15 shows the QBE pane with the two fields chrLastName and chrFirstName
set to Ascending order. Notice that the chrFirstName field is still showing the sort

options available. Also notice that the word Ascending is being selected in the field’s
Sort: cell.

You cannot sort on a Memo or an OLE object field.

Figure 5-15: The chrLastName and chrFirstName fields have been
selected to sort by Ascending order (0 to 9, A to Z).

Caution If you sort on more than one field, the fields must be in order from left to right of

the sort order you want. That is, in the example of Figure 5-15, the Last Name field
must be to the left of the First Name field. Otherwise, Access will sort by first name
and then last name.

Access always sorts the leftmost sort field first —this is known as sort order prece-
dence. To make sure that Access understands how you want to sort your data, you
must arrange the fields in order from left to right according to sort-order precedence.
You can easily change the sort order by selecting a sort field and moving it relative
to another sort field. Access corrects the sort order automatically.

If you click on the datasheet button to display the results of the sort of two fields, you
will notice that the dynaset is arranged in order by two different fields. Figure 5-16
shows the multiple-field sort dynaset. The sort order is controlled by the order of
the fields in the QBE pane (from left to right); therefore, this dynaset is displayed in
order first by Last Name and then by First Name.
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Figure 5-16: Multiple-field sort criteria. The order of the fields
is critical. It will sort first by the left-most field and then sub-sort
by the next field to the right.

Displaying Only Selected Records

Tip

So far, you've been working with all the records of the Contacts and Products tables.
There are times when you may want to work only with selected records in these
tables. For example, you may want to look only at records where the value of
chrContactType is Buyer. Access makes it easy for you to specify a record’s criteria.

If you are following along with the examples, start a new query using the tbIProducts
s, table and select all the fields before continuing.

e

Understanding record criteria

Record criteria are simply some rule or rules that you supply for Access to follow.
These criteria tell Access which records you want to look at in the dynaset. A typical
criterion could be “all Sellers,” or “only those vehicles that are not Trucks,” or “cars
whose retail price is greater than $45,000.”

In other words, with record criteria, you create limiting filters to tell Access which
records to find and which to leave out of the dynaset.

You specify criteria starting in the Criteria: property row of the QBE pane. Here you
designate criteria with an expression. The expression can be simple example data
or can take the form of complex expressions using predefined functions.

As an example of a simple data criterion using the tblProducts table, you could type
“TRUCKS” in the Criteria: cell of chrCategory and the datasheet displays only records
for Trucks.
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Tip

Entering simple character criteria

Character-type criteria are entered into fields that accommodate the Text data type.
To use such criteria, type in an example of the data contained within the field. To
limit the record display in the tblProducts table to CARS, follow these steps:

1. Select the tblProducts and add these fields to the QBE Design pane —
chrDescription, chrCategory, and curCost.

2. Click the Criteria: cell in the chrCategory column in the QBE Design pane.

3. Type CARS in the cell.

4. Click the Datasheet button.
Only the cars are displayed —in this case, 26 records. Observe that you did not
enter an equal sign or place quotes around the sample text, yet Access added dou-
ble quotes around the value. Access, unlike many other applications, automatically
makes assumptions about what you want. This is an illustration of its flexibility. You
could enter the expression in any of these other ways:

4+ CARS

4+ = CARS

4+ “CARS”

4+ = “Cars”

Access is NOT case sensitive, so you can type any of the following for CARS and it
will only find cars — CaRs, CARS, cars, Cars, carS, or any other combination of upper-

4 case and lowercase.

In Figure 5-17, the expression “CARS” is entered under chrCategory; the double
quote marks were placed around the example “CARS” automatically by Access.

Figure 5-17 is an excellent example for demonstrating the options for various types
of simple character criteria. You could just as well type Not Cars in the criteria col-
umn, to say the opposite. In this instance, you would be asking to see all records for
vehicles that are not cars, adding only Not before the example text CARS.

Generally, when dealing with character data, you enter equalities, inequalities, or a
list of values that are acceptable.

With either of these examples, Cars or Not Cars, you entered a simple expression in
a Text-type field. Access took your example and interpreted it to show you all records
that equal the example data you placed in the Criteria: cell.
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Figure 5-17: Specifying character criteria. You can type an example
of the type of records you want to view. In this case, all CARS —
so you type CARS in the criteria field of the chrCategory field.

This capability is a powerful tool. Consider that you have only to supply an example
and Access not only interprets it but also uses it to create the query dynaset. This
is exactly what Query by Example means: You enter an example and let the database
build a query based on this data.

To erase the criteria in the cell, select the contents and press Delete, or select the
contents and select Edit => Delete from the Query Design window’s menu bar. You
can also select Edit = Undo Cell Edit to revert to the previous content (in this case,
a blank cell).

Entering other simple criteria

You can also specify criteria for Numeric, Date, and Yes/No fields. Simply enter the
example data in the criteria field.

It is also possible to add more than one criteria to a query. For example, suppose
that you want to look only at records from the tblContacts for Contacts who are both
Sellers and Buyers (BOTH type in field chrContactType) and where these contacts
have been customers since January 1, 2003 (where the value of dtmOrigCustDate
is greater or equal to January 1, 2003). This would require placing example data in
two different fields —the chrContactType field and the dtmOrigCustdate field. To
do this, it is critical that you place both examples on the same line (Criteria: row).
To create this query, follow these steps:

1. Create a new query starting with the tblContacts table.

2. Add the fields chrContactType, chrLastName, chrFirstName, chrState, and
dtmOrigCustDate to the QBE grid.

. Click the Criteria: cell in the chrContactType column in the QBE Design pane.

. Type BOTH in the cell.

. Click the Criteria: cell in the dtmOrigCustDate column in the QBE Design pane.
. Type >=01/01/03 in the cell.

. Click the Datasheet button.

N S G e W



178

Part I, Section | + Working with Data Tables and Queries

Figure 5-18 shows how the query should look.

RITTT

Figure 5-18: Specifying character and date criteria in the same query.

Access displays records of contacts that are both sellers and buyers that were
customers from January 01, 2003 —in this example, it will display 17 records.

- Cross- Multi-criteria queries are covered in depth in Chapter 6.
'1 Reference

Access also compares Date fields to a value by using comparison operators, such
as less than (<), greater than (>), equal to (=), or a combination thereof. Notice that
Access automatically adds pound-sign (#) delimiters around the date value. Access
recognizes these delimiters as differentiating a Date field from Text fields. It’s the
same as entering text data examples; however, you don’t have to enter the pound
signs. Access understands what you want (based on the type of data entered in the
field), and it converts the entry format for you.

Caution When adding comparison operators to a criteria and mixing greater than/less than

with equals, the greater than sign must precede the equals sign, or Access will
report an error.

r Cross- Operators and Precedence are covered more in Chapters 6 and 20.
'1 Reference

Printing a Query Dynaset

After you create your query, you can quickly print all the records in the dynaset.
Although you can’t specify a type of report, you can print a simple matrix-type
report (rows and columns) of the dynaset that your query created.

You do have some flexibility when printing a dynaset. If you know that the
datasheet is set up just as you want, you can specify some options as you follow
these steps:

1. Use the datasheet you just created for both sellers and buyers that have been
customers since 01/01/2003.

2. If you are not in the datasheet view, switch to the query datasheet mode by
clicking the Datasheet button on the toolbar.

3. Select File = Print from the Query Datasheet window’s menu bar.
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4. Specify the print options that you want in the Print dialog box.
5. Click the OK button in the Print dialog box.

Tip In Step 3 above, you could have also pressed the Print button on the toolbar to
_»  immediately create a report of the datasheet and send it to the default Windows
4 printer. If you print the datasheet this way, you will not have to do Steps 4 or 5.

Access now prints the dynaset for you if you have set up a default printer in
Microsoft Windows. Your dataset prints out in the font selected for display or in the
nearest equivalent your printer offers. The printout also reflects all layout options
in effect when you print the dataset. Hidden columns do not print; gridlines print
only if the Gridlines option is on. The printout does reflect the specified row height
and column width.

L]
Saving a Query
To save a query while working in design mode, follow this procedure:
1. Select File> Save from the Query Design window or click the Save button on
the toolbar.
2. If this is the first time you're saving the query, enter a new query name in the
Save As dialog box.

To save a query while working in datasheet mode, follow this procedure:

1. Select File = Save from the Datasheet File menu.

2. If this is the first time you're saving the query, enter a new query name in the
Save As dialog box.

Tip The F12 key is the Save As key in Access. You can press F12 to save your work and
» continue working on your query.
s

Both of these methods save the query and return you to the mode you were working
in. Occasionally, you will want to save and exit the query in a single operation. To do
this, select File=> Close from the query or the datasheet and answer Yes to the ques-
tion Save changes to Query ‘query name’? If this is your first time saving the query,

Access prompts you to supply a query name and asks whether you want to save the
query to the current database or to an external file or database.

You can leave the Query window at any time by any one of these ways:

4 Select Filew> Close from the Query menu.
4 Select Close from the Query window control box.

4 Press Ctrl+F4 while inside the Query window.
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All three of these methods activate an Access dialog box that asks, Save changes to
Query ‘Queryl’?

Adding More than One Table to a Query

Using a query to obtain information from a single table is common; often, however,
you need information from several related tables. For example, you may want to
obtain a contact’s (buyer’s) name and the type of vehicles the contact has pur-
chased. This requires use of four tables in a query.

There are four primary tables in the Example database —tblContacts, tblSales,
tblSalesLineltems, and tblProducts. All four of these tables would be needed in the
query to determine the type of vehicles each buyer purchased.

In Chapter 4, you learned about primary and foreign table keys and their importance
for linking two tables together. You learned how to create relationships between
two tables at the table level by using the Tools > Relationships command from the
Database window. Finally, you learned how referential integrity rules affect data in
tables.

After you create the tables for your database and decide how the tables are related
to one another, you are ready to begin creating multiple-table queries to obtain
information from several tables at the same time.

By adding more than one table to a query and then selecting fields from the tables
in the query, you can view information from your database just as though the infor-
mation from the several tables was in one table.

The first step in creating a multiple-table query is to open each table in the Query
window. The following steps show how to open the tblContacts, tblSales,
tblSalesLineitems, and tblProducts tables in a single query:

. Click the Queries object in the Database window.

. Click the New toolbar button to create a new query.

. Select Design View and click the OK button in the New Query dialog box.

=W N e

. Select the tblContacts table (in the Show Table dialog box) by double-clicking
the table name.

. Select the tblSales table by double-clicking the table name.
. Select the tblSalesLineltems table by double-clicking the table name.
. Select the tblProducts table by double-clicking the table name.

@ I & O

. Click the Close button in the Show Table dialog box.
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Alote You can also add each table by highlighting the table in the list separately and
-~ clicking Add.

Figure 5-19 shows the top pane of the Query Design window with the four tables
you just added. Because the relationships were set at table level, the join lines are
automatically added to the query.

Figure 5-19: The Query Design window with four tables added. Notice the join
lines are already present.

‘\Iote You can add more tables, at any time, by selecting Query > Show Table from the
~~ Query Design window or by clicking the Show Table button.

Working with the Table/Query Pane

As Figure 5-19 shows, a single line is present between tables, going from the primary
key field to the foreign key field, which signifies a connection between the tables.

lmeSS- These lines were pre-drawn because you already set the relationships between
| Reference )  ihe tables earlier in Chapter 4.

The join line

When Access displays each set of related tables, it places a line between the two
tables. This line is known as a join line. A join line is a graphical line that represents
the relationship between two tables. In this example, the join line goes from the
tblSales table to the tblContacts table to connect the two fields —idsContactID and
IngzBuyer. Join lines also run from tblSales to tblSalesLineitems and tlbSalesLineltems
to tblProducts, connecting these tables as well.

This line is created automatically because a relationship was set in the Relationship
builder. If Access already knows what the relationship is, it automatically creates
the line for you when the tables are added to a query. The relationship is displayed
as a join line between two tables.
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Tip

Tip

If Referential Integrity was set in the relationship between two tables, Access displays
a thick portion of the line right at the table window similar to the line in Figure 5-19.
The line starts heavy and becomes thin between tblSales and tblSalesLineltems
(heavy on both ends). This line variation tells you that Referential Integrity has
been set between the two tables in the Relationship Builder. If a one-to-many rela-
tionship exists, the many relationship is denoted by an infinity symbol (o).

To resize the pane, simply click on the pane resizing bar and drag it down to

-~ enlarge the upper pane. After the pane has been resized, you can move the tables

around to match those in Figure 5-2. Resizing the pane and moving tables are cov-
ered after this section.

If you have not specified a relationship between two tables and the following con-

_», ditions are true, Access 2003 automatically joins the tables:

1. Both tables have a field with the same name.

2. The field with the same name in both tables has the same data type (text,
numeric, and so on).

3. The field is a primary key field in one of the tables.

Access 2003 automatically attempts to join the tables if a relationship exists. It will
not attempt to set the referential integrity — only the join. However, you can turn

D this property off by de-selecting the default Enable Autoloin option from the

global Access options tabbed dialog box. To display this option, select Tools=>
Options, click the Tables/Queries tab in the options box, and de-select the Enable
Autoloin option (under the Query design section).

Resizing the Table/Query pane

When you place Field Lists on the Table/Query pane, they appear in a fixed size
with little spacing between tables. When you add a table to the top pane, it initially
shows five fields. If more fields are in the table, a scroll bar is added to the box
(right side). The table window may show only part of a long field name, the rest
being truncated by the window size. You can move the tables around the pane and
resize them to show more field names or more of the field name. The first step,
however, is to resize the pane itself. The Query Design window has two panes. The
top pane displays your Field Lists, whereas the bottom QBE (Query by Example)
pane below enables you to enter fields, sort orders, and define criteria. Often you
will want the top pane to be larger than the bottom pane so that you can see more
field names. The Query window’s title bar tells you that you are creating a Select
query (Queryl: Select Query). If you change the query to another type of query
(which you do in later chapters), the title bar changes to let you know what type
of query you are creating.



Al ote

Chapter 5 + Displaying Selected Data with Queries ] 83

You can resize the Table/Query pane by placing your mouse pointer on the thick
line between the two panes. This is the window split bar, also known as the pane-
resizing bar. The pointer changes to a small, thick bar with double vertical arrows
(up and down), as shown in Figure 5-20, which enables you to drag the split bar up
or down. To resize the panes, follow these steps:

1. Place the pointer on the window split bar.
2. Hold down the mouse button and drag the split bar down.

3. Release the bar when it is two lines below the QBE row “or.”

The top pane is now much larger; the bottom pane is smaller but it still displays the
entire QBE Design area. If the QBE Design area shows insufficient area, simply resize
the entire window by selecting the bottom border of the window and then click and
drag the window down — making it larger. You now have space to move the Field
Lists around and properly view the Table/Query pane.

You can build a database diagram, as you did in Chapter 4, so that you view only
the Field Lists by moving the split bar to the bottom of the screen and then posi-
tioning the Field Lists as you want within the full-screen area.

/

Figure 5-20: The Query Design window with the screen split arrow in the
center on the window split bar and tables resized.

Looking at Figure 5-20, you see that the Query Design window has been resized and
the pointer (changed to a line with arrows up and down) is on the window split bar.
The table field lists have also been resized.
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Manipulating the Field List window

Each Field List window begins at a fixed size, which shows approximately four
fields and 12 characters for each field. Figure 5-19 shows how the initial field lists
are displayed; Figure 5-20 shows them after they have been expanded. Each Field
List window is a true window and behaves like one; it can be resized and moved. If
you have more fields than will show in the Field List window, a scroll bar displays
to enable you to scroll through the fields in the Field List window.

After a relationship is created between tables, the join line remains between the

-~ two fields. As you move through a table selecting fields, the graphical line will move

relative to the linked fields. For example, if the scroll box moves down (toward the
bottom of the window) in the tblContacts table, the join line moves up with the
customer number, eventually stopping at the top of the table window.

When you’re working with many tables, these join lines can become visually con-
fusing as they cross or overlap. If you move through the table, the line eventually
becomes visible, and the field it is linked to becomes obvious.

Moving a table

You can move Field Lists in the Table/Query pane by placing the mouse pointer on
the title bar of a Field List (where the name of the table is) and dragging the table to
a new location. You may want to move the Field Lists for a better working view or to
clean up a confusing database diagram (like the one shown in Figure 5-20). To move
Field Lists, follow these steps:

1. Place the mouse pointer on the title bar of the table on the name of the Table.
2. Drag the table design (field list) to where you want to place it.

You can move the Field Lists anywhere in the top pane. You can spread them out by
moving the Field Lists farther apart. You can also rearrange the Field Lists.

Removing a table

There are times when you need to remove tables from a query. Any table can be
removed from the Query window. Follow these steps to delete the tblProducts
table; remember, you can bring it back later:

1. Select the table you want to remove in the top pane of the Query window by
clicking either the table or a field in the table.

2. Press the Delete key or select Edit > Delete.

Alote Only one table can be removed at a time from the Query window. The menu
2

choice Edit=> Clear Grid does not remove all tables; it removes all fields from the
QBE pane. You can also remove a table by right-clicking a table and selecting
Remove Table from the shortcut menu.
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When you delete a table, any join lines to that table are deleted as well. When you
delete a table, there is no warning or confirmation dialog box. The table is simply
removed from the screen.

Adding more tables

You may decide to add more tables to a query or you may accidentally delete a table
and need to add it back. You can accomplish this task by either selecting Query =
Show Table or by clicking the right mouse button and selecting Show Table from the
shortcut menu that appears. When you use either of these methods, the Show
Table dialog box that appeared when you created the query is redisplayed.

Resizing a Field List window

You can also resize each of the Field Lists by placing the cursor on one of the Field
List borders. The Field List is nothing but a window; thus, you can enlarge or reduce
it vertically, horizontally, or diagonally by placing the cursor on the appropriate
border. When you enlarge the Field List vertically, you can see more fields than the
default number (five). By making the Field List larger horizontally, you can see the
complete list of field names. Then, when you resize the Table/Query pane to take up
the entire window, you can create a database diagram.

Adding Fields from More than One Table

You add fields from more than one table to the query in exactly the same way as
when you’re working with a single table. You can add fields one at a time, many
fields grouped together, or all the fields from one or all tables.

g Cross- Adding fields from a single table was covered earlier in this chapter; this section
| Reference’)  ,vers the topic in less detail, but focuses on the differences between single- and

’ multiple-table field selection.

Adding a single field

You can add a single field from any table to the QBE pane by several methods:

4 Double-click a field name in the Table/Query pane.
4 Click a field name in the Table/Query pane and drag it to the QBE pane.
4 Click an empty Field cell in the QBE pane and type a field name.
4 Click an empty Field cell and select the field from the drop-down list.
Caution If you type a field name in an empty Field cell that has the same name in two or

more tables, Access enters the field name from the first table that it finds contain-
ing that field. Access searches the tables, starting from the left side in the top pane.
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If you select the field from the drop-down list in the Field cell, you see the name of
the table first, followed by a period and the field name. For example, the chrProductID
in the tblSalesLineltems table is displayed as tblSalesLineltems.chrProductID. This
helps you select the right field name. Using this method, you can select a common
field name from a specific table.

The easiest way to select fields is still to double-click the field names while in the
query/table design pane. To do so, you may have to resize the Field Lists to see the
fields that you want to select.

Viewing the table names

When you’re working with two or more tables, the field names in the QBE pane can
become confusing. You may find yourself asking, for example, just which table the
field chrDescription is from.

Access automatically maintains the table name that is associated with each field
displayed in the QBE pane. The default is to display the table name below the name
of the field. If you do not want to show the table name of each field in the QBE pane,
select View > Table Names and the toggle will be turned off (unchecked).

This command controls the display of table names immediately below the corre-
sponding field name in the QBE pane. Figure 5-21 shows the QBE pane with the Table
row below the Field row. It contains the name of the table for each field.

Jdreit

Figure 5-21: The QBE pane with table names displayed. Notice that it shows
all four table names.

After you add fields to a query, you can view your resultant data at any time. You
can view all the data now by selecting the Datasheet icon. Figure 5-22 displays the
data as currently selected. The fields have been resized to show all the data values.

The display of the table name is only for your information. Access always maintains
the table name associated with the field names.

Adding multiple fields at the same time

The process of adding multiple fields at the same time is identical to adding multi-
ple fields in a single table query. When you’re adding multiple fields from several
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tables, you must add them from one table at a time. The easiest way to do this is to
select multiple fields and drag them together down to the QBE pane.

Pece | Guastity| Descaption
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Figure 5-22: Datasheet view of data from multiple tables. This resulting dynaset,
from the query, contains 84 records.

You can select multiple contiguous fields by clicking the first field of the list and
then clicking the last field while holding down the Shift key (as you click the last
field that you want to add). You can also select non-contiguous fields in the list by
holding down the Ctrl key while clicking individual fields with the mouse.

Adding all table fields

To add all table fields at the same time, select which table’s fields you want to add,
and then select the fields to be added. You can select all the fields by either double-
clicking the title bar of the table name or by selecting the Asterisk (*) field. These
two methods, however, produce very different results.

Selecting all fields using the title bar method

One method of selecting all the fields is to double-click the title bar of the table
whose fields you want to select.

This method automatically selects all the fields (except the Asterisk). Once selected,
all the fields can be dragged to the QBE pane. The fields are added in the order of
their position in the table, from left to right (based on their field order in the table).
By default, Access displays only the first five full fields in the QBE pane (lower pane).
You can change the column width of each field to display more or fewer columns.
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Selecting all fields using the Asterisk (*) method

The first object in each table is an asterisk (at the top of the field list), which is
known as the all-field reference tag. When you select and drag the asterisk to the
QBE pane, all fields in the table are added to the QBE pane, but there is a distinct
difference between this method and the double-clicking method referred to previ-
ously: When you add the all-field reference tag (*), the QBE pane shows only one
cell with the name of the table and an asterisk. For example, if you select the * in
the tblProducts table, you see tblProducts. * displayed in one field row cell.

Unlike selecting all the fields, the asterisk places a reference to all the fields in a
single column. When you drag multiple columns, as in the preceding example, you
drag actual table field names to the query. If you later change the design of the table,
you also have to change the design of the query. The advantage of using the asterisk
for selecting all fields is that the query doesn’t need to be changed if you add, delete,
or rename fields in the underlying table or query. Changing fields in the underlying
table or query automatically adds fields to or removes fields from the query.

Caution Selecting the * does have one drawback: You cannot perform criteria conditions
on the asterisk column itself. You have to add an individual field from the table
and enter the criterion. If you add a field for a criterion (when using the *), the
query displays the field twice — once for the * field and a second time for the crite-
rion field. Therefore, you may want to de-select the Show cell of the criterion field.

Understanding the Limitations
of Multiple-Table Queries

When you create a query with multiple files, there are limitations to what fields can
be edited. Generally, you can change data in a query dynaset, and your changes are
saved to the underlying tables. A primary key field normally cannot be edited if ref-
erential integrity is in effect and if the field is part of a relationship (unless Cascade
Updates is set to Yes).

To update a table from a query, a value in a specific record in the query must repre-
sent a single record in the underlying table. This means that you cannot update
fields in a Crosstab or Totals query because they both group records together to
display grouped information. Instead of displaying the actual underlying table data,
they display records of data that are calculated and stored in a virtual (nonreal)
table called a snapshot.

Updating limitations
In Access, the records in your tables may not always be updateable. Table 5-1
shows when a field in a table is updateable. As Table 5-1 shows, queries based
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on one-to-many relationships are updateable in both tables (depending on how the
query was designed). Any query that creates a snapshot, however, is not updateable.

Table 5-1
Rules for Updating Queries

Type of Query or Field Updateable Comments

One Table Yes

One-to-One relationship Yes

Results contains Memo field Yes Memo field updateable

Results contain Hyperlink Yes Hyperlink updateable

Results contain an OLE object Yes OLE object updateable

One-to-Many relationship Mostly Restrictions based on design
methodology (see text)

Many-to-One-to-Many No Can update data in a form or data
access page if RecordType = Dynaset

Two or more tables with NO join line  No Must have a join to determine
updateability

Crosstab No Creates a snapshot of the data

Totals Query (Sum, Avg, etc.) No Works with Grouped data creating a
snapshot

Unique Value property is Yes No Shows unique records only in a
snapshot

SQL-specific queries No Union & Pass-through work with
ODBC data

Calculated field No Will recalculate automatically

Read-only fields No If opened read-only or on read-only
drive (CD-ROM)

Permissions denied No Insert, Replace, or Delete are not
granted

ODBC Tables with no Primary Key No A primary key (unique index) must
exist

Paradox Table with no Primary Key No A primary key file must exist

Locked by another user No Cannot be updated while a field is

locked by another

189
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Overcoming query limitations

Table 5-1 shows that there are times when queries and fields in tables are not update-
able. As a general rule, any query that does aggregate calculations or is an ODBC
(Open DataBase Connectivity)-based SQL (Structured Query Language) query (SQL-
specific query) is not updateable. All others can be updated. When your query has
more than one table and some of the tables have a one-to-many relationship, there
may be fields that are not updateable (depending on the design of the query).

Updating a unique index (primary key)

If a query uses two tables that have a one-to-many relationship, the one side of the
join must have a unique (primary key) index on the field that is used for the join. If
not, the fields from the one side of the query cannot be updated.

Replacing existing data in a query with a one-to-many relationship
Normally, all the fields in the many-side table are updateable in a one-to-many
query; the one-side table can update all the fields except the primary key (join)
field. Normally, this is sufficient for most database application purposes. Also, the
primary key field is rarely changed in the one-side table because it is the link to
the records in the joined tables.

At times, however, you may need to change the link-field contents in both tables
(make a new primary key in the one table and have the database program change
the link field in all the related records from the many table). Access enables you

to do this by defining a relationship between the two tables and using referential
integrity. If you define a relationship and enforce referential integrity in the
Relationship Builder, two selections are activated. If you want to enable changes
(updates) to the primary key field, check the Cascade Update Related Fields box.
By selecting this option, you can change the primary key field in a relationship;
Access automatically updates the link field to the new value in all the other related
tables.

r Cross- Chapter 4 covers the Relationship Builder in detail.
'] Reference

! . . . . . .

Design tips for updating fields in queries

4 If you want to add records to both tables of a one-to-many relationship,
include the join field from the many-side table and show the field in the
datasheet. After doing this, records can be added starting with either table.
The one side’s join field is copied automatically to the many side’s join field.

4 If you do not want any fields to be updateable, set the Allow Edits property of
the form to No.
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4 If you do not want to update some fields on a form, set the Tab Stop property
for the control (field) to No for these fields.

4 If you want to add records to multiple tables in a form (covered in later
chapters), remember to include all (or most) of the fields from both tables.
Otherwise, you will not have a complete record of data in your form.

Temporary inability to update in a one-to-many relationship

When updating records on the one side of a one-to-many query, you will not be able
to change the many-side join field until you save changes to the one side. You can
quickly save changes to the one side by pressing Shift+Enter or selecting File > Save
Record. After the one-side changes are saved, the join field in the many-side record
can be changed.

Creating and Working with Query Joins

You can create joins between tables in these three ways:

4+ By creating relationships between the tables when you design the database.
(Select Tools => Relationships from the Database window or click the
Relationships button on the toolbar.)

4 By selecting two tables for the query that have a field that has the same data
type and name in both tables and is a primary key field in one of the tables.

4 By creating joins in the Query window at the time you create a query.

The first two methods are automatic in the Query design window. If you create rela-
tionships when designing the tables of your database, Access displays join lines
based on those relationships automatically when you add the related tables to a
query. It also creates an automatic join between two tables that have a common field,
provided that field is a primary key in one of the tables and the Enable AutoJoin
choice is selected (default) in the Options dialog box.

If relationships are set in the relationship builder, there may be times when you add
a table to a query and it will not automatically be related to another table, as in
these examples:

4 The two tables have a common field, but it is not the same name.

4+ A table is not related and cannot be logically related to the other table (for
example, the tblContacts table cannot directly join the Treatments table).
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If you have two tables that are not automatically joined and you need to relate
them, you join them in the Query Design window. Joining tables in the Query Design
window does not create a permanent join between the tables. Rather, the join (rela-
tionship) will apply only to the tables for the query you are working on.

Caution All tables in a query should be joined to at least one other table. If, for example,
you place two tables in a query and do not join them, Access creates a query
based on a Cartesian product (also known as the cross product) of the two tables.
This subject is discussed later in this chapter. For now, note that a Cartesian prod-
uct means that if you have five records in table 1 and six records in table 2, the
resulting query will have 30 records (5 x 6) that will probably be useless.

Joining tables

Figures 5-19 and 5-20 show the joined tblSales and tblContacts tables. They're
joined automatically. Notice that there are join lines between the other tables also.

Alote Tables are not joined automatically in a query if they are not already joined at the
~~  table level, if they do not have a common named field for a primary key, or if the
Autoloin option is off.

At this point, add the tblContactLog table to the query. To accomplish this, right-
click and select Show Table ... from the menu, select tblContactLog, and close the
dialog box. Notice that there is no join line between the new table and any other
table in the query. It should be joined to the tblContacts table. To join the tblContacts
and tblContactLog tables, follow the steps below:

1. Select the idsContactID field in the tblContacts Table in the Table/Query pane.

2. Drag the highlighted field to the tblContactLog table (as you drag the field, the
Field icon appears).

3. Drop the Field icon on the IngzContactID field in the tblContactLog table (the
Field icon disappears and a join line appears connecting the two tables via the
fields specified).

Figure 5-23 shows the new join line between the two tables after it is created. When
you perform this action (joining one field to another), the Field icon disappears
immediately before the join line is displayed. As the Field icon moves between
tables, it changes to the symbol that indicates that the icon cannot be dropped in
the area between the tables. When it comes over the Field List of the tblContactLog,
it changes back to the Field icon, indicating that it can be dropped on any field in
that location. When you release the mouse button over the IngzContactID field of
the table, the join line appears.
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Figure 5-23: Joining tables in the Table/Query pane. Notice the join line is
created between the tblContacts and tblContactlog tables. The figure also
shows the Join Properties dialog box open to specify the type of join (which
is opened by double-clicking on the join line).

Specify the type of join

With the join specified between two tables, you may need to specify the type of join
you want — which records should show. The default action for creating a join in a
query is to show only those records where the join fields from both tables are equal.
Often this will not display all the records you need to see in the query datasheet. For
instance, in this chapter, there is no relationship defined between the tblContacts
and tblContactLog tables at the table level (relationship builder). As Figure 5-23
shows, the default join line between these tables has no arrow at either end of the
join line, nor does it show the type of relationship between the tables (one-to-many,
one-to-one, or many-to-one). The default join line between two tables is one where
it will only include records where the join fields from both tables are equal. You can
see this as choice one in Figure 5-23. Because tblContactLog will not have records
for all records in tblContacts, you will need to change the type of link between the
tables to include ALL records in tblContacts and only those from tblContactLog
where the field value is equal. To activate the Join Properties dialog box and change
the join type, follow the steps below:

1. Select the join line between the tblContacts and tblContactLog tables.

2. Double-click on the join line (or right-click and select Join Properties from the
menu; alternately select View=> Join Properties from the menu). The Join
Property dialog box appears (as shown in Figure 5-23).
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3. Select “Include ALL records from ‘tblContacts’ and only those records from
‘tblContactLog’ where the joined fields are equal.”

4. Click the OK button to create the join.

Now the query should show a join line pointing from the tblContacts table to the
tblContactLog table.

Caution If you fail to create this type of join, leaving it to include records where both tables

have equal values in their fields, and attempt to run the query, Access will report
an error, as shown in Figure 5-24. This warning says that you have an ambiguous
outer join between tables and suggests a fix. The error is reported because the
field idsContactID in tblContacts is used to join with two tables. Thus you need to
specify the specific type of join between the tables. The easiest way is to simply
include all records from tblContacts in the join.
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Figure 5-24: Running a query with an improper join type.

Of course, you can also create joins that make no sense, but when you view the
data, you will get less-than-desirable results. If two joined fields have no values in
common, you will have a datasheet in which no records are selected.

Caution If you fail to create a join line between tables, the resulting dynaset, viewed in the

A ote

datasheet, will be a Cartesian product in which each and every record is joined
with each and every record in the second table. If one table has 100 records and
the other has 200 records, the Cartesian join will create a table with 20,000 records
and the results will make no sense.

You can select either table first when you create a join.
3

You would never want to create a meaningless join. For example, you would not
want to join the chrCity field from the tblContact table to the tbmSalesDate of the
tblSales table. Although Access will enable you to create this join, the resulting
dynaset will have no records in it.

Deleting joins

To delete a join line between two tables, you select the join line and press the Delete
key. You can select the join line by placing the mouse pointer on any part of the line
and clicking once.
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Caution If you delete a join between two tables and the tables remain in the Query win-
dow unjoined to any other tables, the solution will have unexpected results
because of the Cartesian product that Access creates from the two tables. The
Cartesian product is effective for only this query. The underlying relationship
remains intact.

‘\lote Access enables you to create multiple-field joins between tables (more than one
-~ line can be drawn). The join must be between two fields that have the same data
and data type; if not, the query will not find any records from the datasheet to

display.

Understanding Types of Table Joins

In Chapter 4, you learned about table relationships and relating two tables by a
common field. Access understands all types of table and query relations, including
these:

4 One-to-one

4 One-to-many

4 Many-to-one

4 Many-to-many

When you specify a relationship between two tables, you establish rules for the
type of relationship, not for viewing the data based on the relationship.

To view data in two tables, they must be joined through a link that is established via
a common field (or group of fields) between the two tables. The method of linking
the tables is known as joining. In a query, tables with established relationships are
shown already joined. Within a query, you can create new joins or change existing
joins; just as there are different types of relationships, there are different types of
joins. In the following sections, you learn about these types of joins:

4+ Equi-joins (inner joins)
4 Outer joins

4 Self-joins

4 Cross-product joins (Cartesian joins)

Inner joins (Equi-joins)
The default join in Access is known as an inner join or equi-join. It tells Access to

select all records from both tables that have the same value in the fields that are
joined.
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The Access manuals refer to the default join as both an equi-join and inner join
(commonly referred to as an inner join in database relational theory). The Access
Help system refers to it as an inner join. The terms equi-join and inner join are
interchangeable; however, in the remainder of this chapter they shall be referred
to as inner joins.

—

If records are found in either table that do not have matching records in the other
table, they are excluded from the resultant dynaset and will not be shown in the
datasheet. Thus, an inner join between tables is simply a join where records are
selected when matching values exist in the joined field of both tables.

You can create an inner join between the tblContacts and tblSales tables by bringing
these two tables into a new query and clicking on the join line to activate the Join
Property dialog box and select the first choice— “Only include rows where the
joined fields from both tables are equal.” Remember that you are looking for all
records from these two tables with matching fields. The idsContactID field and
IngzBuyer contain the common field values, so the inner join will not show any
records for Contacts that have no Sales or any Sales that do not relate to a valid
ContactID number. The rules of referential integrity prevent Sales records that are
not tied to a Contact number from being saved. Of course, it’s possible to delete all
Sales from a Contact or to create a new Contact record with no Sales records (possi-
bly a Seller instead of a Buyer), but a Sale should always be related to a valid
Contact (Buyer). Referential integrity should keep a Contact number from being
deleted or changed if a Sale is related to it.

It’s possible to have a buyer in the tblContacts table who has no sales. It’s less
likely, theoretically impossible, to have a Sale with no Buyer. If you create a query
to show Contacts and their Sales, any record of a Contact without a Sale or a Sales
record without a matching Contact record will not be shown in the resulting dynaset.

It can be important to find these lost records. One of the features of a query is to
perform several types of joins.

Access can help find lost records between tables by using a Query Wizard to build

_aFind Unmatched Query (these are covered in Chapter 38).
s

Changing join properties
If you create join properties at table level, in the relationship builder they will be

the default properties for your tables when working with queries. However, you can
change these properties for a specific query at the query level.

With the tblContacts and tblSales tables joined, certain join behaviors (or properties)
exist between the tables. The join property is a rule that says to display all records
(for the fields you specify) that correspond to the characters found in the
idsContactID field of the tblContacts table and in the corresponding IngzBuyer field
of the tblSales table.
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To translate this rule into a practical example, this is what happens in the
tblContacts and tblSales tables:

4 If a Buyer’s record in the tblContacts table has an idsContactID (customer

number) that is not found in any of the records of the tblSales table, that
Buyer’s record is not shown.

4+ If a record in the tblSales table has a number for a customer number that is

not related to any number in the tblContacts table, that tblSales record is not
shown.

This makes sense, at least most of the time. You don’t want to see records for buyers
without sales —or do you?

A join property is a rule that is enforced by Access. This rule tells Access how to

interpret any exceptions (possible errors) between two tables. For example, as you
saw earlier, should the non-corresponding records be shown?

Access has several types of joins, each with its own characteristics or behaviors.
Access enables you to change the type of join quickly by changing its properties.
You can change join properties by selecting the join line between tables and dou-
ble-clicking the line or right-clicking and selecting Join Properties from the menu.
When you do so, a Join Properties dialog box appears. If you double-click the join

line between the tblContacts and tblSales tables, the dialog box in Figure 5-25
displays.

Join Properties 7 Figure 5-25: The Join Properties dialog

o Tobie Viame Bt Tabie Yt box for the tblContacts and tblSales tables.
— 1 iomed “ | Notice that the third option button is

L Column Mame Sugne Cglumn Mitemsp ..

anContacts v (ot « | selected (for an outer join), because the

1+ Orily includie rows wihere e joined Seids fom bot tbies e a0l
2: Enclade AL records frem DiContacts’ and onfy o reconds fem
Ditany whare T pares Geice are ool
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join properties were set at table level.
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As Figure 5-25 shows, the Join Properties dialog box has two parts: the four combo
boxes and three option buttons. For now, you focus on the three options buttons:

1. Only include rows where the joined fields from both tables are equal. (This is
the default.)

2. Include ALL records from “tblContacts” and only those records from
“tblSales” where the joined fields are equal.

3. Include ALL records from “tblSales” and only those records from
“tblContacts” where the joined fields are equal.
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The first choice is commonly known as an inner join, and the other two are known
as outer joins. These joins control the behavior of Access as it builds the dynaset
from the query.

To create this query and change the value from the third option to the first, to create
an inner join between the two tables, follow these steps:

1. Start a new query and select the tblContacts and tblSales tables. Select the
chrContactType, chrLastName, and chrFirstName fields from the tblContacts
table and dtmSaleDate from the tblSales table. (These fields will be displayed
later.)

2. Double-click on the join line between the two tables.

3. Select the choice “1: Only include rows where the joined fields from both
tables are equal.” (This is normally the default.)

4. Click the OK button to return to the query design window.

Inner and outer joins

The Query Design window should now display two tables in the top pane of the
Query window —tblContacts and tblSales, with four fields selected to display. If
your query window does not have these two tables, create a new query and add
them. The following sections use these tables as examples to explain how inner
and outer joins operate.

Displaying an inner join

To display an inner join, follow this procedure: In the QBE pane, make sure you
have selected the fields chrContactType, chrLastName, and chrFirstName from the
tblContacts table and the field dtmSaleDate from the tblSales table. Then display
the dynaset by selecting the Datasheet button on the toolbar. The datasheet should
now look similar to the one shown in Figure 5-26, displaying each buyer’s name and
all buyers’ sales dates. Scroll through the records until you reach the bottom of the
datasheet. Notice that the value in the Contact Type column is either Both or Buyer
for each record.

Notice that each of the 53 records has entries in all four fields. This means that
every record displayed from the tblContacts table has a corresponding record or
records in the tblSales table.

Return to query design mode by clicking the Design icon on the toolbar. When you
double-click the join line between the tblContacts and tblSales tables, you see that
the join property for these two tables becomes the first selection shown in the Join
Properties dialog box. This is an inner join, or equi-join, the most common type.
These joins show only the records that have a correspondence between tables.
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Figure 5-26: The datasheet for an inner join between the tblContacts and
tblSales tables.

Creating a right outer join

Unlike inner joins (equi-joins), outer joins are used for showing all records in one
table while showing common records in the other. The table or query that does not
have a matching record will simply display empty cells in the datasheet when the
dynaset is displayed.

When you have created an outer join, the join line will point graphically to one of
the tables; as is the default action of the tblSales and tblContacts tables (being set
at table level). If displaying the join property, it says to show all records from the
main table (the one missing the arrow) while showing only matching records in
the table being pointed to. For a further explanation, follow these instructions:

1. If you have left the Join Properties dialog box, double-click the join line
between tblContacts and tblSales.

2. Select the second choice from the Join Properties dialog box, which includes
all records from the tblContacts table and only those records from tblSales
where the joined fields are equal. (This may be the third choice if you have
the tblSales table to the left of the tblContacts table and no relationship built
between the two tables.) Then click the OK button. Notice that the join line
now has an arrow at one end, pointing rightward to the tblSales table, as in
Figure 5-27. This is known in database terminology as a right outer join. (If the
tblSales table is to the left of the tblContacts table, move it to the right and
the arrow will point right — remember, the relationship here is that one Buyer
can own many Sales.)

3. Click the Datasheet button to display this dynaset. Everything looks the same
as before, except now there are 81 records instead of 53. Now move down the
page and notice that everywhere there is a value of Seller in the Contact type

199
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column, there is no corresponding Sale Date value (see Figure 5-28). These
records result from selecting the join property that specifies “include all
records from tblContacts table.”

[EoeSeeGoery SE

thiSales

thiContacts

Figure 5-27: The join line for an outer join between the tblContacts and
tblSales tables. The one and infinity signs are from the relationship set at table
level with referential integrity.

Figure 5-28: A datasheet with a right outer join. It shows all Contacts
(buyers and sellers), including those with no Sales.

There are now 81 records, with the extra records being displayed in a record in

the tblContacts table. There are many persons that do not have any corresponding
records in the tblSales table (all of them are sellers). You can see one in the figure
shown above . . . others are in the records not visible on the screen.
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Unlike inner joins, outer joins show all corresponding records between two tables
and records that do not have a corresponding record in the other table. In the pre-
ceding example, there were numerous records of Sellers but no corresponding
record for any Sale where they are the buyer. Figure 5-28 shows four records in the
window that do not have sales information — all of them have a value of Seller in
the Contact Type column.

Caution If you've changed the display order of the tables since adding them to the Query
window, Access does not follow the new table order you set up; rather, it uses the
original order in which you selected the tables. Because the information is normally
the same in either table, it doesn’t make a difference which field is selected first.

Tip You may want to break the joins between tables that you have moved around and
%, re-create the joins once you have put them in the order that you want. Now Access
4 will accept your changes.

Creating a left outer join

Once in the query design, again double-click the join line between the tblContacts
and tblSales tables. Select the third choice from the Join Properties dialog box,
which asks to “include all records from tblSales.” Then click the OK button. The join
line now has an arrow pointing to the tblContacts table. This is known as a left outer
join. (If the arrow points to the right in the top pane, the join is known as a right
outer join; if the arrow points to the left, it’s a left outer join.)

If you create this left-outer join query between the tables and select the Datasheet
button to display the dynaset, you will see that you again have 53 records. This
simply means that there are no records in the tblSales table (Sales without Buyers).
If there were one or more sales without buyers, this query would show them. The
Sales records, without Buyers, would result from selecting the join property to
include all records from tblSales (a left outer join in database terminology).

Any Sales record without a Buyer is known as an orphan record. Referential integrity
can’t be set in the Relationships window if there is an orphan record. If you attempt
to set Referential Integrity between tables and you cannot, simply remove any
orphan records and then return to the Relationships window to set up referential
integrity between the tables.

- Cross- Removing unwanted, unrelated records is detailed in Chapter 38.
'] Reference
!

Creating a Cartesian product

If you add both the tblContacts and tblSales tables to a query but don’t specify
a join between the tables, Access combines the first thlIContact record with all
the tblSales records; then it takes the second record and combines it with all the
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tblSales records and continues until all the tblContacts records have been combined
with all of the tblSales records. Combining each record in one table with each record
in the other table results in a Cartesian product (cross-product) of both tables.
Because the tblContacts table has 58 records and the tblSales table has 53, the
resulting dynaset has 3074 records.

+ o+ 4



Using Operators
and Expressions
in Multi-table

Select Queries

In previous chapters, you work with queries using criteria
on a single field. You also get experience adding multiple
tables to a query and joining the tables together. This chapter
focuses on extracting information from multiple tables using
multiple criteria in select queries.

Before working with queries, this chapter will focus on opera-
tors, functions, and expressions that are the fundamental
building blocks for Access operations. You will often use them
as criteria in queries to specify which records to display. They
are also used to calculate fields in forms to show calculated
information or to display data in a different format, and they
are used in summary controls in reports to show totals and
subtotals.

On the This chapter will use the database named CHAPO6Start.

cn@“ mdb. If you have not already copied it onto your machine
from the CD, you will need to do so now. When you have
completed this chapter, your database should resemble
the one in CHAPO6End.mdb.

What Are Operators?

Operators let you add numbers, compare values, put text
strings together, and create complex relational expressions.
You use operators to inform Access that a specific operation
is to be performed against one or more items.

C H AgP T\E R
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In This Chapter

Understanding what
operators, functions,
and expressions are
and how they are used

Reviewing types
of operators

Looking at types
of functions

Learning how to create
an expression

Examining special
identifier operators and
expressions

Creating and using Text
expressions as criteria

Using the Like and
Not operators
and wildcards

Creating and using
Memo, Date, and
Numeric expressions
as criteria

Using the And/Or
operators in single-field
criteria

Using the In and
Between...And
operators

Searching for Null data

Using the And/Or
operators across
several fields

Using functions as
expressions for criteria

Creating and using a
calculated field

+ 0+ o+
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Types of operators

The types of operators discussed in this chapter are listed below:

4 Mathematical (arithmetic) operators
4 Relational operators

4 String operators

4 Boolean (logical) operators

4 Miscellaneous operators

When are operators used?

You find yourself using operators all the time. In fact, you use them every time you
create an equation in Access. For example, operators specify data-validation rules
in table properties, create calculated fields in forms, and specify criteria in queries.

Operators indicate that an operation needs to be performed on one or more items.
Some common examples of operators are:

&
And
Like

Mathematical operators

There are seven basic mathematical operators. These are also known as arithmetic
operators, because they are used for performing arithmetic calculations:

* Multiply

+ Add

- Subtract

/ Divide

\ Integer Divide

A Exponentiation
Mod Modulo
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By definition, you use mathematical operators to work with numbers. When you
work with mathematical operators, numbers can be any numeric data type. The
number can be an actual number (constant value), or the value of a memory vari-
able, or a field’s contents. Furthermore, the numbers can be used individually or
combined to create complex expressions. Some of the examples in this section are
quite complex, but don’t worry if you don’t usually work with sophisticated mathe-
matics. This chapter shows you how to work with mathematical formulas in Access.

The * (multiplication) operator

A simple example of when to use the multiplication operator is to calculate the total
price of purchasing several items. You could design a query to display the number
of items purchased and the price for each item. Then you could have a column
containing the value of the number of items purchased times the price per item.

In this case, you could get that information from the table tblSalesLineltems, and
the formula would be [tblSalesLineltems.intQuantity] * [tblSalesLineltems.curPrice].
Another example could be a form for entering the number of items purchased and
the per-item price. Then you could use a calculated field to calculate and display
the total price for that number of items. In this case, the calculated field would con-
tain a formula like [curPrice] * [intQuantity].

The standard notation for dealing with field names in an expression is to enclose

them in square brackets.

Notice that the name of the table is used before the field name in the above
example. Because your tables only have one field named curPrice and intQuantity,

“ you could have skipped the table names; however, it is good practice to specify the

table name where the field comes from — separating the table name from the
field name by a single period.

The + (addition) operator

If you want to create a calculated field in a query for adding the value of tax

to the gross amount, you would use an expression similar to this: [Tax Amt]+
[tblSalesLineltems.curPrice]. To use this expression, you would have to create
another calculated field in the query named [Tax Amt] that is created using the
multiplication operator — Tax Amt: [tblSales.dblTaxRate] * [tblSalesLineltems.
curPrice]. You could also create a form for adding the values in fields, such as Gross
Amount and Tax, in which case you would use the expression [Gross Amount] +
[Tax]. This simple formula uses the addition operator to add the contents of both
fields and display the result in the object that contains the formula.

Besides adding two numbers, the addition operator can be used for concatenating
two character strings — putting two text-based strings together forming a single
text string. For example, you may want to combine the fields chrFirstName and

205
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chrLastName from the tblContacts table to display them as a single field. This
expression is:

[tblContacts.chrFirstName] + [tblContacts.chrLastName]

Note

- Cross-
] Reference

Caution

Notice that the name of the table is used before the field name. In this example, it
isn't necessary because your tables only have one field named chrFirstName and
chrLastName; however, it is good practice to specify the table name where the field
comes from — separating the table name from the field name by a single period.

More can be found on concatenating strings later in this chapter.

Although you can concatenate (put two strings together) text strings by using the
addition operator, you should use the ampersand (&). The reason for this appears
in the section “String operators,” later in this chapter.

The - (subtraction) operator

An example of using the subtraction operator on the same form is to calculate the
final invoice amount minus a discount. The formula to determine the Net Invoice
Amount of an item would be as follows:

[tblSalesLineltems.curPrice] -
([tblSalesLineltems.curPrice]*[tblSalesLineltems.dblDiscountPercent]).

‘\lote

—

Although parentheses are not mathematical operators, they play an integral part in
working with operators, as discussed later, in the section “Operator precedence.”

The / (division) operator

You can use the division operator to divide two numbers and (as with the previous
operators) display the result wherever you need it. Suppose, for example, that a
pool of 212 people win the $1,000,000 lottery this week. The formula to determine
each individual’s payoff is 1,000,000 / 212, resulting in $4,716.98 per person.

Tip

Using Access's Immediate window that is built into the Visual Basic Window, you
can determine the values of mathematical formulas. To activate the immediate
window, press the Ctrl+G key combination. Once active, you can perform any cal-
culation and have it display the results by placing a question mark in front of the
calculation —for example, typing ? 1000000 / 212 and pressing Enter will result in
an answer of 4716.9811. To close this window, close the Microsoft Visual Basic
window.
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The \ (integer division) operator

Should you ever need to take two numbers, round them both to integers, divide the
two rounded integers, and receive a non-rounded integer, the integer division opera-
tor does it in one step. Here is an example:

Normal Division Integer Conversion Division
100 /6 = 16.667 100\ 6 =16
100.9 /6.6 = 15.288 1009\ 6.6 = 14
Tip Access has the round function for rounding fractional numbers to whole numbers.

% You can also use the integer division operator to round any number. Just integer-
4  divide (\) the number you want to round by 1, as in 125.6 \ 1 = 126.

/\Iote Access rounds numbers based on the greater-than-.5 rule: Any number with a
=~ decimal value of x.5 or less rounds down; greater than x.5 rounds up to the next
whole number. This means that 6.5 becomes 6, but 6.51 and 6.6 become 7.

What Are Integer Values?

Integers are whole numbers (numbers that have no decimal places), which in Access are
the values between -32768 and +32767. They have no fractional part (meaning the part
after the dot). (For example, 7.2 is not an integer, because it has a fractional part which is .2;
7 is the integer number!) Examples are 1; 722; 33; -5460; 0; and 22. They include all whole
positive and negative numbers and 0. When you use the Int() function or the integer divide
operator (\) to determine the integer part of any number, simply drop any decimal values.
For example, the integer value of 45.123 is 45; for 2.987, the integer is 2; and so forth.

The integer divide operator can be a confusing operator until you understand just what it
does. If you enter the following print statements in the Immediate window of Microsoft
Visual Basic (accessed from Access), it should become clear:

? 101 / 6 results in 16.833.

7 101.9 / 6.6 results in 15.439.
? 102 / 7 results in 14.571.
?INT(102 / 7) results in 14.

? 101.9 \ 6.6 results in 14.

The last entry uses the integer divide sign (\) and is equivalent to rounding both numbers
in the division operation (101.9 = 102 and 6.6 = 7), dividing 102 by 7, and converting the
answer to an integer. In other words, it is equivalent to the following:

INT((101.9\ 1) / (6.6 \ 1)) or INT(round(101.9)/ round(6.6))
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The * (exponentiation) operator

The exponentiation operator (") raises a number to the power of an exponent.
Raising a number simply means indicating the number of times that you want
to multiply a number by itself. For example, multiplying the value 4 x 4 x 4 (that
is, 4-cubed) is the same as entering the formula 4"3.

The Mod (Modulo) operator

The modulo operator (mod), or remainder operator, takes any two numbers
(numberl and number2) and divides the first by the second (numberl / number2),
returning only the remainder. For example, if you type in the following examples in
the Immediate window, it should become clear:

? 10 Mod 5 results in 0 (10 divided by 5 is 2 with a remainder of 0.)
? 10 Mod 4 results in 2. (10 divided by 4 is 2 with a remainder of 2.)

All numbers, if they are not integers, are first rounded to integers before the Mod
operator is performed. For example:

? 22.24 Mod 4 results in 2. (22 divided by 4 is 5 with a remainder of 2.)
?22.51 Mod 4 results in 3. (23 divided by 4 is 5 with a remainder of 3.)

? 21 Mod 5.49 results in 1. (21 divided by 5 is 4 with a remainder of 1.)

Relational operators

There are six basic relational operators (also known as comparison operators).
They compare two values or expressions via an equation. The relational operators
include the following:

= Equal

<>, Not equal

< Less than

<=, Less than or equal to

> Greater than

>=, Greater than or equal to

The expressions built from relational operators always return either a logical value
or Null; the value they return says Yes (True), No (not True; that is, False), or Null
(unknown/no value).
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Aote Access actually returns a numeric value for relational operator equations. It returns
-~ a-1 (negative 1) for True and a O (zero) for False.

If either side of an equation is a Null value, the result will always be a Null.

The = (equal) operator
The equal operator returns a logical True if the two expressions being compared are
the same. Here are two examples of the equal operator:

[tbIProducts.chrCategory] = “Car” Returns a True if the category is a car;
False is returned for any other type.

[tblSales.dtmSaleDate] = Date() Returns a True if the date in the
dtmSaleDate field is today.

The <> (not-equal) operator

The not-equal operator is exactly the opposite of the equal operator. In this example,
the car example is changed to not-equal:

[tbIProducts.chrCategory] <> “Car” Returns a True if Type of Category is
anything but a car.

[tbIProducts.chrCategory] != “SUV” Returns a True if Type of Category is
anything but an SUV.

Notice that you have two different ways to express not equal to: the <> or != symbols
both mean exactly the same thing.

The < (less-than) operator

The less-than operator returns a logical True if the left side of the equation is less
than the right side, as in this example:

[tblSalesLineltems.curPrice] < 1000 Returns a True if the Price field
contains a value of less than 1000.

The <= (less-than-or-equal-to) operator

The less-than-or-equal-to operator returns a True if the left side of the equation is
either less than or equal to the right side, as in this example:

[tblSalesLineltems.curPrice] <= 2500 Returns a True if the value of Price
equals 2500 or is less than 2500.

[tblSalesLineltems.curPrice] !> 1500 Returns a True if the value of Price
equals 1500 or is less than 1500.
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Notice, in the second example, that you got the same results using the operator !>
(not greater than). In other words, equal to or less than can be expressed using
either operator, <= or !>.

Caution Access 2003 is sensitive to the order of the operators. Access reports an error if you
enter =<; the order is important. It must be less than or equal to (<=).

The > (greater-than) operator

The greater-than operator is the exact opposite of the less-than operator. This opera-
tor returns a True when the left side of the equation is greater than the right side, as
in this example:

[tblSales.dblTaxRate] > 3.5 Returns True if the value of Tax rate is greater
than 3.5.

The >= (greater-than-or-equal-to) operator

The greater-than-or-equal-to operator returns a True if the left side of the equation is
either equal to or greater than the right side. For example:

[tblSales.dblTaxRate] >= 5 Returns a True if the field Tax rate contains a
value equal to or greater than 5.
[tblSales.dblTaxRate] !< 5 Returns a True if the field Tax rate contains a

value equal to or greater than 5.

Notice, in the second example, that you got the same results using the operator !<
(not less than). In other words, equal to or greater than can be expressed using
either operator, >= or !<.

Caution Access 2003 is sensitive to the order of the operators. Access reports an error if
you enter =>; the order is important. It must be greater than or equal to (>=).

String operators

Access has three string operators, also know as text operators. Unlike the other
operators, these work specifically with the Text data type:

& Concatenation
Like Similar to...
NOT Like Not similar to...

The & (concatenation) operator

The concatenation operator connects or links (concatenates) two or more objects
into a resultant string. This operator works similarly to the addition operator.
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Unlike the addition operator, however, the & operator always forces a string con-
catenation. For instance, this example produces a single string:

[chrFirstName] & [chrLastName]

However, in the resultant string, no spaces are automatically added. If [chrFirstName]
equals “Fred” and [chrLastName] equals “Smith,” concatenating the field contents
yields FredSmith. To add a space between the strings, you must concatenate a
space string between the two fields. To concatenate a space string between first
and last name fields, you enter a formula such as this:

[chrFirstName] & “ ” & [chrLastName]

This operator can easily concatenate a string object with a number- or date-type
object. Using the & eliminates the need for special functions to convert a number
or date to a string.

Suppose, for example, that you have a Number field, which is House Number, and
a Text field, which is Street Name, and that you want to build an expression for a
report of both fields. For this, you can enter the following:

[House Number] & “” & [Street Name]

If House Number has a value of 1600 and Street Name is “Pennsylvania Avenue
N.W.,” the resultant concatenation of the number and string is as follows:

“1600 Pennsylvania Avenue N.W.”

Perhaps you want to have a calculated field in a report that prints the operator’s
name and the date and time the report was run. This can be accomplished using
syntax similar to the following:

“This report was printed ” & Now() & “ by ” & [operator name]

If the date is March 21, 2003, and the time is 4:45 p.m., this concatenated line prints
something like this:

This report was printed 3/21/03 4:45:40 PM by Michael R. Irwin

Notice the spaces at the end or the beginning of the strings. Knowing how this oper-
ator works makes maintenance of your database expressions easier. If you always
use the concatenation operator for creating concatenated text strings, you won’t
have to be concerned with the data types of the concatenated objects. Any formula
that uses the & operator converts all the objects being concatenated to a string
data type for you.
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Using the & with Nulls: If both objects are Null, the result is also a Null. If only one
of the two objects is Null, Access converts the object that is Null to a string type
with a length of 0 and builds the concatenation.

e

The Like (similar to) operator and NOT Like

The Like operator, and its opposite, the NOT Like operator, are used to compare
two string objects by using wildcards. This operator determines whether one
object matches, or doesn’t match, the pattern of another object. The resultant
value of the comparison is a True, False, or Null.

The Like operator uses the following basic syntax:
expression object Like pattern object

Like looks for the expression object in the pattern object; if it is present, the opera-
tion returns a True. (The Like operator is discussed in more detail in Chapter 13.)

If either object in the Like formula is a Null, the result is a Null.
p

This operator provides a powerful and flexible tool for string comparisons. The
pattern object can use wildcard characters to increase flexibility (see the sidebar
“Using Wildcards”).

If you want to match one of the wildcard characters in the Like operation, the wild-
card character must be enclosed in brackets in the pattern object. In the example

“AB*Co” Like “AB[¥|C*"

the [*] in the third position of the pattern object will look for the asterisk as the
third character of the string.

Following are some examples that use the Like operator:

[tblContacts.chrLastName] Like “M[Cc]*” Returns a True for any last name
that begins with “Mc” or “MC.”
“McDonald,” “McJamison,”
“MCWilliams” are all True; “Irwin”
and “Prague” are False.

[chrAnswer] Like “[!e-zE-Z]” Returns a True if the Answer
isA,B,C,D, a, b, c,or d. Any
other letter is False.

“AB1989” Like “AB####” Results in True because the
string begins with the letters
AB and is followed by any four
numbers.
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“#10 Circle Drive” Like “[#]*Drive” Results in True because the first
character is the pound sign (#)
and the last part is the word
Drive.

[Answer] NOT Like “[le-zE-Z]” Returns a False if the Answer is
A,B,C,D, a, b, c, or d. Any other
letter is TRUE.

[chrLastName] NOT Like “M[Cc]*” Is True for any last name that
DOES NOT begin with “Mc”
or “MC.” “McDonald,”
“McJamison,” “MCWilliams” are
all FALSE; “Irwin” and “Prague”
are TRUE.

Boolean (logical) operators

Access uses six Boolean operators. Also referred to as logical operators, these are
used for setting conditions in expressions. Boolean operators are used to create
complex multiple-condition expressions. Like relational operators, these always
return either a logical True or False or a Null. Boolean operators include the
following:

And Logical and

Or Logical inclusive or

Eqv Logical equivalence

Imp Logical implication

Xor Logical exclusive or

Not Logical not

The And operator

You use the And operator to perform a logical conjunction of two objects; the opera-
tor returns the value True if both conditions are true. The general syntax of an And
operation is:

object expression 1 And object expression 2

Here is an example:

[tblContacts.chrState] = “MA” Is True only if both conditions
And [tblContacts.chrZipCode] = “02379-" are True.
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Using Wildcards

Access lets you use these five wildcards with the Like operator:

Character Matches

? A single character (A to Z, 0 to 9)
& Any number of characters (0 to n)
# Any single digit (0 to 9)

flist]
[ist]

Any single character in the list

Any single character not in the list

Both [list] and [!list] can use the hyphen between two characters to signify a range.

If the conditions on both sides of the And operator are True, the result is a True

value. Table 6-1 demonstrates the results.

And Operator Resultants

Expression 1

Expression 2

Return Resultant

True
True
True
False
False
False
Null
Null
Null

True
False
Null
True
False
Null
True
False

Null

True
False
Null
False
Fals